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9

Introduction

PLAXIS 2D is a finite element package that has been developed specifically for the analysis of
deformation, stability and flow in geotechnical engineering projects. The simple graphical input
procedures enable a quick generation of complex finite element models, and the enhanced
output facilities provide a detailed presentation of computational results. The calculation itself is
fully automated and based on robust numerical procedures. This concept enables new users to
work with the package after only a few hours of training.

Though the various tutorials deal with a wide range of interesting practical applications, this
Tutorial Manual is intended to help new users become familiar with PLAXIS 2D. The tutorials and
the respective material data sets should therefore not be used as a basis for practical projects.

Users are expected to have a basic understanding of soil mechanics and should be able to work
in a Windows environment. It is strongly recommended that the tutorials are followed in the
order that they appear in the manual. Please note that minor differences in results maybe found,
depending on hardware and software configuration.

The Tutorial Manual does not provide theoretical background information on the finite element
method, nor does it explain the details of the various soil models available in the program. The
latter can be found in the Material Models Manual, as included in the full manual, and theoretical
background is given in the Scientific Manual. For detailed information on the available program
features, the user is referred to the Reference Manual. In addition to the full set of manuals, short
courses are organised on a regular basis at several places in the world to provide hands-on
experience and background information on the use of the program.

Tutorials available for different licencing levels:
Given PLAXIS 2D features and soil models are provided for separated licencing services, the
present tutorial manuals are available with previous installation of a specific licence level.

For more information about licencing levels please visit: General Information Manual, Reference
Manual and Material Models Manual).

As a summary, the tutorials available for each licence level can be identified with the following
conventions:
● Tutorials with no identification - generally available for PLAXIS 2D licence.
● [ADV] - tutorials for users with PLAXIS 2D Advanced licence.
● [ULT] - tutorials for users with PLAXIS 2D Ultimate licence.
● [GSE] - tutorials for users with Geotechnical SELECT subscription (previous Basic, Advanced

or Ultimate licence level required).

Note:

Each individual PLAXIS 2D tutorial is available for downloading as PDF file in Bentley
Communities.
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1
Settlement of a circular footing on

sand

1.1   Introduction
In this chapter a first application is considered, namely the settlement of a circular foundation
footing on sand. This is the first step in becoming familiar with the practical use of PLAXIS 2D.
The general procedures for the creation of a geometry model, the generation of a finite element
mesh, the execution of a finite element calculation and the evaluation of the output results are
described here in detail. The information provided in this chapter will be utilised in the later
tutorials. Therefore, it is important to complete this first tutorial before attempting any further
tutorial examples.

Objectives:
● Starting a new project
● Creating an axisymmetric model
● Creating soil stratigraphy using the Borehole feature
● Creating and assigning of material data sets for soil ( Mohr-Coulomb model )
● Defining prescribed displacements
● Creation of footing using the Plate feature
● Creating and assigning material data sets for plates
● Creating loads
● Generating the mesh

10



● Generating initial stresses using the K0 procedure
● Defining a Plastic calculation
● Activating and modifying the values of loads in calculation phases
● Viewing the calculation results
● Selecting points for curves
● Creating a 'Load - displacement' curve

1.2  Geometry
A circular footing with a radius of 1.0 m is placed on a sand layer of 4.0m thickness as shown
in Figure 1–1 (p. 11). Under the sand layer there is a stiff rock layer that extends to a large
depth. The purpose of the exercise is to find the displacements and stresses in the soil caused
by the load applied to the footing. Calculations are performed for both rigid and flexible footings.
The geometry of the finite element model for these two situations is similar. The rock layer is not
included in the model; instead, an appropriate boundary condition is applied at the bottom of
the sand layer. To enable any possible mechanism in the sand and to avoid any influence of the
outer boundary, the model as shown in Figure 1–1 (p. 11) is extended in horizontal direction to
a total radius of 5.0 m.

Footing

Sand
y

x

4.0 m

Load

2.0 m

Figure 1–1: Geometry of a circular footing on a sand layer

1.3  Case A: Rigid footing
In the first calculation, the footing is considered to be very stiff and rough. In this calculation the
settlement of the footing is simulated by means of a uniform indentation at the top of the sand
layer instead of modelling the footing itself. This approach leads to a very simple model and is
therefore used as a first exercise, but it also has some disadvantages. For example, it does not
give any information about the structural forces in the footing.

The second part of this tutorial deals with an external load on a flexible footing, which is a more
advanced modelling approach.
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1.3.1  Create a new project
1

Start PLAXIS 2D by double-clicking the icon of the Input program .

The Quick start dialog box appears in which you can create a new project or select an
existing one.

Figure 1–2: Quick start - PLAXIS 2D
2 Click Start a new project.

The Project properties window appears with three tabsheets: Project, Model and Cloud
services .

Note: For the different licencing tiers the Project properties window will vary from
three tabsheets to four tabsheets with the addition of Constants alongwith Project,
Model and Cloud services.

1 Settlement of a circular footing on sand   |  12



Figure 1–3: Project properties window - PLAXIS 2D

Note:

The first step in every analysis is to set the basic parameters of the finite element
model. This is done in the Project properties window. These settings include the
description of the problem, the type of model, the basic type of elements, the basic
units and the size of the drawing area.

To enter the appropriate settings for the footing calculation follow the steps below.

3 In the Project tabsheet, enter Lesson 1 in the Title box and type Settlement of a
circular footing in the Comments box.

4 Click the Next button at the bottom or click the Model tab.

The Model properties are shown in Figure 1–4 (p. 14):
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Figure 1–4: Model properties tabsheet
5 In the Type group the type of the model (Model) and the basic element type (Elements) are

specified. Since this tutorial concerns a circular footing, select the Axisymmetry and the
15-Noded options from the Model and the Elements drop-down menus respectively.

6 In the Contour group set the model dimensions to xmin = 0, xmax = 5, ymin = 0 and ymax = 4.

7 Click the OK button to confirm the settings.

The project is created with the given properties. The Project properties window closes and the
Soil mode view will be shown, where the soil stratigraphy can be defined.

Note: The project properties can be changed later. You can access the Project
properties window by selecting the corresponding option from the File menu.

1.3.2  Define the soil stratigraphy
In the Soil mode of PLAXIS 2D the soil stratigraphy can be defined.

Information on the soil layers is entered in boreholes. Boreholes are locations in the drawing area
at which the information on the position of soil layers and the water table is given. If multiple
boreholes are defined, PLAXIS 2D will automatically interpolate between the boreholes. The
layer distribution beyond the boreholes is kept horizontal.
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Note: The modelling process is completed in five modes (Soil, Structures, Mesh, Flow
conditions and Staged construction). More information on modes is available in the Input
Program  Structures Mode of the Reference Manual.

In order to construct the soil stratigraphy follow these steps:

1 Click the Create borehole button  in the side (vertical) toolbar to start defining the soil
stratigraphy.

2 Click at x = 0 in the drawing area to locate the borehole.

The Modify soil layers window will appear as shown in Figure 1–5 (p. 15) .

3 Add a soil layer by clicking the Add button in the Modify soil layers window.

4 Set the top boundary of the soil layer at y = 4 and keep the bottom boundary at y = 0 m.

5 Set the Head to 2.0 m.

By default the Head value (groundwater head) in the borehole column is set to 0 m.

Figure 1–5: Modify soil layers window
Next the material data sets are defined and assigned to the soil layers, see 1.3.3 Create and
assign material data sets (p. 15).

1.3.3  Create and assign material data sets
In order to simulate the behaviour of the soil, a suitable soil model and appropriate material
parameters must be assigned to the geometry. In PLAXIS 2D, soil properties are collected
in material data sets and the various data sets are stored in a material database. From the
database, a data set can be assigned to one or more soil layers. For structures (like walls, plates,
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anchors, geogrids, etc.) the system is similar, but different types of structures have different
parameters and therefore different types of material data sets. PLAXIS 2D distinguishes between
material data sets for Soils and interfaces, Discontinuities, Plates, Geogrids, Embedded
beams , Cables and Anchors.

The sand layer that is used in this tutorial has the following properties as shown in Table 1–1 (p.
16) :

Table 1–1: Material properties of the sand layer

Parameter Name Value Unit

General
Soil model Model Mohr-Coulomb -

Drainage type Type Drained -

Unsaturated unit weight γunsat 17 kN/m3

Saturated unit weight γsat 20 kN/m3

Mechanical

Young's modulus E'ref 13 · 103 kN/m2

Poisson's ratio ν 0.3 -

Cohesion c'ref 1 kN/m2

Friction angle φ' 30 °

Dilatancy angle ψ 0 °

To create a material set for the sand layer, follow these steps:

1 Open the Material sets window by clicking the Materials button  in the Modify soil
layers window or in the side toolbar.

The Material sets window pops up as shown in Figure 1–6 (p. 17).
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Figure 1–6: Material sets window
2 Click the New button at the lower side of the Material sets window.

A new window will appear with the tabsheets: General, Mechanical, Groundwater,
Interfaces and Initial.

3 In the Material set box of the General tabsheet, write Sand in the Identification box.

The default material model (Mohr-Coulomb) and drainage type (Drained) are valid for this
example.

4 Enter the proper values in the General properties box (Figure 1–7 (p. 18)) according
to the material properties listed in Table 1–1 (p. 16). Keep parameters that are not
mentioned in the table at their default values.
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Figure 1–7: The General tabsheet of the Soil window

Note:

a. As displayed in Figure 1–7 (p. 18) a Feedback side panel is included in the
Material window. This panel prevents the definition of an invalid material data
set. To display the list of detailed messages please select Show full feedback.
Three types of messages are possible:
● Errors: the parameter value or combination of parameter values must be

changed, otherwise the material set could be invalid and calculation of the
project will be blocked.

● Warnings: the parameter value seems to deviate from a recommended
parameter value or parameter range. Generally the material set will not
be considered invalid and calculating the project will not be blocked. The
chosen parameter could however cause unexpected results.

● Hints: the entered parameter can be defined under certain circumstances or
options.

b. The Feedback side panel is displayed at the moment of defining materials and
structures. For the sake of simplicity, this panel will only be shown in some
tutorial examples..

5 Click the Next button or click the Mechanical tab to proceed with the input of model
parameters.
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The parameters appearing on the Mechanical tabsheet depend on the selected material
model (in this case the Mohr-Coulomb model).

Figure 1–8: Mechanical tabsheet of the Soil window - Soil and interfaces set type
6 Enter the model parameters of Table 1–1 (p. 16) in the corresponding edit boxes of the

Mechanical tabsheet (Figure 1–8 (p. 19)) and keep the other parameters as their default
values. A detailed description of different soil models and their corresponding parameters
can be found in the Material Models Manual.

Note: To understand why a particular soil model has been chosen, see Appendix B
of the Material Models Manual.

7 The soil material is drained, the geometry model does not include interfaces and the
default thermal and initial conditions are valid for this case, therefore the remaining
tabsheets can be skipped. Click OK to confirm the input of the current material data set.

Now the created data set will appear in the tree view of the Material sets window.

8 Drag the set Sand from the Material sets window (select it and hold down the left mouse
button while moving) to the graph of the soil column on the left hand side of the Modify
soil layers window and drop it there (release the left mouse button).

9 Click OK in the Material sets window to close the database.

10 Click OK to close the Modify soil layers window.
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Tip:
● Existing data sets may be changed by opening the Material sets window,

selecting the data set to be changed from the tree view and clicking the Edit
button. As an alternative, the Material sets window can be opened by clicking
the corresponding button in the side toolbar.

● PLAXIS 2D distinguishes between a project database and a global database of
material sets. Data sets may be exchanged from one project to another using
the global database. The global database can be shown in the Material sets
window by clicking the Show global button. The data sets of all tutorials in the
Tutorial Manual are stored in the global database during the installation of the
program.

● The material assigned to a selected entity in the model can be changed in the
Material drop-down menu in the Selection explorer. Note that all the material
datasets assignable to the entity are listed in the drop-down menu. However,
only the materials listed under Project materials are listed, and not the ones
listed under Global materials.

● The program performs a consistency check on the material parameters and will
give a warning message in the case of a detected inconsistency in the data.

1.3.4  Define the footing
Structural elements and loads are created in the Structures mode of the program. In this
exercise a uniform indentation will be created to model a very stiff and rough footing.

Tip:

Visibility of a grid in the drawing area can simplify the definition of geometry. The grid
provides a matrix on the screen that can be used as reference. It may also be used
for snapping to regular points during the creation of the geometry. The grid can be
activated by clicking the corresponding button under the drawing area. To define the
size of the grid cell and the snapping options:

Click the Snapping options button  in the bottom toolbar. The Snapping window
pops up where the size of the grid cells and the snapping interval can be specified. The
spacing of snapping points can be further divided into smaller intervals by the Number
of snap intervals value. Use the default values in this tutorial.

1 Click the Structures tab to proceed with the input of structural elements in the Structures
mode .

2 Click the Create prescribed displacement button  in the side toolbar.

3 Select the Create line displacement option  in the expanded menu.

4 In the drawing area move the cursor to point (0 4) and click the left mouse button.
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5 Move along the upper boundary of the soil to point (1 4) and click the left mouse button
again.

6 Click the right mouse button to stop drawing.

7 In the Selection explorer set the x-component of the prescribed displacement
(Displacement x) to Fixed.

8 Specify a uniform prescribed displacement in the vertical direction by assigning a value of
-0.05 to u y,start,ref, signifying a downward displacement of 0.05 m as shown in Figure 1–9 (p.
21).

Figure 1–9: Prescribed displacement in the Selection explorer
The geometry of the model is complete.

When the geometry model is complete, the finite element mesh can be generated. Proceed to
1.3.5 Generate the mesh (p. 21).

1.3.5  Generate the mesh
PLAXIS 2D allows for a fully automatic mesh generation procedure, in which the geometry
is divided into elements of the basic element type and compatible structural elements, if
applicable.

The mesh generation takes full account of the position of points and lines in the model, so that
the exact position of layers, loads and structures is accounted for in the finite element mesh.
The generation process is based on a robust triangulation principle that searches for optimised
triangles. In addition to the mesh generation itself, a transformation of input data (properties,
boundary conditions, material sets, etc.) from the geometry model (points, lines and clusters) to
the finite element mesh (elements, nodes and stress points) is made.

In order to generate the mesh, follow these steps:

1 Proceed to the Mesh mode by clicking the corresponding tab.

2 Click the Generate mesh button  in the side toolbar.

The Mesh options window pops up as shown in Figure 1–10 (p. 22). The Medium option
is by default selected as element distribution.

1 Settlement of a circular footing on sand   |  21



Figure 1–10: The Mesh options window
3 Click OK to start the mesh generation.

4 As the mesh is generated, click the View mesh button.

A new window is opened displaying the generated mesh as shown in Figure 1–11 (p. 22).
Note that the mesh is automatically refined under the footing.

Figure 1–11: The generated mesh in the Output window
5 Click on the Close tab to close the Output program and go back to the Mesh mode of the

Input program.

Note:
● By default, the Element distribution is set to Medium. The Element distribution

setting can be changed in the Mesh options window. In addition, options are
available to refine the mesh globally or locally (for more information see the
Reference Manual).

● The finite element mesh has to be regenerated if the geometry is modified.
● The automatically generated mesh may not be perfectly suitable for the intended

calculation. Therefore it is recommended that the user inspects the mesh and
makes refinements if necessary.
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Once the mesh has been generated, the finite element model is complete.

After the mesh was generated, the calculation phases are defined and the calculation is done,
see 1.3.6.1 Initial phase (p. 23) for instructions.

1.3.6  Define and perform the calculation
The calculation has to be defined in phases before the actual calculation can be performed. This
example needs two phases: the initial phase and one to simulate the settlement of the footing.

1.3.6.1  Initial phase
The 'Initial phase' always involves the generation of initial conditions. In general, the initial
conditions comprise the initial geometry configuration and the initial stress state, i.e. effective
stresses, pore pressures and state parameters, if applicable.

1 Click the Staged construction tab to proceed with the definition of calculation phases. The
Flow conditions mode may be skipped.

When a new project has been defined, a first calculation phase named ' Initial phase', is
automatically created and selected in the Phases explorer as shown in Figure 1–12 (p.
23):

Figure 1–12: Phases explorer - Initial Phase

All structural elements and loads that are present in the geometry are initially automatically
switched off, only the soil volumes are initially active.

2
Click the Edit phase button  or double-click the phase in the Phases explorer.

In this tutorial lesson the properties of the Initial phase will be described. Below an overview
is given of the options to be defined even though the default values of the parameters are
used.

By default the K0 procedure is selected as Calculation type in the General
subtree of the Phases window. This option will be used in this project to
generate the initial stresses.

The Staged construction option is available as Loading type.

The Phreatic option is selected by default as the Pore pressure calculation
type.

Note: The K0 procedure should be primarily used for horizontally layered
geometries with a horizontal ground surface and, if applicable, a horizontal phreatic
level. See the Reference Manual for more information on the K0 procedure.
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The other default options in the Phases window will be used as well in this tutorial.

The Phases window is displayed in Figure 1–13 (p. 24).

Figure 1–13: Phases window - Initial phase
3 Click OK to close the Phases window.

4 In the Model explorer expand the Model conditions subtree as shown in Figure 1–14 (p.
25).

For deformation problems two types of boundary conditions exist: Prescribed displacement
and prescribed forces (loads). In principle, all boundaries must have one boundary condition
in each direction. That is to say, when no explicit boundary condition is given to a certain
boundary (a free boundary), the natural condition applies, which is a prescribed force equal
to zero and a free displacement.

To avoid the situation where the displacements of the geometry are undetermined,
some points of the geometry must have prescribed displacements. The simplest form
of a prescribed displacement is a fixity (zero displacement), but non-zero prescribed
displacements may also be given.

5 Expand the Deformations subtree.

Note that the box is checked by default. By default, a full fixity is generated at the
base of the geometry, whereas roller supports are assigned to the vertical boundaries
(BoundaryXMin and BoundaryXMax are normally fixed, BoundaryYMin is fully fixed and
BoundaryYMax is free).

6 Expand the Water subtree.

The initial water level has been entered already in the Modify soil layers window. The water
level generated according to the Head value assigned to boreholes in the Modify soil layers
window (BoreholeWaterLevel_1) is automatically assigned to GlobalWaterLevel .
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Figure 1–14: Model explorer showing model conditions and Deformations
The water level defined according to the Head specified for boreholes is displayed in the model
explorer window. Note that only the global water level is displayed in both Phase definition
modes. All the water levels are displayed in the model only in the Flow conditions mode .

The model of the project in the initial phase is shown in Figure 1–15 (p. 25).

Figure 1–15: Initial phase in the Staged construction mode
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Next, the calculation phase for the footing settlement is defined.

1.3.6.2  Phase 1: Footing
In order to simulate the settlement of the footing in this analysis, a plastic calculation is required.
PLAXIS 2D has a convenient procedure for automatic load stepping, which is called 'Load
advancement'. This procedure can be used for most practical applications. Within the plastic
calculation, the prescribed displacements are activated to simulate the indentation of the
footing. In order to define the calculation phase follow these steps:

1 Click the Add phase button  in the Phases explorer.

A new phase, named Phase_1 will be added in the Phases explorer.

2 Double-click Phase_1 to open the Phases window. In the ID box of the General section, write
(optionally) an appropriate name for the new phase (for example Indentation).

The current phase starts from the Initial phase, which contains the initial stress state. The
default options and values assigned are valid for this phase as shown in Figure 1–16 (p.
26).

Figure 1–16: The Phases window for the Indentation phase
3 Click OK to close the Phases window.

4 Click the Staged construction tab to enter the corresponding mode.
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5 In the drawing area right-click the prescribed displacement and select the Activate option in
the appearing menu as shown in Figure 1–17 (p. 27).

Figure 1–17: Activation of the prescribed displacement in the Staged construction mode

Tip: Calculation phases may be added, inserted or deleted using the Add, Insert and
Delete buttons in the Phases explorer or in the Phases window.

1.3.6.3  Execute the calculation
Both calculation phases are marked for calculation, as indicated by the blue arrows. The
execution order is controlled by the Start from phase parameter.

1 Click the Calculate button  to start the calculation process. Ignore the warning that no
nodes and stress points have been selected for curves.

During the execution of a calculation, a window appears which gives information about the
progress of the actual calculation phase as shown in Figure 1–18 (p. 28) .
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Figure 1–18: Calculation progress

The information, which is continuously updated, shows the calculation progress, the current
step number, the global error in the current iteration and the number of plastic points in
the current calculation step. It will take a few seconds to perform the calculation. When a
calculation ends, the window is closed and focus is returned to the main window.

The phase list in the Phases explorer is updated. A successfully calculated phase is
indicated by a check mark inside a green circle .

2 Save the project by clicking the Save button  before viewing results.

Once the calculation has been completed, the results can be displayed in the Output program.

1.3.6.4  View the calculation results
In the Output program, the displacement and stresses in the full two-dimensional model as
well as in cross sections or structural elements can be viewed. The computational results
are also available in tabular form. To check the applied load that results from the prescribed
displacement of 0.05 m:

1 Open the Phases window.

2 From the Reached values subtree look for the Force-Y which is an important value of the
current application. This value represents the total reaction force corresponding to the
applied prescribed vertical displacement, which corresponds to the total force under 1.0
radian of the footing (note that the analysis is axisymmetric). In order to obtain the total
footing force, the value of Force-Y should be multiplied by 2π (this gives a value of about
588 kN).
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The results can be evaluated in the Output program. In the Output window you can view the
displacements and stresses in the full geometry as well as in cross sections and in structural
elements, if applicable.
The computational results are also available in tabulated form. To view the results of the
footing analysis, follow these steps:

3 Select the last calculation phase in the Phases explorer.

4
Click the View calculation results button  in the side toolbar.

As a result, the Output program is started, showing the deformed mesh at the end of the
selected calculation phase as shown in Figure 1–19 (p. 29):

Figure 1–19: Deformed mesh

The deformed mesh is scaled to ensure that the deformations are visible.

5 Select the menu Deformations > Total displacements > |u|.

The plot shows the colour shadings of the total displacements. The colour distribution is
displayed in the legend at the right hand side of the plot.

Tip: The legend can be toggled on and off by clicking the corresponding option in
the View menu.

6 The total displacement distribution can be displayed in contours by clicking the Contour
lines button  in the toolbar.

The plot shows contour lines of the total displacements, which are labelled. An index is
presented with the displacement values corresponding to the labels.

7 Click the Arrows button .
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The plot shows the total displacements of all nodes as arrows, with an indication of their
relative magnitude.

8 Click the menu Stresses > Principal effective stresses > Effective principal stresses.

The plot shows the effective principal stresses at the stress points of each soil element
with an indication of their direction and their relative magnitude as shown in Figure 1–20 (p.
30):

Figure 1–20: Effective principal stresses
9 Click the Table button  on the toolbar.

A new window is opened in which a table is presented, showing the values of the principal
stresses and other stress measures in each stress point of all elements.

Tip:
● In addition to the total displacements, the Deformations menu allows for the

presentation of Incremental displacements. The incremental displacements are
the displacements that occurred within one calculation step (in this case the final
step). Incremental displacements may be helpful in visualising an eventual failure
mechanism.

● The plots of stresses and displacements may be combined with geometrical features,
as available in the Geometry menu.
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1.4  Case B: Flexible footing
The project is now modified so that the footing is modelled as a flexible plate. This enables the
calculation of structural forces in the footing. The geometry used in this exercise is the same as
the previous one, except that additional elements are used to model the footing. The calculation
itself is based on the application of load rather than prescribed displacement. It is not necessary
to create a new model; you can start from the previous model, modify it and store it under a
different name. To perform this, follow these steps:

1.4.1  Modify the geometry
1 In the Input program select the File > Save project as menu. Enter a non-existing name for

the current project file and click the Save button.

2 Go back to the Structures mode . Make sure you are in Select mode by clicking the Select
button .

3 Right-click the prescribed displacement and select Line displacement > Delete as shown in
Figure 1–21 (p. 31).

Figure 1–21: Delete the line displacement option
4 In the model right-click the line at the location of the footing. Select Create > Create Plate

as shown in Figure 1–22 (p. 32).

1.4 Case B: Flexible footing   |  31



Figure 1–22: Create Plate option

A plate is created, which simulates the flexible footing.

5 In the model right-click again the line at the location of the footing and select Create >
Create Line load as shown in Figure 1–23 (p. 33).
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Figure 1–23: Create line load option
6 In the Selection explorer the default input value of the distributed load is -1.0 kN/m2 in the y-

direction. The input value will later be changed to the real value when the load is activated.

1.4.2  Add material properties for the footing
The material properties for the flexible footing are as follows:

Table 1–2: Material properties of the footing

Parameter Name Value Unit

General
Material type - Elastic -

Unit weight w 0.0 kN/m/m

Prevent punching - No

Mechanical
Isotropic - Yes -

Axial stiffness EA1 5 · 10 6 kN/m

Bending stiffness EI 8.5 · 10 3 kNm2/m

Poisson's ratio ν 0.0 -
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1 Click the Materials button  in the side toolbar.

2 In the Material sets window, from the Set type drop-down menu, select Plates.

3 Click the New button.

A new window appears where the properties of the footing can be entered.

4 Type Footing in the Identification box. The Elastic option is selected by default for the
material type. Keep this option for this example.

5 Enter the properties as listed in Table 1–2 (p. 33). Keep parameters that are not
mentioned in the table at their default values.

6

Note: The equivalent thickness is automatically calculated by PLAXIS 2D from the
values of EA and EI. It cannot be defined manually.

Click OK.

The new data set now appears in the tree view of the Material sets window.

7 Drag the set called Footing to the drawing area and drop it on the footing. Note that the
shape of the cursor changes to indicate that it is valid to drop the material set.

Tip: If the Material sets window is displayed over the footing and hides it, click on
its header and drag it to another position.

8 Click OK to close the materials database.

1.4.3  Generate the mesh
In order to generate the mesh, follow these steps:

1 Proceed to the Mesh mode .

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh.

4 Click the Close tab to close the Output program.

Note:  Regeneration of the mesh results in a redistribution of nodes and stress
points.
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1.4.4  Calculations

1 Proceed to the Staged construction mode .

2 Leave the initial phase as it is. The initial phase is the same as in the previous case.

3 Double-click the following phase (Phase_1) and enter an appropriate name for the phase ID.
Keep the Calculation type as Plastic and keep the Loading type as Staged construction.

4 Close the Phases window.

5 In the Staged construction mode activate the load and plate.

The model is shown- in Figure 1–24 (p. 35):

Figure 1–24: Active plate and load in the model
6 In the Selection explorer shown in Figure 1–25 (p. 35) assign -188 kN/m2 to the vertical

component of the line load. Note that, this gives a total load that is approximately equal to
the footing force that was obtained from the first part of this tutorial. (188 kN/m2 · π ·(1.0
m)2 ≈ 590 kN).

Figure 1–25: Definition of the load components in the Selection explorer
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7 No changes are required in the Flow conditions tabsheet.

The calculation definition is now complete. Before starting the calculation it is advisable to
select nodes or stress points for a later generation of load-displacement curves or stress
and strain diagrams. To do this, follow these steps:

8 Click the Select points for curves button  in the side toolbar.

As a result, all the nodes and stress points are displayed in the model in the Output
program. The points can be selected either by directly clicking on them or by using the
options available in the Select points window.

9 In the Select points window enter (0.0 4.0) for the coordinates of the point of interest and
click Search closest.

The nodes and stress points located near that specific location are listed.

10 Select the node at exactly (0.0 4.0) by checking the box in front of it. The selected node
is indicated by Node 4* in the model when the Selection labels option is selected in the
Mesh menu.

Tip: Instead of selecting nodes or stress points for curves before starting the
calculation, points can also be selected after the calculation when viewing the
output results. However, the curves will be less accurate since only the results
of the saved calculation steps will be considered. To select the desired nodes by
clicking on them, it may be convenient to use the Zoom in option  on the toolbar
to zoom into the area of interest.

11 Click the Update button on the top left to return to the Input program.

12 Check if both calculation phases are marked for calculation by a blue arrow . If this is
not the case click the symbol of the calculation phase or right-click and select Mark for
calculation from the pop-up menu.

13 Click the Calculate button  to start the calculation.

14 Click the Save button  to save the project after the calculation has finished.
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1.4.5  View the calculation results
1 After the calculation the results of the final calculation step can be viewed by clicking the

View calculation results button . Select the plots that are of interest. The displacements
and stresses should be similar to those obtained from the first part of the exercise.

2 Click the Select structures button  in the side toolbar and double-click the footing.

A new window opens in which either the displacements or the bending moments of the
footing may be plotted (depending on the type of plot in the first window).

3 Note that the menu has changed. Select the various options from the Forces menu to view
the forces in the footing.

Note:  Multiple (sub-)windows may be opened at the same time in the Output program.
All windows appear in the list of the Window menu. PLAXIS 2D follows the Windows
standard for the presentation of sub-windows (Cascade, Tile, Minimize, Maximize,
etc).

1.4.6  Generate a load-displacement curve
In addition to the results of the final calculation step it is often useful to view a load-
displacement curve. In order to generate the load-displacement curve, follow these steps:

1 Click the Curves manager button  in the toolbar.

The Curves manager window pops up.

2 In the Charts tabsheet, click New.

The Curve generation window pops up as shown in Figure 1–26 (p. 38).
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Figure 1–26: Curve generation window
3 For the x-axis, select Node 4* (0.00 , 4.00) from the drop-down menu. Select the

Deformations > Total displacements > |u|.
4 For the y-axis, select the Project option from the drop-down menu. Select the Multipliers >

ΣMstage option. ΣMstage is the proportion of the specified changes that has been applied.
Hence the value will range from 0 to 1, which means that 100% of the prescribed load has
been applied and the prescribed ultimate state has been fully reached.

5 Click OK to accept the input and generate the load-displacement curve.

As a result the curve of is plotted as shown in Figure 1–27 (p. 39):
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Figure 1–27: Load-displacement curve for the footing

Tip:

You can re-enter the Settings window (in the case of a mistake, a desired regeneration
or modification) by:
● Double-click the curve in the legend of the chart OR
● Select the menu Format > Settings.

The properties of the chart can be modified in the Chart tab sheet whereas the
properties curve can be modified in the corresponding tab sheet.

1 Settlement of a circular footing on sand   |  39



2
Drained and undrained stability of an

embankment

2.1   Introduction
In this chapter the construction of an embankment on clay is simulated. The clay will first be
considered a drained material and then an undrained material. For both cases the factor of
safety will be determined. This would for instance give an indication of both the long term and
short term stability of the embankment.

Objectives
● Modelling Drained and Undrained soil behaviour.
● Changing material sets during the calculation.
● Calculating a factor of safety.
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2.2  Geometry
Figure 2–1 (p. 41) shows the layout of an embankment . The embankment is 4 m high and the
crest of the embankment has a width of 2.0 m. The groundwater level is just below surface, but
to simplify the problem it will be defined at ground level.

14 m 8 m 2 m

4 m

12 m 14 m

y

x

6 m

Figure 2–1: Geometry of the project

2.3  Create new project
To create a new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-
Noded).

4 Set the model dimensions to: xmin = 0 m, xmax = 50 m, ymin = -6 m and ymax = 4 m.

5 Keep the default values for units, constants and the general parameters and click OK to
close the Project properties window.

2.4  Define the soil stratigraphy
The subsoil profile consists of a single clay layer extending until large depth. Since we are only
interested in the stability of the embankment it is not necessary to model the clay layer until very
large depth; the model has to be deep enough to allow the failure mechanism to form. Please
note that for a deformation analysis a deeper model may be required as deformations due to the
construction of the embankment will still occur at considerable depth.

To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up as shown in Figure 2–2 (p. 42).

2 Add a single soil layer from Top = 0 to Bottom = -6.

3 Keep the Head for this borehole to 0. Hence, the groundwater level coincides with ground
level.
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Figure 2–2: The soil stratigraphy in the Modify soil layers window

2.5  Create and assign material data sets
For this project three material sets have to be defined. One material to represent the sand of
which the embankment will be constructed and two materials representing the subsoil: a drained
and an undrained material set representing the clay in long term and short term conditions.

Table 2–1: Material properties of the soil layer

Parameter Name Embankment Clay layer Unit

General
Soil model - Hardening soil Hardening soil -

Type of material behaviour - Drained Drained -

Unsaturated unit weight γunsat 16 13 kN/m3

Saturated unit weight γsat 16 13 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 15·103 5,600 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 15·103 5,000 kN/m2

Unloading / reloading stiffness Eur 
ref 45·103 20·103 kN/m2
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Mechanical
Power for stress-level dependency
of stiffness m 0.5 1.0 -

Cohesion c'ref 3 10 kN/m2

Friction angle φ' 30 25 °

Initial
K0-determination - Automatic Automatic -

Overconsolidation ratio OCR 1.0 1.2 -

1 Select the Show materials button  so that the Materials sets window shows up.

2 Using the New button define the two material sets as defined in the Table 2–1 (p. 42) .

3 In order to create the undrained material set for the clay layer select the drained material
in the Material sets window and click the Copy button to duplicate the material set. In the
copied material set, change the name and set the Drainage type to Undrained (A).

4 Assign the material set representing the drained clay to the subsoil.

2.6  Create the embankment
To create the embankment define a soil polygon representing the embankment and then assign
the material properties to it.

1 Go to Structures mode .

2 From the tools side bar select the Create soil polygon option  and then from the small
popup button menu that appears select the Create soil polygon  option again.

3 Now draw a polygon starting from (x y) = (14 0) continuing to (22 4), (24 4) and finally (36
0).

4 Now assign the embankment material to the polygon. This can either be done by opening
the Material sets window and then drag and drop the material set onto the polygon, or by
selecting the polygon and then in the Selection explorer set the Material option of the soil
polygon to the embankment material.

2.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Click the Generate mesh button  to generate the mesh.

The Mesh options window appears.

3 Select the Fine option in the Element distribution list and generate the mesh.
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4 Click the View mesh button  to view the mesh and the generated mesh is shown in Figure
2–3 (p. 44).

Figure 2–3: The generated mesh
5 Select the Close button on the top left of the Output program to close the mesh view.

2.8  Define and perform the calculation
The embankment construction is done in a single stage here, as we're only interested in
the stability. Note that for settlement predictions it is better to divide the construction of the
embankment in multiple phases, if necessary with periods of consolidation in between. The
embankment construction has to be done both on drained and undrained subsoil, so a total of
three calculation phases have to be defined: the initial phase and two construction phases.

2.8.1  Initial phase: Initial conditions
In the initial situation the embankment is not present yet. Since the subsoil consists of only
1 layer with a horizontal ground level the K0 procedure can be used to generate the initial
stresses. As this is the default option, no changes have to be made to the initial phase. The
model in the initial phase is shown in Figure 2–4 (p. 44).

Figure 2–4: Configuration of the initial phase

2.8.2  Phase 1: Embankment construction on drained
subsoil

1 Click the Add phase button  to create a new phase .

In the new phase the Calculation Type > Plastic analysis and the Loading type > Staged
construction are used as a default.

2 Right-click on the embankment and from the popup menu select the Activate option to
activate the soil representing the embankment. The model of phase 1 is shown in Figure 2–5
(p. 45).
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Figure 2–5: Configuration of phase 1

2.8.3  Phase 2: Embankment construction on
undrained subsoil

In this calculation phase the same embankment will be constructed, by now under the
assumption of undrained behaviour of the subsoil. This implies that the material set of the
subsoil must be changed, but also that this construction phase must start from the initial phase
as it is an alternative calculation for phase 1 rather than a continuation of phase 1.

1 In the Phase explorer select the Initial phase and then create a new phase using the Add
phase button .

Because the initial phase was the selected phase the newly created phase 2 will start from
the initial phase. In case by mistake phase 2 starts from phase 1, this can be changed by
double-clicking on Phase 2 in the Selection explorer so that the Phases window opens. In
the General section now set the option Start from phase to the initial phase and close the
Phases window again.

2 Now the soil behaviour of the subsoil must be changed to undrained by assigning the
undrained material set to the subsoil. There are several ways to do this:
●

From the navigation side bar select the Show materials button  . From the Material
sets window that opens drag and drop the material set for undrained clay on the subsoil.

● Right-click on the subsoil and from the popup menu(s) that open consecutively select the
options Soil ( ) > Soil ( ) > Set material and finally assign the material representing
the undrained subsoil .

● Select the subsoil and in the Selection explorer change the Material under the Soil
object for the material representing the undrained subsoil.

3 Finally, activate the embankment. The model for phase 2 is shown in Figure 2–6 (p. 45).

Figure 2–6: Configuration of phase 2

2.8.4  Calculate
Before starting the calculation it's recommended to choose some nodes or stress points to later
evaluate the results in for instance load-displacement or stress-strain curves. In this project we
will select a point halfway the left hand side slope to later evaluate the factor of safety.
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1 Click the Select points for curves button  on the navigation side bar.

2 Select a Node halfway the left hand side slope, hence around (x y) = (18 2).

3 Click the Update button on the top left to close the Output program and store the selected
point.

4 Click the Calculate button  to start the calculation.

2.9  Results
1 After the calculation ended, select the first phase and click the View calculations results

button .

The Output program now opens showing the deformed mesh after the construction of the
embankment on the drained subsoil.

2 From the Displayed step drop-down list at the top choose to see the results for Phase 2.
Now the deformed mesh after construction of the embankment on undrained subsoil is
shown.

Figure 2–7 (p. 46) shows the deformed mesh for both phases. In case of the drained
subsoil the embankment settles everywhere, but in case of the undrained subsoil the
embankment settles in the middle but heaves near the toes. This makes perfect sense: the
subsoil is now undrained and because of that there can be no volume change. Hence, if the
subsoil settles in the middle due to the weight of the embankment it must heave somewhere
else, typically just next to the embankment.

Figure 2–7: Deformed mesh after phase 1 (top) and phase 2 (bottom)

It can also be seen that in case of the undrained subsoil the embankment seems to widen
leading to a larger settlement at the top of the embankment. This is not immediately obvious
and it will be discussed in more detail after performing a factor of safety analysis.

3 From the Stresses menu select the option Pore pressures and then p  excess . This will show
the excess pore pressures due to the undrained loading of the subsoil. By default the pore
pressures are shown as iso-shadings but with the buttons  and  from the horizontal
button bar at the top it is possible to see the principal directions of the pore pressures, either
for all or a reduced number of stress points.
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Figure 2–8 (p. 47) shows that excess pore pressures have developed due to the
construction of the embankment. The highest excess pore pressures are of course directly
underneath the embankment, but also on either side of the toes of the embankment some
excess pore pressures occur.

Figure 2–8: Excess pore pressures after construction on undrained subsoil
4 After viewing the results, close the Output program and return to the Input program.

2.10  Safety analysis
In the design of an embankment it is important to consider not only the settlements, but also the
stability in terms of a factor of safety. It could be seen that the settlements are different for the
construction of an embankment on drained or undrained subsoil and so it would be interesting to
evaluate a global safety factor for both cases.

In structural engineering, the safety factor is usually defined as the ratio of the collapse load
to the working load. For soil structures, however, this definition is not always useful. For
embankments, for example, most of the loading is caused by soil weight and an increase in soil
weight would not necessarily lead to collapse. Indeed, a slope of purely frictional soil will not
fail in a test in which the self weight of the soil is increased (like in a centrifuge test). A more
appropriate definition of the factor of safety is therefore:

Where S represents the shear strength. The ratio of the true strength to the computed minimum
strength required for equilibrium (hence, the mobilized strength) is the safety factor that is
conventionally used in soil mechanics. For soil models using the standard Coulomb failure
condition, the safety factor is obtained as:

Where c and φ are the input strength parameters and σn is the actual normal stress component.

The parameters cr and φr are reduced strength parameters that are just large enough to maintain
equilibrium. The principle described above is the basis of the method of Safety that can be used
in PLAXIS 2D to calculate a global safety factor. In this approach the cohesion and the tangent of
the friction angle are reduced in the same proportion:

The reduction of strength parameters is controlled by a multiplier called ΣMsf that is increased
step-by-step until failure occurs. The safety factor is then defined as the value of ΣMsf at
failure, provided that at failure a more or less constant value is obtained for a number of
successive load steps with ongoing deformations.
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Note that for soil models that do no use the Coulomb failure criterion the concept of strength
reduction remains the same, but with reduction of strength parameters specific to that soil
model.

The Safety calculation option is available in the Calculation type drop-down menu in the
General section of the Phases window. If the Safety option is selected the Loading input on
the Parameters tabsheet is automatically set to Incremental multipliers, this means that the
multiplier ΣMsf will be incremented until failure occurs. The other option for the Loading input is
Target-ΣMsf, which means the multiplier ΣMsf will only increase until the specified target value
and not until failure. However, this latter option is not used here.

To calculate the global safety factor for the road embankment for both cases, follow these steps:

1. Select Phase 1 in the Phases explorer.
2. Add a new calculation phase. 
3. Double-click on the new phase to open the Phases window.
4. In the Phases window the selected phase is automatically selected in the Start from

phase_1 drop-down menu.
5. In the General subtree, set the Calculation type as Safety  from the drop down menu.
6. The Incremental multipliers option  is already selected in the Loading input box. The first

increment of the multiplier that controls the strength reduction process, Msf, is set to 0.1.
7. In order to exclude existing deformations from the resulting failure mechanism, select the

Reset displacements to zero option in the Deformation control parameters subtree.
8. The first safety calculation has now been defined.
9. Follow the same steps to create a new calculation phase that analyses the stability at the

end of construction of the embankment on undrained subsoil.
10. Click the Calculate button  to start the calculation .

The phases explorer window displaying the safety calculation is shown in Figure 2–9 (p. 48).

Figure 2–9: Phases explorer displaying the Safety calculation phases

Note:

Note that for a Safety phase the option Use pressures from the previous phase 
in the Pore pressure calculation type drop-down menu is automatically selected
and grayed out indicating that this option cannot be changed. A Safety calculation
always uses the same pore pressures as the phase for which the safety factor has to be
calculated.
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Note:

The default value of Max steps in a Safety calculation is 100. In contrast to a Staged
construction calculation, the specified number of steps is always fully executed. In
most Safety calculations, 100 steps are sufficient to arrive at a state of failure. If not, the
number of steps can be increased to a maximum of 1000.

For most Safety analyses Msf = 0.1 is an adequate first step to start up the process.
During the calculation process, the development of the total multiplier for the strength
reduction, ΣMsf, is automatically controlled by the load advancement procedure.

2.10.1  Evaluation of safety analysis results
Due to the ongoing reduction of the soil strength, additional displacements are generated during
a Safety calculation. The resulting total displacements do not have a physical meaning as they
depend on the amount of load steps that was applied: more load steps means the calculation
would push further into failure thus generating larger displacement while in reality a failing
embankment would re-establish a new equilibrium with limited deformations. However, the
incremental displacements in the final step (at failure) are very useful as they give an indication
of the likely failure mechanism. The incremental displacements are the change of displacement
per load increment. Typically this is a very small value as the load increments are small, but in
case of failure the failure zone only needs a very small change of load to generate large changes
of displacements, hence the failure zone then has large incremental displacement whereas
anywhere else in the model the incremental displacements should be small.

In order to view the mechanism for the embankment on drained subsoil:

1. Select Phase 3, that is the Safety phase following on Phase 1, and click the View calculation
results button .

2. In the Output program select the menu Deformations > Incremental displacements > |Δu|.

Figure 2–10: Shadings of the displacement increments indicating the most
applicable failure mechanism of the embankment after drained construction

The resulting plot shown in Figure 2–10 (p. 49) gives a good impression of the failure
mechanisms. The magnitude of the displacement increments is not relevant. From the results it
can be seen that the slope on the left side of the embankment fails with a classical slip surface .

By choosing phase 4 from the drop down list at the toolbar the failure mechanism for the
embankment constructed on undrained subsoil can be evaluated. The failure mechanism is no
longer limited to just the embankment, but is in fact mostly a failure of the subsoil underneath
the embankment. This also explains the widening of the embankment at the base as was
observed earlier: the soil underneath the embankment fails and moves horizontally away from
the center of the embankment shown in Figure 2–11 (p. 50).

2 Drained and undrained stability of an embankment   |  49



Figure 2–11: Shadings of the displacement increments indicating the most
applicable failure mechanism of the embankment after undrained construction

The safety factor can be obtained from the Calculation info option of the Project menu. The
Multipliers tabsheet of the Calculation information window represents the actual values of
the load multipliers. The value of ΣMsf represents the safety factor, provided that this value is
indeed more or less constant during the previous few steps.

The best way to evaluate the safety factor, however, is to plot a curve in which the parameter
ΣMsf is plotted against the displacements of a certain node. Although the displacements are not
relevant, they indicate whether or not a failure mechanism has developed.

In order to evaluate the safety factors for the three situations in this way, follow these steps:

1. Click the Curves manager button  in the toolbar.
2. Click New in the Charts tabsheet.
3. In the Curve generation window, use from the dropdown list the previously selected Node

for the x-axis. Select Deformations > Total displacements > |u|.
4. For the y-axis, select Project > Multipliers > ΣMsf. The Safety phases are considered in

the chart.
5. Press OK to close the window and generate the chart.
6. Right-click on the chart and select the Settings option in the appearing menu. The Settings

window pops up.
7. In the tabsheet corresponding to the curve click the Phases button.
8. In the Select phases window select only Phase 3 as shown in Figure 2–12 (p. 50):

Figure 2–12: The Select phases window

9. Click OK to close the Select phases window.
10. In the Settings window change the titles of the curve in the corresponding tabsheet.
11. Click the Add curve button and select the From current project option in the appearing

menu. Define the curve for the phase 4 by following the same steps as described for Phase
3.
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12. In the Chart tabsheet shown in Figure 2–13 (p. 51), set the scaling of the x-axis to
Manual and set the value of Maximum to 0.5:

Figure 2–13: The Chart tabsheet in the Settings window

13. Click Apply to update the chart according to the changes made and click OK to close the
Settings window.

14. The plot is shown as follows in Figure 41:

Figure 2–14: Evaluation of safety factor

The maximum displacements plotted are not relevant. It can be seen that for both curves a
more or less constant value of ΣMsf is obtained. Hovering the mouse cursor over a point on the
curves, a box shows up with the exact value of ΣMsf as well as the calculation phase. With the
latter it can be determined that the upper curve with a factor of safety of 1.8 is Phase 3, hence
the embankment on drained soil. Similarly the lower curve with a factor of safety of 1.4 is Phase
4, the embankment on undrained soil.
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3
Submerged construction of an

excavation

3.1   Introduction
This tutorial illustrates the use of PLAXIS 2D for the analysis of submerged construction of
an excavation. Most of the program features that were used in Tutorial 1 will be utilised here
again. In addition, some new features will be used, such as the use of interfaces and anchor
elements, the generation of water pressures and the use of multiple calculation phases. The new
features will be described in full detail, whereas the features that were treated in Tutorial 1 will
be described in less detail. Therefore it is suggested that Tutorial 1 should be completed before
attempting this exercise.

Objectives
● Modelling soil-structure interaction using the Interface feature.
● Advanced soil models (Soft Soil model and Hardening Soil model).
● Undrained (A) drainage type.
● Defining Fixed-end-anchor.
● Creating and assigning material data sets for anchors.
● Simulation of excavation (cluster de-activation).
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3.2  Geometry
This tutorial concerns the construction of an excavation close to a river. The submerged
excavation is carried out in order to construct a tunnel by the installation of prefabricated tunnel
segments which are 'floated' into the excavation and 'sunk' onto the excavation bottom. The
excavation is 30 m wide and the final depth is 20 m. It extends in longitudinal direction for
a large distance, so that a plane strain model is applicable. The sides of the excavation are
supported by 30 m long diaphragm walls, which are braced by horizontal struts at an interval
of 5 m. Along the excavation a surface load is taken into account. The load is applied from 2 m
from the diaphragm wall up to 7 m from the wall and has a magnitude of 5 kN/m2/m.

The upper 20 m of the subsoil consists of soft soil layers, which are modelled as a single
homogeneous clay layer. Underneath this clay layer there is a stiffer sand layer, which extends
to a large depth and 30 m of the sand layer are considered in the model which is shown in Figure
3–1 (p. 53).

5 kN/m2/m5 kN/m2/m

Sand 

to be excavated

Strut

Diaphragm wall

Clay

20 m

10 m

19 m

1 m

5 m 2 m 30 m 2 m 5 m 43 m43 m

Figure 3–1: Geometry model of the situation of a submerged excavation

Since the geometry is symmetric, only one half (the left side) is considered in the analysis.
The excavation process is simulated in three separate excavation stages. The diaphragm wall
is modelled by means of a plate, such as used for the footing in the previous tutorial. The
interaction between the wall and the soil is modelled at both sides by means of interfaces. The
interfaces allow for the specification of a reduced wall friction compared to the friction in the
soil. The strut is modelled as a spring element for which the normal stiffness is a required input
parameter.

3.3  Create new project
1

Start PLAXIS 2D by double-clicking the icon of the Input program .

2 Click Start a new project.

3 In the Project tabsheet of the Project properties window, enter an appropriate title.
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4 In the Model tabsheet keep the default options for Model (Plane strain}, and Elements (15-
Node).

5 Set the model Contour to xmin = 0 m, xmax = 65 m, ymin = -30 m and ymax = 20 m.

6 Keep the default values for units and constants and click OK.

The project is created with the given properties. The Project properties window closes and the
Soil mode view will be shown, where the soil stratigraphy can be defined.

3.4  Define the soil stratigraphy
To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

2 Add the top soil layer and specify its height by setting the top level to 20 m and the bottom
level to 0 m.

3 Add the bottom soil layer and specify its height by keeping the top level at 0 m and by
setting the bottom level to -30 m.

4 Set the Head in the borehole to 18 m.

Next the material data sets are defined and assigned to the soil layers, see 3.5 Create and assign
material data sets (p. 54).

3.5  Create and assign material data sets
Two data sets need to be created; one for the clay layer and one for the sand layer.

The layers have the following properties as shown in Table 3–1 (p. 54):

Table 3–1: Material properties of the sand and clay layer and the interfaces

Parameter Name Clay Sand Unit

General

Soil model Model Hardening
Soil Hardening soil -

Drainage type Type Undrained (A) Drained -

Unsaturated unit weight γunsat 16 17 kN/m3

Saturated unit weight γsat 18 20 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 4 · 103 40 · 103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 3.3 · 103 40 · 103 kN/m2
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Mechanical

Unloading / reloading stiffness Eur 
ref 12 · 103 120 · 103 kN/m2

Poisson's ratio νur 0.15 0.2 -

Power for stress-level dependency
of stiffness m 1.0 0.5 -

Cohesion (constant) c'ref 1 0 kN/m2

Friction angle φ' 25 32 °

Dilatancy angle ψ 0 2 °

K0-value for normal consolidation K0 nc 0.5774 0.4701 -

Groundwater
Data set - Standard Standard -

Soil type - Coarse Coarse -

Use defaults - None None -

Permeability in horizontal direction kx 1 · 10-3 1 m/day

Permeability in vertical direction ky 1 · 10-3 1 m/day

Interfaces
Srength determination - Manual Manual -

Interface reduction factor Rinter 0.5 0.67 -

Initial
K0 determination - Automatic Automatic -

Pre-overburden pressure POP 5 0 kN/m2

Over-consolidation ratio OCR 1 1 -

To create the material sets, follow these steps:

1 Click the Materials button  in the Modify soil layers window.

The Material sets window pops up, where the Soil and interfaces option is selected by
default as the Set type.

2 Click the New button in the Material sets window to create a new data set.

3 For the clay layer, enter Clay for the Identification and select Hardening Soil as the Soil
model. Set the Drainage type to Undrained (A).

4 Enter the properties of the clay layer, as listed in Table 3–1 (p. 54), in the General,
Mechanical and Flow parameters tabsheets.

5 Click the Interfaces tab. Select the Manual option in the Strength drop-down menu. Enter
a value of 0.5 for the parameter Rinter.
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This parameter relates the strength of the soil to the strength in the interfaces, according to
the equations:  and  where: ,
see Table 3–1 (p. 54)

Hence, using the entered Rinter-value gives a reduced interface friction (wall frictions)
and interface cohesion (adhesion) compared to the friction angle and the cohesion in the
adjacent soil.

6 In the Initial tabsheet keep the default option for the K0 determination and the default value
for the overconsolidation ratio (OCR). Set the pre-overburden pressure (POP) value to 5.0.

7 For the sand layer, enter Sand for the Identification and again select Hardening soil as the
Soil model. The drainage type should be set to Drained.

8 Enter the properties of the sand layer, as listed in Table 3–1 (p. 54), in the corresponding
edit boxes of the General and Mechanical tabsheet.

9 Click the Interfaces tab. In the Strength box, select the Manual option. Enter a value of
0.67 for the parameter Rinter. Close the data set.

10 Assign the material datasets to the corresponding soil layers.

Note:
● When the Rigid option is selected in the Strength drop-down, the interface has

the same strength properties as the soil (Rinter = 1.0).
● Note that a value of Rinter < 1.0 , reduces the strength as well as the stiffness

of the interface (for more info see the corresponding section in the Reference
Manual.

● Instead of accepting the default data sets of interfaces, data sets can directly
be assigned to interfaces in the Model explorer by selecting Interfaces >
Interface_#_# > Material mode.

3.6  Define the structural elements
The creation of diaphragm walls, strut, surface load and excavation levels is described below.

Click on the Structures tab to open the Structures mode and proceed with the input of
structural elements in the model:

3.6.1  Define the diaphragm wall
A diaphragm wall with the following material properties mentioned in Table 3–2 (p. 57) has to
be defined:
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Table 3–2: Material properties of the diaphragm wall (plate)

Property Name Value Unit

General
Material type - Elastic -

Weight w 10 kN/m/m

Prevent punching - No -

Mechanical
Isotropic - Yes -

Axial stiffness EA1 7.5 · 10 6 kN/m

Bending stiffness EI 1.0 · 10 6 kNm2/m

Poisson's ratio ν 0.0 -

1
Click the Create structure button  in the side toolbar.

2 In the expanded menu select the Create plate  option as shown in Figure 3–2 (p. 57).

Figure 3–2: Create plate option
3 In the drawing area move the cursor to position (50 20) at the upper horizontal line and click.

Move 30 m down (50 -10) and click. Click the right mouse button to finish the drawing.

4 Click the Show materials button  in the side toolbar. Set the Set type parameter in the
Material sets window to Plates and click the New button. Enter Diaphragm wall as an
Identification of the data set and enter the properties as given in Table 3–2 (p. 57).

5 Click OK to close the data set.

6 Drag the Diaphragm wall data set to the wall in the geometry and drop it as soon as the
cursor indicates that dropping is possible.

7 Click OK to close the Material sets window.
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Note: In general, only one point can exist at a certain coordinate and only one
line can exist between two points. Coinciding points or lines will automatically be
reduced to single points or lines. More information is available in the Reference
Manual

3.6.2  Define the interfaces
1 Right-click on the plate representing the diaphragm wall.

Figure 3–3: Create positive interface
2 Select Create > Positive interface .

3 In the same way assign a negative interface as well as shown in Figure 3–3 (p. 58).
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Note:
● In order to identify interfaces at either side of a geometry line, a positive sign ( )

or negative sign ( ) is added. This sign has no physical relevance or influence
on the results.

● A Virtual thickness factor can be defined for interfaces. This is a purely
numerical value, which can be used to optimise the numerical performance of
the interface. To define it, select the interface in the drawing area and specify
the value to the Virtual thickness factor parameter in the Selection explorer.
Non-experienced users are advised not to change the default value. For more
information about interface properties see the Reference Manual - Chapter 5 -
Advanced Geometric Modelling options.

3.6.3  Define the excavation levels
1 Click the Create line button  in the side toolbar.

2 To define the first excavation stage move the cursor to position (50 18) at the wall and click.
Move the cursor 15 m to the right (65 18) and click again. Click the right mouse button to
finish drawing the first excavation stage.

3 To define the second excavation stage move the cursor to position (50 10) and click.
Move to (65 10) and click again. Click the right mouse button to finish drawing the second
excavation stage.

4 The third excavation stage is automatically defined as it corresponds to the boundary
between the soil layers (y = 0).

3.6.4  Define the strut
The material properties of the strut is shown in Table 3–3 (p. 59) .

Table 3–3: Material properties of the strut (anchor)

Property Name Strut Unit

General
Material type - Elastic -

Mechanical
Out-of-plane spacing Lspacing 5 m

Axial stiffness EA 2 · 10 6 kN

To define the strut follow these steps:

1
Click the Create structure button in the side toolbar and select the Create fixed-end
anchor  in the expanded menu.
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2 Move the cursor to (50 19) and click the left mouse button. A fixed-end anchor is added,
being represented by a rotated T with a fixed size.

3 Click the Show materials button  in the side toolbar. Set the Set type parameter in
the Material sets window to Anchors and click the New button. Enter Strut as an
Identification of the data set and enter the properties as given in Table 3–3 (p. 59). Click
OK to close the data set.

4 Click OK to close the Material sets.

5 Make sure that the fixed-end anchor is selected in the drawing area.

6 In the Selection explorer assign the material data set to the strut by selecting the
corresponding option in the Material drop-down menu.

The anchor is oriented in the model according to the Directionx and Directiony parameters in
the Selection explorer . The default orientation is valid in this tutorial.

Figure 3–4: Parameters for fixed-end anchors in the Selection explorer
7 Enter an Equivalent length of 15m corresponding to half the width of the excavation as

shown in Figure 3–4 (p. 60).

Note: The Equivalent length is the real distance between the connection point and
the fixed end point. For an excavation problem that is typically half the width of the
excavation as the axis of symmetry in the middle of the excavation is considered
fixed.

3.6.5  Define the distributed load
1 Click the Create load button  in the side toolbar.

2 Select the Create line load option  in the expanded menu to define a distributed load.

3 Move the cursor to (43 20) and click, then move the cursor 5m to the right to (48 20) and
click again. Right-click to finish the drawing.

4 In the Selection explorer assign a value of -5 kN/m/m to the y-component of the load
(qy,start,ref) as shown in Figure 3–5 (p. 61).
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Figure 3–5: Components of the distributed load in the Selection explorer

3.7  Generate the mesh
In order to generate the mesh, follow these steps:

1 Proceed to the Mesh mode .

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh as shown in Figure 3–6 (p. 61).

Figure 3–6: The generated mesh
4 Click the Close tab to close the Output program.
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3.8  Define and perform the calculation
In practice, the construction of an excavation is a process that can consist of several phases.
First, the wall is installed to the desired depth. Then some excavation is carried out to create
space to install an anchor or a strut. Then the soil is gradually removed to the final depth of the
excavation. Special measures are usually taken to keep the water out of the excavation. Props
may also be provided to support the retaining wall.

In PLAXIS 2D, these processes can be simulated with the Staged construction loading type
available in the General subtree of the Phases window. It enables the activation or deactivation
of weight, stiffness and strength of selected components of the finite element model. Note
that modifications in the Staged construction mode of the program are possible only for this
type of loading. The current tutorial explains the use of this powerful calculation option for the
simulation of excavations.

3.8.1  Initial phase
1 Click the Staged construction tab to proceed with the definition of calculation phases.

The initial phase has already been created.

2 Keep its calculation type as K0 procedure. Make sure all the soil volumes are active and all
the structural elements and load are inactive.

3.8.2  Phase 1: External load
1 In the Phases explorer click the Add phase button  to create a new phase.

The default settings are valid for this phase. In the model the full geometry is active except
for the wall, interfaces, strut and load.

2 Click the Select multiple objects button in the side toolbar. In the appearing menu select
Select line > Select plates as shown in Figure 3–7 (p. 63).
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Figure 3–7: Select multiple objects
3 In the drawing area define a rectangle that includes all the plate elements as shown in Figure

3–8 (p. 63).

4 Right-click the wall in the drawing area and select the Activate option from the context
menu.

Figure 3–8: Selected multiple plate elements in the model
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When the wall is unselected it can be seen that wall is now visible in the color that is
specified in the material dataset.

5 Right-click the distributed load to activate it and select the Activate option from the
appearing menu.

The load has been defined in the Structures mode as -5 kN/m/m. The value can be checked
in the Selection explorer.

6 Make sure all the interfaces in the model are active.

Note: The selection of an interface is done by right-clicking the corresponding
geometry line and subsequently selecting the corresponding interface (positive or
negative) from the context menu.

3.8.3  Phase 2: First excavation stage
1 Click the Add phase button  in the Phases explorer.

A new calculation phase appears in the Phases explorer. Note that the program
automatically presumes that the current phase should start from the previous one and that
the same objects are active.

Tip: To copy the settings of the parent phase, select the phase in the Phases
explorer and then click the Add phase button. Note that the settings of the parent
phase are not copied when it is specified by selecting it in the Start from phase
drop-down menu in the Phases window.

2 The default settings are valid for this phase. In the Staged construction mode all the
structure elements except the fixed-end anchor are active.

3 In the drawing area right-click the top right cluster and select the Deactivate option in the
appearing menu.

The model for the first excavation phase is shown in Figure 3–9 (p. 65):
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Figure 3–9: Model for the first excavation phase

3.8.4  Phase 3: Installation of a strut
1 Click the Add phase button  in the Phases explorer.
2 Activate the strut.

The strut turns black to indicate it is active.

3.8.5  Phase 4: Second (submerged) excavation stage
1 Click the Add phase button  to add a new phase.

2 Deactivate the second cluster from the top on the right side of the mesh. It should be the
topmost active cluster.

Note: Note that in PLAXIS 2D the pore pressures are not automatically deactivated
when deactivating a soil cluster. Hence, in this case, the water remains in the
excavated area and a submerged excavation is simulated.

The resulting model is shown in Figure 3–10 (p. 66) :
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Figure 3–10: Model for the second excavation phase

3.8.6  Phase 5: Third excavation stage
In the final calculation stage the excavation of the last clay layer inside the pit is simulated.

1 Click the Add phase button  to add a new phase.

2 Deactivate the third cluster from the top on the right hand side of the mesh.

The model for the phase is shown in Figure 3–11 (p. 67):
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Figure 3–11: Model for the third excavation phase
The calculation definition is now complete.

3.8.7  Execute the calculation
Before starting the calculation it is suggested to select the nodes or stress points for the
generation of load-displacement curves or stress and strain diagrams later. To do this, follow the
steps given below.

1 Click the Select points for curves button  in the side toolbar.

The connectivity plot is displayed in the Output program and the Select points window is
activated.

2 Select some nodes on the wall at points where large deflections can be expected (e.g. 50
10). The nodes located near that specific location are listed. Select the convenient one by
checking the box in front of it in the list.

3 Click on the Update tab at the top left to save the selected points, close the Output program
and go back to the Input program.

4 Click the Calculate button  to calculate the project.

During a Staged construction calculation phase, a multiplier called ΣMstage is increased from
0.0 to 1.0. This parameter is displayed in the calculation info window. As soon as ΣMstage has
reached the value 1.0, the construction stage is completed and the calculation phase is finished.
If a Staged construction calculation finishes while ΣMstage is smaller than 1.0, the program will
give a warning message. The most likely reason for not finishing a construction stage is that
a failure mechanism has occurred, but there can be other causes as well. See the Reference
Manual for more information about Staged construction.
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3.9  View the calculation results
In addition to the displacements and the stresses in the soil, the Output program can be used to
view the forces in structural objects. To examine the results of this project, follow these steps:

3.9.1  Displacements and stresses
To view displacements and stresses, follow these steps:

1 Click the final calculation phase in the Calculations window.

2 Click the View calculation results button  on the toolbar.

As a result, the Output program is started, showing the deformed mesh (scaled up) as
shown in Figure 3–12 (p. 68) at the end of the selected calculation phase, with an
indication of the maximum displacement:

Figure 3–12: Deformed mesh after the third excavation stage

Note:

In the Output program, the display of the loads, fixities and prescribed
displacements applied in the model can be toggled on/off by clicking the
corresponding options in the Geometry menu.

3 Select the menu Deformations > Incremental displacements > |Δu|.

The plot shows colour shadings of the displacement increments, which indicates the
formation of a mechanism of soil movement behind the wall.
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4 Click the Arrows button  in the toolbar.

The plot shows the displacement increments of all nodes as arrows. The length of the
arrows indicates the relative magnitude.

5 Select the menu Stresses > Principal effective stresses > Effective principal stresses.

The plot in Figure 3–13 (p. 69) shows the effective principal stresses at the three middle
stress points of each soil element with an indication of their direction and their relative
magnitude. Note that the Center principal directions button is selected in the toolbar. The
orientation of the principal stresses indicates a large passive zone under the bottom of the
excavation and a small passive zone behind the strut.

Figure 3–13: Principal stresses after excavation

3.9.2  Shear forces and bending moments
To plot the shear forces and bending moments in the wall follow the steps given below.

1 Double-click the wall.

A new window is opened showing the axial force.

2 Select the menu Forces > bending moment M.

The bending moment in the wall is displayed in Figure 55 with an indication of the maximum
moment:
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Figure 3–14: Bending moments in the wall
3 Select Shear forces Q from the Forces menu.

The plot now shows the shear forces in the wall.

Note: The Window menu may be used to switch between the window with the
forces in the wall and the stresses in the full geometry. This menu may also be
used to Tile or Cascade the two windows, which is a common option in a Windows
environment.

4 Select the first window (showing the effective stresses in the full geometry) from the
Window menu. Double-click the strut.

The strut force (in kN) is shown in the displayed table.

5 Click the Curves manager button on the toolbar.

As a result, the Curves manager window pops up.

6 Click New to create a new chart.

The Curve generation window pops up.

7 For the x-axis select the point A from the drop-down menu. In the tree select Deformations
- Total displacements - |u|.

8 For the y-axis keep the Project option in the drop-down menu. In the tree select Multiplier -
ΣMstage.

9 Click OK to accept the input and generate the load-displacement curve.

As a result the curve is plotted as shown in Figure 3–15 (p. 71) :
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Figure 3–15: Load-displacement curve of deflection of wall
The curve shows the construction stages. For each stage, the parameter ΣMstage changes from
0.0 to 1.0. The decreasing slope of the curve in the last stage indicates that the amount of plastic
deformation is increasing. The results of the calculation indicate, however, that the excavation
remains stable at the end of construction.

3 Submerged construction of an excavation   |  71



4
Stabilisation of a rock slope

4.1  Introduction
This tutorial illustrates the use of PLAXIS 2D for simulating the excavation of a road in a siltstone
rock mass. This tutorial introduces the Discontinuity and Cable elements in order to model the
road cut.

Objectives:
● Use the Gravity loading method to generate the initial stresses.
● Model the fault using the Discontinuity feature.
● Model the reinforcement with the Cable feature.
● Determine the influence of reinforcements on the factor of safety.
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4.2  Geometry
In this tutorial, the geometry of a natural sloping ground is considered, in which a road cut slope
is excavated. An unsupported excavation of the road cut will cause instability of the rock slope
and therefore, the excavation is conducted in two stages. After the first 9 m of excavation, the
excavated slope is reinforced with two rows of cables with 3 m spacing. The third row of cables
is installed after the final excavation of 6 m is completed. The final excavation is then additionally
reinforced with the construction of a 3 m retaining wall with backfill. The retaining wall acts a
rock fall barrier to avoid the rocks rolling onto the road.

A fault at a dip angle of 38.7o is located within the rock mass, and the fault daylights near the
toe of the slope due to the excavation. The distance between the fault and the slope face at the
top is 12 m. The geometry of the rock slope, along with the fault and reinforcements, is shown in
Figure 4–1 (p. 73).

Figure 4–1: Geometry of the rock slope with reinforcement

4.3  Create a new project
To create a new project, follow the following steps:

1. Start the Input program and select Start a new project from the Quick Start dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-

Noded).
4. Set the model Contour to: xmin = 0 m, xmax = 45 m, ymin = -13 m and ymax = 15 m.
5. Keep the default values for units, constants, and general parameters and click OK to close

the Project properties window.
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4.4  Create and assign material data sets
In this tutorial, the rock mass is a siltstone modelled using the Hoek-Brown constitutive model.
To create a material set for the rock mass, follow these steps:

1 Select the Show materials button  and the Material sets window will pop up.

2 Click the New button in the Material sets window to create the data set as shown in the
Table 4–1 (p. 74).

Table 4–1: Material properties of the siltstone

Parameter Name Value Unit

General
Soil model - Hoek Brown -

Drainage type - Drained -

Unsaturated unit weight γunsat 24 kN/m3

Saturated unit weight γsat 24 kN/m3

Mechanical

Young's modulus Erm 1 · 106 kN/m2

Poisson's ratio ν 0.25 -

Uni-axial compressive strength
intact rock 25 · 103 kN/m2

Intact rock parameter mi 10 °

Geological strength index GSI 39 -

Disturbance factor D 0 -

Tension cut-off - True -

Tensile strength - 30 kN/m2

Dilatancy angle ψmax 10 °

Dilatancy parameter 50 kN/m2
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3 Select the created polygon and assign the Material to the soil polygon as shown in Figure 4–
2 (p. 75).

Figure 4–2: Assigning soil material to the created polygon

4.4.1  Define the rock mass stratigraphy
The geometry of the natural slope must be defined. To do so, follow these steps:

1 Click the Structures tab to proceed with the input of structural elements in the Structures
mode.

2 Click the Snapping options button  in the bottom toolbar. In the appearing window, set the
Spacing to 0.5 and the Number of snap intervals to 1 as shown in Figure 4–3 (p. 75).

Figure 4–3: Window showing Snapping options

3
Click the Create soil polygon button  in the side toolbar and select the Create soil
polygon option.

4 Create the rock mass either in the command line or by clicking on points at coordinates:

(0 -13) (0 15) (20 15) (23.5 13) (27 10.5) (29 8.5) (32 6) (35 4) (37
 2.5) (40 0) (42.5 -1) (45 -2) (45 -13)
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4.5  Define the structural elements
The creation of the fault, the cable elements, and the retaining wall are described below.

4.5.1  Define the fault
The fault is modelled using a discontinuity, and its material properties are defined in Table 4–2
(p. 76) below:

Table 4–2: Material properties of the fault (discontinuity)

Parameter Name Value Unit

General
Material model - Mohr-Coulomb -

Drainage type - Drained -

Mechanical

Normal stiffness 1·106 kN/m3

Shear stiffness 100·103 kN/m3

Strength method - Peak

Cohesion 8 kN/m2

Friction angle 20 o

Dilatancy angle 0 o

Consider gap closure - True -

1 In the Structures mode, click the Create line button  and select the Create discontinuity
option .

2 Draw the discontinuity through the points (8 15) and (42 -13).

3 Select the discontinuity, then in the Selection explorer click on Material. This will display a
drop-down list.

4
Click the Add button  to create and assign a new material set for the discontinuity as
shown in Figure 4–4 (p. 77).

5 Define the material data set for the discontinuity based on the properties listed in Table 4–2
(p. 76).
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Figure 4–4: Material assignment of discontinuity in the Selection explorer

4.5.2  Define the excavation of the road cut
The road cut is excavated in two stages with a total height of 15 m. The first excavation stage
corresponds to the upper 9 m and the remaining 6 m is the second excavation stage. To define
the excavation follow these steps:

1 Define the slope face of the road cut by drawing a line  passing through points (20 15) and
(25 0).

2 Define the bottom of excavation (roadway) by drawing a line through points (25 0) and (40
0).

3 Define the upper 9 m of excavation by drawing a horizontal line  from (23 6) to the point
where it intersects with the initial slope surface at (32 6).

4.5.3  Define the cables
The reinforcement of the upper slope after the first excavation stage is achieved by creating two
rows of 25.4 mm diameter grouted cable elements. The lower slope after the second excavation
is reinforced by the third row of cables. The three rows of cables are 3 m above each other.

The coordinates of the cables and the material properties of the cables are listed in Table 4–3 (p.
77) and Table 4–4 (p. 78) respectively.

Table 4–3: Cable element coordinates

Cable location First point Second point
Top (21.5 10.5) (11.5 7)

Middle (22.5 7.5) (12.5 4)

Bottom (23.5 4.5) (13.5 1)
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Table 4–4: Properties of the cables

Parameter Name Value Unit

General
Material type - Elastoplastic -

Mechanical

Cable bolt spacing 3 m

Cross section type - Predefined -

Predefined cross section type - Solid circular beam -

Diameter 0.0254 m

Stiffness 98.6·106 kN/m2

Compressive yield strength 0 kN

Tensile yield strength 548 kN

Shear stiffness 15·106 kN/m2

Strength distribution - Uniform -

Cohesive strength - 800 kN/m

Bond frictional angle 20 o

Failure surface perimeter - Predefined -

1 In the side tool bar click on the Create line button  and then select the Create cable option

.

2 Draw a line from (21.5 10.5) to (11.5 7) to create the first row of cables.

3 Repeat step 2 to define the middle and bottom rows of the cables using the coordinates
given in Table 4–3 (p. 77).

4 Click on Material sets   > Set type > Cables and click on New to create the cable material
data set based on the parameters listed in Table 4–4 (p. 78).

5 Multi-select all the cables in the drawing area, then in the Selection explorer assign the
cable material by choosing the corresponding option in the Material drop-down menu.

4.5.4  Define the retaining wall and backfill
The retaining wall is modelled with a thickness of 1 m, constructed at the toe of the rock slope.
The backfill is provided between the slope face and the retaining wall, with its thickness varying
along the height. The material properties of the retaining wall and the backfill are shown in Table
4–5 (p. 79) and Table 4–6 (p. 79) respectively.
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Table 4–5: Material properties of the retaining wall

Parameter Name Value Unit

General
Soil model - Mohr-Coulomb -

Drainage type - Non-porous -

Unsaturated unit weight 24 kN/m3

Mechanical

Young's modulus 27·106 kN/m2

Poisson's ratio 0.15 -

Cohesion 500 kN/m2

Friction angle 35 o

Dilatancy angle 5 o

Tension cut-off - True

Tensile strength - 750 kN/m2

Table 4–6: Material properties of the backfill

Parameter Name Value Unit

General
Soil model - Mohr-Coulomb -

Drainage type - Drained -

Unsaturated unit weight 20 kN/m3

Saturated unit weight 20 kN/m3

Mechanical

Young's modulus 100·103 kN/m2

Poisson's ratio 0.3 -

Cohesion 5 kN/m2

Friction angle 45 o

Dilatancy angle 15 o

To define the geometry of the retaining wall and backfill, follow these steps:

1 Click on the Create line button  and then select the Create line option .

2 Draw the retaining wall by defining lines through the points (25.5 0), (25.5 3) then (25.5 3),
(26.5 3) and (26.5 3), (26.5 0).
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3 Define the backfill by drawing a line from (25.5 3) at the retaining wall to the sloping face of
the rock cut at (24 3).

4 Create the separate materials for the retaining wall and the backfill in the Material sets >
Soil and interfaces using the parameters listed in Table 4–5 (p. 79) and Table 4–6 (p.
79). These materials will be assigned later in the Staged construction mode.

Figure 4–5: Final geometry of the model

4.6  Generate the mesh
1. Proceed to the Mesh mode.
2. Select the soil polygon enclosed between the lower slope, the discontinuity and the third

cable row as shown in Figure 4–6 (p. 80). In the Selection explorer set the coarseness
factor to 0.5.

Figure 4–6: Refining the mesh for the selected soil polygon
3.

Click the Generate mesh  button to generate the mesh. The Mesh options window will
appear.

4. Select the Medium option in the Element distribution list, and generate the mesh.
5.

Click the View mesh button  to view the mesh. The generated mesh is shown in Figure 4–
7 (p. 81).

6. Select the Close button on the top left of the Output program to close the mesh view.
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Figure 4–7: The generated mesh

Note:

In areas where large stress concentrations or large deformation gradients are expected,
it is desirable to have a more accurate (finer) finite element mesh, whereas other parts
of the geometry might not require a fine mesh. Such a situation often occurs when the
geometry model includes edges or corners or structural objects. Local refinement is
based on a local coarseness factor that can be specified for each geometry entity.

4.7  Define and perform the calculation
The construction of this project consists of the initial phase and eight phases.
● In the Initial phase, the initial stresses are generated using the Gravity loading method.
● Phase 1 involves the excavation of the top 9 m.
● Phase 2 includes the installation and connection of the first two rows of cables to the face of

the rock cut.
● Phase 3 entails a further 6 m excavation to reach the designed level of the roadway.
● Phase 4 includes the installation of the third row of cable to the face of the rock cut.
● Phase 5 involves the construction of the retaining wall near the toe of the road cut.
● Phase 6 involves placing the backfill between the slope face and the retaining wall.

Additionally, a safety analysis is performed for both Phase 3 and Phase 6 respectively.

4.7.1  Initial phase: Initial conditions
The initial stress field is generated by means of the  Gravity loading method.

1 Proceed to the Staged construction mode.

2 Activate all the polygons of the original sloping rock mass.

3 Activate the discontinuity by selecting it in the Model explorer. All other structural
components (cables) should remain deactivated.
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4 In the Phases explorer, double-click the initial phase and for Calculation type select the
Gravity loading option. The other default parameters for the initial phase remain the same.

5 Click OK to close the Phases window.

Note: The water conditions are not considered in this tutorial example, therefore the
pore pressure calculation options are neglected.

4.7.2  Phase 1: First excavation stage
1 Click the Add phase button  to create a new phase.

2 Deactivate the upper 9 m cluster of the excavation.

The model for the Phase 1 is shown in Figure 4–8 (p. 82) below:

Figure 4–8: Configuration of Phase 1

4.7.3  Phase 2: Installation of the first two rows of
cables

1 In the Phases explorer, click on the Add phase button  .

2 Select the first two cables and activate them in the Selection explorer by clicking on the
checkbox in front of the Cables.

3 In the Selection explorer, click the checkbox for Adjust prestress and assign a pre-stress
force of 200 kN.

The model for the Phase 2 is shown in Figure 4–9 (p. 83) below:
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Figure 4–9: Configuration of Phase 2

Note: When the Adjust prestress box is selected, a prestress force (per cable, force
unit) is applied to the cable, while bond shear force is assumed to be zero [State:
Unbonded]. When the Adjust prestress box is unselected, in a subsequent phase, it is
assumed that bond interaction with the surrounding rock is developed [State: Bonded].
By default, in a calculation phase following a phase in which an anchor or a cable
was prestressed, the prestress setting is NOT continued but the prestressing force is
maintained. In this way, the existing cable force is used as a start condition and will
develop 'naturally' based on changes of stresses and forces in the model.

4.7.4  Phase 3: Second excavation stage
1. Click the Add phase  button  to add a new phase.
2. Deactivate the soil polygon of the second excavation.
3. Deactivate the lines of the discontinuity that are inside the second excavation.

The model configuration for Phase 3 is shown in Figure 4–10 (p. 83) below:

Figure 4–10: Configuration of Phase 3
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4.7.5  Phase 4: Installation of the third cable
1 Click the Add phase button to create a new phase.

2 Select the third cable and activate it in the Selection explorer by clicking on the checkbox in
front of the Cables.

3 In the Selection explorer, click the checkbox for Adjust prestress and assign a pre-stress
force of 200 kN.

The model configuration for Phase 4 is shown in Figure 4–11 (p. 84).

Figure 4–11: Configuration of Phase 4

4.7.6  Phase 5: Construction of the retaining wall
1 Click the Add phase button  to add a new phase.

2 Activate the retaining wall and assign the material to the retaining wall according to Table 4–
5 (p. 79).

The model configuration for Phase 5 is shown in Figure 4–12 (p. 84) below:

Figure 4–12: Configuration of Phase 5
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4.7.7  Phase 6: Backfilling
1 Click the Add phase button  to add a new phase.

2 Activate the backfill and assign the material to the backfill according to Table 4–6 (p. 79).

The model configuration for Phase 6 is shown in Figure 4–13 (p. 85) below:

Figure 4–13: Configuration of Phase 6

4.7.8  Phase 7 and Phase 8: Safety analysis
To design the road cut slope, it is important to consider the stability during the excavation and
also after the completion of construction. Therefore, it is necessary to evaluate the global safety
factor of Phase 3 (second excavation stage), and Phase 6 (After backfilling). To calculate the
global safety factor for these two situations, follow these steps:

1 Select Phase 3 in the Phases explorer.

2 Add a new calculation phase.

3 Double-click on the new phase to open the Phases window.

4 In the Phases window, Phase 3 is automatically selected from the Start from phase drop-
down menu.

5
In the Calculation type box, select Safety .

6 In the Deformation control parameters section select the Reset displacements to zero
option in order to exclude the existing deformations from the previous calculations.

7 In the Numerical control parameters section leave selected the Use default iter
parameters. The safety calculation is now defined for Phase 3.

8 Follow the same steps as mentioned above to create a new calculation phase that analyses
the stability of the final phase after the construction of the retaining wall and the backfill
(Phase 6).

The phases after defining the safety calculations are displayed in Figure 4–14 (p. 86).
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Figure 4–14: Safety calculation phases

4.8  Calculate
Before initiating the calculation, it is recommended to select some nodes in order to generate the
plots to determine the factor of safety at a later stage. To do this, follow these steps.

1 Click on the Select points for curves button  in the side toolbar.

2 Select the characteristic point (23 6) for curves and click on Update.

3 Click on the Calculate button  to compute the project.

4 Once the calculation is completed, save the project by clicking on the Save button  .

4.9  Results
For this tutorial, the results for the excavation phases and the safety analysis are evaluated.

4.9.1  Evaluation of results
1 After completing the calculations, select Phase 3 (second excavation stage) and click on the

View calculation results button . The Output program will show the deformed mesh after
the second excavation stage. Then, zoom in the toe area to inspect the deformed mesh.

Figure 4–15 (p. 87) shows the deformed mesh for the Phase 3.
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Figure 4–15: The deformed mesh after the second excavation stage
2 To inspect the resulting axial force in the cables, in the toolbar from the Displayed step

button drop-down menu, go to Phase 6. Click on the Drag a window to select structures
button  in the side toolbar and drag the mouse to define a rectangle encompassing all
the cables. Select the  Cable option in the appearing window, as shown in Figure 4–16 (p.
87).

Figure 4–16: Select structures window
3 Click View. Note that the cables are displayed in the Structures view.

4 From the Forces menu, select the  option to view the shear force developed in the
grouted segments as displayed in Figure 4–17 (p. 88).
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Figure 4–17: Resulting shear force in the bond Ts,bond after backfilling

5 Again from the Forces menu, select the Axial forces N  option as shown in Figure 4–18 (p.
88).

Figure 4–18: Axial forces in the cables after backfilling
Figure 4–17 (p. 88) and Figure 4–18 (p. 88) illustrates that the axial forces are considerably
intensified at the intersection of cables and the fault, where the shear force in the bond also
develops. The cable forces are mobilised when the rock face moves along the discontinuity.
However, after the installation of the third cable there is no further movement of the rock face
so the forces in the lower cable is not mobilised. The main function of the lower cable is to
contribute to a higher factor of safety rather than to limit the movement of the rock face under
normal conditions.

4.9.2  Evaluation of safety analysis results
To assess the stability of the road cut slope design, a safety analysis is performed for this
project based on the strength reduction method. Due to the ongoing reduction of the soil
strength, additional displacements are generated during a safety calculation. The incremental
displacements in the final step of failure are evaluated to assess the possible failure mechanism.
To view the incremental displacements of the slope resulting from the second excavation, follow
these steps:
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1
Select Phase 7 in the Input program, and click on the View calculation results button ,
which is the Safety phase starting from Phase 3.

2 In the Output program, select the menu Deformations > Incremental displacements > |
Δu|, to display the contour plots of total incremental displacement of the safety calculation
after the second excavation stage.

3 From the Displayed step drop-down menu in the toolbar, select Phase 8 to view the
results of the safety calculation for the rock slope after the construction of the backfill and
retaining wall.

The results are shown in Figure 4–19 (p. 89).

Figure 4–19: Shadings of the displacement increments indicating
the most applicable failure mechanism after the second

excavation stage (first) and after the backfilling (second)
4 From the top toolbar, click the Arrows button , and the incremental displacement

movement vectors will be displayed. The length of the arrow indicates the magnitude of
the specific incremental displacement, while the arrow direction indicates the displacement
increment direction, as shown in Figure 4–20 (p. 89) .

Figure 4–20: Displacement increments after the second
excavation stage (first) and after the backfilling (second)

Figure 4–19 (p. 89) and Figure 4–20 (p. 89) shows the contour plots and arrows of
the incremental displacement from the safety calculations for both Phases 3 and 6. The
magnitude of the displacement increments is not relevant, but it indicates whether or not
a failure mechanism has developed. In Figure 4–19 (p. 89), the rock slope tends to

4 Stabilisation of a rock slope   |  89



slide down along the discontinuity, indicating the need for stabilisation by constructing a
retaining wall. In both the figures it is seen that the potential failure mechanism is a planar
failure of the rock block sliding along the discontinuity.

It can be seen that the value of ΣMsf remains relatively constant from a certain step
onwards while the displacements keep increasing. For an accurate evaluation of the safety
factor, it is necessary to plot the values of parameter ΣMsf against the displacement of a
node inside the failure zone. To determine the safety factors, follow these steps:

5 To evaluate the factor of safety for Phases 7 and 8 corresponding to Phase 3 and 6, click
on the Curves manager button .

6 In the Charts tabsheet, click on New option.

7 In the Curve generation window, select the pre-calculation Node from the dropdown list
for the x-axis. Select Deformations > Total displacements > |u|.

8 For the y-axis, select Project > Multipliers > ΣMsf.

9 Press OK to close the window and generate the chart.

10 Right-click on the chart and select the Settings option in the appearing menu. The Settings
window pops up.

11 In the tabsheet corresponding to the node curve, click the Phases button.

12 In the Select phases window make sure only the safety calculation Phases are selected.

13 Click OK to close the Select phases window.

14 In the Settings window change the titles and colour of the curves in the corresponding
tabsheet.

15 Click  Apply to update the chart according to the changes made and click OK  to close the
Settings window. The plot is shown in Figure 4–21 (p. 90).

Figure 4–21: Evaluation of safety factor

In Phase 7 which represents the second excavation stage has a lower factor of safety of
about 1.33. It indicates that the rock slope along the discontinuity is unstable. However, in
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Phase 8 which represents the final road cut slope with the construction of retaining wall
along with backfilling is stable with a higher factor of safety of about 1.83.
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5
Settlements due to tunnel

construction [GSE]

5.1  Introduction
In this tutorial the construction of a shield tunnel in medium soft soil and the influence on a
pile foundation is considered. A shield tunnel is constructed by excavating soil at the front of a
tunnel boring machine (TBM) and installing a tunnel lining behind it. In this procedure the soil
is generally over-excavated, which means that the cross sectional area occupied by the final
tunnel lining is always less than the excavated soil area. Although measures are taken to fill up
this gap, one cannot avoid stress re-distributions and deformations in the soil as a result of the
tunnel construction process. To avoid damage to existing buildings or foundations on the soil
above, it is necessary to predict these effects and to take proper measures. Such an analysis
can be performed by means of the finite element method. This tutorial shows an example of
such an analysis.

Objectives
● Modelling of the tunnel boring process
● Modelling undrained behaviour using the Undrained (B) option
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5.2  Geometry
The tunnel considered in this tutorial has a diameter of 5 m and is located at an average depth of
17 m. The geometry of the tunnel is shown in Figure 5–1 (p. 93) .
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0 m
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Deep clay
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Figure 5–1: Geometry of the tunnel project with an indication of the soil layers

5.3  Create new project
To create the new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-
Noded).

4 Set the model Contour to xmin = 0 m, xmax = 35 m, ymin = -30 m and ymax = 3 m.

5 Keep the default values for units and constants and press OK to close the Project properties
window.
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5.4  Define the soil stratigraphy
The soil profile indicates four distinct layers: The upper 13 m consists of soft clay type soil with
stiffness that increases approximately linearly with depth. Under the clay layer there is a 2 m
thick fine sand layer. This layer is used as a foundation layer for old wooden piles on which
traditional brickwork houses were built. The pile foundation of such a building is modelled next
to the tunnel. Displacements of these piles may cause damage to the building, which is highly
undesirable. Below the sand layer there is a 5 m thick deep loamy clay layer.

To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

Figure 5–2: The soil stratigraphy in the Modify soil layers window
2 Create the soil stratigraphy as shown in Figure 5–2 (p. 94).

3 Keep the Head in the borehole to 0 m.

5.4.1  Create and assign material data sets
Four data sets need to be created for the clay and sand layers.

For the upper clay layer the stiffness and shear strength increase with depth. Therefore values
for E'inc and su,inc are entered in the Advanced subtree. The values of E'ref and su,ref become
the reference values at the reference level yref. Below yref the actual values of E' and su increase
with depth according to:
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The data sets of the two lower soil layers include appropriate parameters for the tunnel
interfaces. In the other data sets the interface properties just remain at their default values. Enter
four data sets with the properties as listed in Table 5–1 (p. 95) and Table 5–2 (p. 96) , then
assign them to the corresponding clusters in the geometry model.

The layers have the following properties:

Table 5–1: Material properties of the clay layers

Property Name Clay Deep clay Unit

General

Soil model - Mohr-
Coulomb

Mohr-
Coulomb -

Drainage type - Undrained (B) Undrained (B) -

Unsaturated unit weight γunsat 15 16 kN/m3

Saturated unit weight γsat 18 18.5 kN/m3

Mechanical

Young's modulus at reference level E' ref 3.4 · 103 9.0 · 103 kN/m2

Poisson's ratio ν(nu) 0.33 0.33 -

Young's modulus increment E'inc 400 600 kN/m3

Reference level yref 3.0 -12 m

Undrained shear strength at
reference level su,ref 5 40 kN/m2

Undrained shear strength inc. su,inc 2 3 kN/m3

Groundwater
Data set - Standard Standard -

Soil type - Coarse Coarse -

Use defaults - None None -

Permeability in horizontal direction kx 0.1 · 10-3 0.01 m/day

Permeability in vertical direction ky 0.1 · 10-3 0.01 m/day

Interfaces
Strength determination - Rigid Manual -

Interface reduction factor Rinter 1.0 0.7 -

Initial
K0 determination - Manual Manual -

Lateral earth pressure coefficient K0,x 0.6 0.7 -
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Table 5–2: Material properties of the sand layers

Property Name Sand Deep sand Unit

General
Soil model - HS small HS small -

Drainage type - Drained Drained -

Unsaturated unit weight γunsat 16.5 17 kN/m3

Saturated unit weight γsat 20 21 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 25 · 103 42 · 103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 25 · 103 42 · 103 kN/m2

Unloading / reloading stiffness Eur 
ref 75 · 103 126 · 103 kN/m2

Poisson's ratio νur 0.2 0.2 -

Power for stress-level dependency
of stiffness m 0.5 0.5 -

Shear modulus at very small strains G0 ref 80· 103 110 · 103 kN/m2

Shear strain at which Gs = 0.722 G0 γ0.7 0.2 · 10-3 0.13 · 10-3 -

Cohesion c'ref 0 0 kN/m2

Friction angle φ' 31 35 °

Dilatancy angle ψ 1 5 °

Groundwater
Classification type - Standard Standard -

Soil class - Coarse Coarse -

Use defaults - None None -

Permeability in horizontal direction kx 1.0 0.5 m/day

Permeability in vertical direction ky 1.0 0.5 m/day

Interfaces
Strength determination - Rigid Manual -

Interface reduction factor Rinter 1.0 0.7 -

Initial
K0 determination - Automatic Automatic -

Pre-overburden pressure POP 0.0 0.0 -
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Initial
Over-consolidation ratio OCR 1.0 1.0 -

To create the material sets, follow these steps:

Click the Materials button  in the Modify soil layers window and create the data sets.

5.5  Define the structural elements
The tunnel and the building are defined as structural elements.

5.5.1  Define the tunnel
The tunnel considered here is the right half of a circular tunnel. After generating the basic
geometry, follow these steps to design the circular tunnel:

1 In the Structures mode click the Create tunnel button  in the side toolbar and click at (0
-17) in the drawing area.

The Tunnel designer window pops up displaying the General tabsheet of the Cross
section mode .

2 Select the Circular option in the Shape type drop-down menu.

3 Select the Define right half option in the Whole or half tunnel drop-down menu.

4 In the Offset to begin point group set Axis 2 to -2.5. No change is required for the
orientation axes.

5 Click the Segments tab to proceed to the corresponding tabsheet.

A segment is automatically created. A new box is shown under the segment list where the
properties of the segment can be defined.

6 In the Segment box set Radius to 2.5 m.

The generated segment is shown in Figure 5–3 (p. 98) .
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Figure 5–3: The geometry of the tunnel segment

Note: In the tunnel as considered here, the segments do not have a specific
meaning as the tunnel lining is homogeneous and the tunnel will be constructed at
once. In general, the meaning of segments becomes significant when:
● It is desired to excavate or construct the tunnel (lining) in different stages.
● Different tunnel segments have different lining properties.
● One would consider hinge connections in the lining (hinges can be added after

the design of the tunnel, in the general drawing area).
● The tunnel shape is composed of arcs with different radii (for example NATM

tunnels).

7 Click the Properties tab to proceed to the corresponding mode.

8 Right-click on the segment in the display area and select the menu Create > Create plate
option in the appearing menu.

9 In Tunnel Designer go to the Material property in the Selection explorer and click the plus
button  to create a new material dataset. Specify the material parameters for the TBM
according to the Table 5–3 (p. 98):

Table 5–3: Material properties of the plates

Parameter Name TBM Lining Building Unit

General
Material type - Elastic Elastic Elastic -

Unit Weight w 17.7 8.4 25 kN/m/m
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Parameter Name TBM Lining Building Unit

General
Prevent
punching - No No No -

Mechanical
Isotropic - Yes Yes Yes -

Axial
stiffness EA1 63 · 106 14 · 106 1 · 1010 kN/m

Bending
stiffness EI 472.5 · 103 143 · 103 1 · 1010 kNm2/m

Poisson's
ratio ν(nu) 0 0.15 0 -

Note: A tunnel lining consists of curved plates (shells). The lining properties can
be specified in the material database for plates. Similarly, a tunnel interface is
nothing more than a curved interface.

10 Right-click the segment in the display area and select the Create negative interface option
in the appearing menu.

11 Right-click the segment in the display area and select the Create line contraction option
in the appearing menu. In the polycurve properties specify a value of 0.5% for Cref. The
tunnel model is shown in Figure 5–4 (p. 100) .
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Figure 5–4: Tunnel model in the Properties tab

Note:
● A Cref value of 0.5% corresponds to a volume loss of 0.5% of the tunnel

volume. The actual strain that is applied to the line is half the applied
contraction. Hence, the resulting liner contraction is 0.25%.

● The entered value of contraction is not always fully applied, depending on the
stiffness of the surrounding clusters and objects.

12 Click on Generate to include the defined tunnel in the model.

13 Close the Tunnel designer window.

5.5.2  Define building
The building itself will be represented by a stiff plate founded on piles.

1 From the side bar, select Create line > Create plate  and draw a plate from (5 3) to (15 3),
representing the building.

2 Create a material set for the building according to Table 5–3 (p. 98) and assign it to the
plate. Do not forget to also create the material set for the tunnel lining.

3 From the side bar, select Create line > Create embedded beam   and draw two piles from
(5 3) to (5 -11) and from (15 3) to (15 -11).
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4 Create a material set for the foundation piles according to Table 5–4 (p. 101) and assign
it to the foundation piles. To do so click the Show materials button in the side toolbar. Set
the Set type parameter in the Material sets window to Embedded beams and click the New
button and enter the properties as given in Table 5–4 (p. 101).

Table 5–4: Material properties of piles (Embedded beam)

Parameter Name Foundation piles Unit

General
Material type - Elastic -

Unit weight γ 7.0 kN/m3

Mechanical

Pile spacing Lspacing 3.0 m

Cross section type - Predefined -

Predefined cross
section type - Solid circular beam -

Diameter - 0.25 m

Stiffness E 10 · 106 kN/m2

Axial skin resistance Linear -

Tskin, start, max 1.0 kN/mAxial skin resistance

Tskin, end, max 100.0 kN/m

Lateral resistance Lateral resistance Unlimited -

Base resistance Fmax 100.0 kN

Interface stiffness
factors Default values Yes -

5.6  Generate the mesh
The default global coarseness parameter (Medium) can be accepted in this case. Note that the
structural elements (plate and embedded beams) are internally automatically refined by a factor
of 0.25.

1 Proceed to the Mesh mode.

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh as shown in Figure 5–5 (p. 102) .
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Figure 5–5: The generated mesh

Tip:

With the Default fixities used, a plate that extends to a geometry boundary that is
fixed in at least one direction obtains fixed rotations, whereas a plate that extends to
a free boundary obtains a free rotation. To view the fixities in the Output program go
to menu bar at the top click on Geometry > Fixities.

4 Click the Close tab to close the Output program.

5.7  Define and perform the calculation
To simulate the construction of the tunnel it is clear that a staged construction calculation is
needed.

5.7.1  Initial phase
1 Proceed to the Staged construction mode to proceed with the definition of the calculation

phases.

2 The initial phase has already been introduced. Keep its calculation type as K0 procedure.
The water pressures can be generated on the basis of a general phreatic level at a level of y
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= 0.0 m as already defined in the borehole. Make sure that the building, foundation piles and
tunnel lining are deactivated.

5.7.2  Phase 1: Building
The first calculation phase is used to activate the building.

1 Click the Add phase button  to create a new phase.

2 In the Phases window rename the Phase ID as Building.

3 In the Deformation control parameters subtree select the Ignore undr. behaviour (A,B)
option. The default values of the remaining parameters are valid for this phase.

4 In the drawing area activate the plate of the building and the foundation piles.

5.7.3  Phase 2: TBM
1 Click the Add phase button  to create a new phase.

2 In the Phases window select the Reset displacements to zero option in the Deformation
control parameters subtree.

3 In Staged construction multi-select the clusters inside the tunnel. In the Selection explorer
deactivate the two soil clusters and set the Water conditions to Dry.

4 Activate the circular plate that in this phase represents the Tunnel Boring Machine (and thus
has the TBM material set) as well as the negative interfaces. Note that contraction is not
active in this phase.

5.7.4  Phase 3: TBM conicity
1 Click the Add phase button  to create a new phase.

2 Multi-select the plates. In the Selection explorer activate the contraction.

Note:
● The contraction represents the effects of the cone shape of the TBM (cutter head

has larger diameter than the tail).
● The contraction of the tunnel lining by itself does not introduce forces in the tunnel

lining. Eventual changes in lining forces as a result of the contraction procedure are
due to stress redistributions in the surrounding soil or to changing external forces.

5.7.5  Phase 4: Tail void grouting
At the tail of the tunnel boring machine (TBM), grout is injected to fill up the gap between the
TBM and the final tunnel lining. The grouting process is simulated by applying a pressure on the
surrounding soil.

1 Click the Add phase button  to create a new phase.
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2 In the Staged construction mode deactivate the TBM (plates, negative interfaces and
contraction).

3 Multi-select the clusters inside the tunnel. In the Selection explorer activate
WaterConditions.

4 In the Condition drop-down menu select the User-defined option and set p  ref  to -230 kN/
m  2 . The pressure distribution in the tunnel is constant.

5.7.6  Phase 5: Lining installation
1 Click the Add phase button  to create a new phase.

2 In the Staged construction set the clusters inside the tunnel to Dry.

3 Activate the plates and the negative interfaces of the tunnel.

4 Since the plates now represent the final lining of the tunnel, assign the Lining material set to
the plate elements.

5.7.7  Execute the calculation
1 Click the Select points for curves button in the side toolbar.

2 Select some characteristic points for load-displacement curves (for example the corner
point (0 -14.50) at the ground surface above the tunnel and the corner points of the building
(5 3)).

3 Click the Calculate button  to calculate the project.

4 After the calculation has finished, save the project by clicking the Save button .
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5.8  Results
After the calculation, select the last calculation phase and click the View calculation results
button. The Output program is started, showing the deformed meshes at the end of the
calculation phases which is shown in Figure 5–6 (p. 105):

Figure 5–6: Deformed mesh after construction of
the tunnel (Phase 5; scaled up manually 20 times)

As a result of the second calculation phase (removing soil and water out of the tunnel) there is
some settlement of the soil surface and the tunnel lining shows some deformation. In this phase
the axial force in the lining is the maximum axial force that will be reached. The lining forces
can be viewed by double- clicking the lining and selecting force related options from the Force
menu. The plots of the axial forces and bending moment are scaled by factors of 5·10-3 and 0.2
respectively which is shown in Figure 5–7 (p. 106).
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Figure 5–7: Axial forces and Bending moments in the lining after the second phase

The plot of effective stresses as shown in Figure 5–8 (p. 106), shows that arching occurs
around the tunnel. This arching reduces the stresses acting on the tunnel lining. As a result, the
axial force in the final phase is lower than that after the second calculation phase.

Figure 5–8: Effective principal stresses after the construction of the tunnel (Phase 2 TBM)

To display the tilt of the structure at the end of lining installation phase:

1. Click the Distance measurement button  in the side toolbar.
2. Click the node located at the left corner of the structure (5 3).
3. Click the node located at the right corner of the structure (15 3).
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The Distance measurements information window is displayed in Figure 5–9 (p. 107), where
the resulting tilt of the structure is shown.

Figure 5–9: Distance measurement information window
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6
Excavation of an NATM tunnel [GSE]

6.1  Introduction
This tutorial illustrates the use of PLAXIS 2D for the analysis of the construction of a NATM
tunnel. The NATM is a technique in which ground exposed by excavation is stabilised with
shotcrete to form a temporary lining.

Objectives
● Modelling the construction of an NATM tunnel using the Deconfinement method.
● Using Gravity loading to generate initial stresses.
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6.2  Geometry
The geometry of the tunnel is shown in Figure 6–1 (p. 109) .
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Figure 6–1: Geometry of the project

6.3  Create a new project
To create a new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet make sure that Model is set to Plane strain and that Elements is set
to 15-Noded.

4 Define the limits for the soil contour as xmin = -50 m, xmax = 50 m, ymin = 0 m and ymax = 35
m.

6.4  Define the soil stratigraphy
The basic stratigraphy will be created using the Borehole feature. In the model 11 m of the Clay-
limestone layer is considered. The bottom of this layer is considered as reference in y direction
(ymin = 0).

To define the soil stratigraphy:

1 Click the Create borehole button  and create the first borehole at x = -22 m.

2 In the Modify soil layers window create three soil layers.

a. Layer number 1: both Top and Bottom lie in 24, which means that layer 1 has a depth
equal to zero in Borehole_1.

b. Layer number 2: lies from Top = 24 to Bottom = 11.
c. Layer number 3: lies from Top = 11 to Bottom = 0.

3 At the bottom of the Modify soil layers window click on the Boreholes button.

4 In the appearing menu select the Add option.

The Add borehole window pops up.

6.2 Geometry  |  109



5 Specify the location of the second borehole (x = -14).

6 Note that the soil layers are available for Borehole_2.

a. Layer number 1: both Top and Bottom lie in 30, which means that layer number 1 has a
depth equal to zero in Borehole_2. Notice how depth of layer 2 in Borehole_2 is higher
than layer 1 in borehole_1.

b. Layer number 2: lies from Top = 30 to Bottom = 11.
c. Layer number 1: lies from Top = 11 to Bottom = 0.

7 Create a new borehole (Borehole_3) at x = -7.

8 In Borehole_3:

a. Layer number 1: lies from Top = 35 to Bottom = 30, which means that layer 1 has a non-
zero thickness in of Borehole_3.

b. Layer number 2: lies from Top = 30 to Bottom = 11.
c. Layer number 3: lies from Top = 11 to Bottom = 0.

9 In all the boreholes the water level is located at y = 0 m.

10 Specify the soil layer distribution as shown in Figure 6–2 (p. 110).

Figure 6–2: Soil layer distribution

6.5  Create and assign material data sets
Three material sets need to be created for the soil layers.

Note that the layering of the model left from the first borehole is based on Borehole_1 and the
layering right from the last borehole is based on Borehole_3. Hence, no borehole is needed at x
= -50 m or x = 50 m.

The layers have the following properties as shown in Table 6–1 (p. 111):
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Table 6–1: Material properties of the soil layer

Property Name Top layer Unit

General
Soil model - Hardening soil -

Drainage type - Drained -

Unsaturated unit weight γunsat 20 kN/m3

Saturated unit weight γsat 22 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 40·103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 40·103 kN/m2

Unloading / reloading stiffness Eur 
ref 120·103 kN/m2

Poisson's ratio νur 0.2 -

Power for stress-level dependency
of stiffness m 0.5 -

Cohesion c'ref 10 kN/m2

Friction angle φ' 30 °

Interfaces
Strength determination - Rigid -

Interface reduction factor Rinter 1.0 -

Table 6–2: Material properties of the soft rock layers

Parameter Name Clay-
silt stone

Clay-
limestone Unit

General
Soil model - Hoek-Brown Hoek-Brown -

Type of material behaviour - Drained Drained -

Unsaturated unit weight γunsat 25 24 kN/m3

Saturated unit weight γsat 25 24 kN/m3

Mechanical

Young's modulus Erm 1.0·106 2.5·106 kN/m2

Poisson's ratio ν (nu) 0.25 0.25 -

Uniaxial compressive strength 25·103 50·103 kN/m2
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Mechanical

Material constant for the intact rock mi 4 10 -

Geological Strength Index GSI 40 55 -

Disturbance factor D 0.2 0.0 -

Dilatancy parameter ψmax 30 35 °

Dilatancy parameter σψ 400 1000 kN/m2

Interfaces
Strength determination - Manual Rigid -

Interface reduction factor Rinter 0.5 1.0 -

1 Create soil material data sets according to Table 6–1 (p. 111) and assign them to the
corresponding layer Figure 6–2 (p. 110). Then assign the values for the soft rock layers
as per Table 6–2 (p. 111), find the analysis for various strength parameters from the
emerging window as shown in Figure 6–3 (p. 112).

2 Close the Modify soil layers window and proceed to the Structures mode to define the
structural elements.

Figure 6–3: Mechanical Parameter
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6.6  Define the tunnel
1 In the Structures mode click on the Create tunnel button  in the side toolbar and click

on (0 16) in the drawing area to specify the location of the tunnel.

The Tunnel designer window pops up.

2 The default shape option (Free) will be used. The default values of the rest of the
parameters defining the location of the tunnel in the model are valid as well.

3 Click on the Segments tab.

4 Click the Add section button  in the side toolbar. In the tunnel Selection Explorer.

a. Set the Segment type to Arc.
b. Set Radius to 10.4 m
c. Set the Segment angle to 22°.

5 The default values of the remaining parameters are valid.

6 Click the Add section button  to add a new arc segment.

a. Set Radius to 2.4 m.
b. Set the Segment angle to 47°.
c. The default values of the remaining parameters are valid.

7 Click the Add section button  to add a new arc segment.

a. Set Radius to 5.8 m.
b. Set the Segment angle to 50°.
c. The default values of the remaining parameters are valid.

8 Click the Extend to symmetry axis option  to complete the right half of the tunnel.

A new arc segment is automatically added closing the half of the tunnel.

9 Click the Symmetric close button  to complete the tunnel. Four new arc segment are
automatically added closing the tunnel.

10 Click on the Subsections tab.

11 Click the Add button  to add a new subsection.

Note:
● The current subsection will be used to separate the top heading (upper

excavation cluster) from the invert (lower excavation cluster).
● While creating the new subsection some warnings and/or errors will be

displayed. For this tutorial, ignore them and continue with the instructions.

With the created subsection selected, in the Selection Explorer do the following:

6.6 Define the tunnel   |  113



a. Set the Offset 2 as 3 m.
b. From the Segment type drop-down menu select the Arc option.
c. Set Radius to 11 m.
d. Segment angle to 360°.

12 Click the Select multiple objects button  and select all the geometric entities in the slice.

13
Click the Intersect button .

14 Delete the part of the subsection outside of the slice by selecting it in the display area and
clicking the Delete button  in the side toolbar.

Figure 6–4: Segments in the tunnel cross section
15 Proceed to the Properties tabsheet.

16 Multi-select the polycurves in the display area, right click and in the appearing menu select
Create > Create Plate.

17 The various segments in the tunnel cross section can be seen in Figure 6–4 (p. 114).

18 Press Ctrl +  M  to open the Material sets window. Create a new material dataset for the
created plates according to Table 6–3 (p. 114).

Table 6–3: Material properties of the plates

Parameter Name Lining Unit

General
Material type - Elastic -

Unit Weight w 5 kN/m/m
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Parameter Name Lining Unit

General
Prevent punching - No -

Mechanical
Isotropic - True -

Axial stiffness EA1 6.0·106 kN/m

Bending stiffness EI 20·103 kNm2/m

Poisson's ratio ν 0.15 -

19 Multi-select the created plates and in the Selection explorer, assign the material Lining to
the selected plates.

20 Create negative interfaces to the lines defining the shape of the tunnel (not the excavation
levels or subsection).

The final tunnel view in the Tunnel designer window is shown in Figure 6–5 (p. 115):

Figure 6–5: Final tunnel
21 Click on Generate to update the tunnel in the model and click Close.

6.7  Generate the mesh
The default global coarseness parameter (Medium) can be accepted in this case.

1 Proceed to the Mesh mode.
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2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh as shown in Figure 6–6 (p. 116).

Figure 6–6: The generated mesh
4 Click the Close tab to close the Output program.

6.8  Define and perform the calculation
To simulate the construction of the tunnel a staged construction calculation is needed in
which the tunnel lining is activated and the soil clusters inside the tunnel are deactivated. The
calculation phases are Plastic analyses, Staged construction. The three-dimensional arching
effect is emulated by using the so-called β-method. The idea is that the initial stresses pk acting
around the location where the tunnel is to be constructed are divided into a part (1-β) pk that
is applied to the unsupported tunnel and a part Deconfinement method that is applied to the
supported tunnel.

To apply this method in PLAXIS 2D, one can use the Deconfinement option, which is available
for each deactivated soil cluster in the model explorer. Deconfinement is defined as the
aforementioned factor (1-β). For example, if 60% of the initial stresses in a deactivated soil
cluster should disappear in the current calculation phase (so the remaining 40% is to be
considered later), it means that the Deconfinement (1-β) parameter of that inactive cluster
should be set to 60%. The value of Deconfinement can be increased in subsequent calculation
phases until it reaches 100%.

To define the calculation process follow these steps:

6.8.1  Initial phase
1 Click on the Staged construction tab to proceed with the definition of the calculation

phases.

2 The initial phase has already been introduced. Note that the soil layers are not horizontal.
It is not recommended in this case to use the K0 procedure to generate the initial effective

stresses. Instead Gravity loading  will be used. This option is available in the General
subtree of the Phases window.

3 Water will not be considered in this example. The general phreatic level should remain at the
model base.
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4 Make sure that the tunnel is inactive.

6.8.2  Phase 1: First tunnel excavation (deconfinement)
1 Click the Add phase button  to create a new phase.

2 In the Staged construction mode deactivate the upper cluster in the tunnel. Do NOT activate
the tunnel lining.

3 While the deactivated cluster is still selected, in the Selection explorer set Deconfinement(1
- β) to 60 %.

The model for Phase 1 is displayed in Figure 6–7 (p. 117).

Figure 6–7: Configuration of Phase 1

6.8.3  Phase 2: First (temporary) lining
1 Click the Add phase button  to create a new phase.

2 In the Staged construction mode, activate the lining and interfaces of the part of the
tunnel excavated in the previous phase.

3 Select the deactivated cluster. In the Selection explorer set Deconfinement to 100 % as
shown in Figure 6–8 (p. 117).

Figure 6–8: Configuration of Phase 2
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6.8.4  Phase 3: Second tunnel excavation
(deconfinement)

1 Click the Add phase button  to create a new phase.

2 In the Staged construction mode deactivate the lower cluster (invert) and the temporary
lining in the middle of the tunnel.

3 While the lower deactivated cluster is still selected, set in the Selection explorer
Deconfinement to 60%.

4 The model for phase 3 can be seen in Figure 6–9 (p. 118).

Figure 6–9: Configuration of Phase 3

6.8.5  Phase 4: Second (final) lining
1 Click the Add phase button  to create a new phase.

2 Activate the remaining lining and interfaces.

All the plates and interfaces around the full tunnel are active.

3 Select the lower deactivated cluster. In the Selection explorer set Deconfinement to 100 %.

4 The model for phase 4 can be seen in Figure 6–10 (p. 118).

Figure 6–10: Configuration of Phase 4
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6.8.6  Execute the calculation
1 Click the Select points for curves button in the side toolbar.

2 Select a node at the slope crest point and the tunnel crest. These points might be of interest
to evaluate the deformation during the construction phases.

3 Click the Calculate button  to calculate the project.

4 After the calculation has finished, save the project by clicking the Save button .

6.9  Results
After the calculation, select the last calculation phase and click the View calculation results
button. The Output program is started, showing the deformed mesh at the end of the calculation
phases as shown in Figure 6–11 (p. 119):

Figure 6–11: The deformed mesh at the end of the final calculation phase

To display the bending moments resulting in the tunnel:

1. To select the lining of all the tunnel sections, click the corresponding button  in the side
toolbar and drag the mouse to define a rectangle where all the tunnel sections are included.
Select the Plate  option in the appearing window as shown in Figure 6–12 (p. 119):

Figure 6–12: Select structures window
2. Click View.

Note that the tunnel lining is displayed in the Structures view.
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3. From the Forces menu select the Bending moment M option. The result, scaled by a factor of
0.5 is displayed in Figure 6–13 (p. 120).

Figure 6–13: Resulting bending moments in the NATM tunnel
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7
Dry excavation using a tie back wall

[ADV]

7.1  Introduction
This example involves the dry construction of an excavation. The excavation is supported by
concrete diaphragm walls. The walls are tied back by prestressed ground anchors.

PLAXIS 2D allows for detailed modelling of this type of problem. It is demonstrated in this
example how ground anchors are modelled and how prestressing is applied to the anchors.
Moreover, the dry excavation involves a groundwater flow calculation to generate the new water
pressure distribution. This aspect of the analysis is explained in detail.

Objectives
● Modelling ground anchors.
● Generating pore pressures with a groundwater flow calculation.
● Displaying the contact stresses and resulting forces in the model.
● Scaling the displayed results.
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7.2  Geometry
The excavation is 20 m wide and 10 m deep. 16 m long concrete diaphragm walls of 0.35 m
thickness are used to retain the surrounding soil. Two rows of ground anchors are used at
each wall to support the walls. The anchors have a total length of 14.5 m and an inclination of
33.7°(2:3). On the left side of the excavation a surface load of 10 kN/m2 is taken into account.

The relevant part of the soil consists of three distinct layers. From the ground surface to a depth
of 3 m there is a fill of relatively loose fine sandy soil. Underneath the fill, down to a minimum
depth of 15 m, there is a more or less homogeneous layer consisting of dense well-graded sand.
This layer is particularly suitable for the installation of the ground anchors. The underlying layer
consists of loam and lies to a large depth 15 m of this layer is considered in the model as shown
in Figure 7–1 (p. 122).

10 m 20 m2 m

10kN/m2

Final excavation level

Ground anchor

3 m

4 m

3 m

5 m

Loam

Sand

Silt

Figure 7–1: Excavation supported by tie back walls

7.3  Create new project
1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-
Node).

4 Set the model Contour to xmin = 0 m, xmax = 100 m, ymin = 0 m, ymax = 30 m.

5 Keep the default values for units and the constants and press OK to close the Project
properties window.

7.4  Define the soil stratigraphy
To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.
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2 Add three soil layers to the borehole. Locate the ground level at y = 30 m by assigning 30 to
the Top level of the uppermost layer. The bottom levels of the layers are located at 27, 15 and
0 m, respectively.

3 Set the Head to 23 m.

The layer stratigraphy is shown in Figure 7–2 (p. 123):

Figure 7–2: The Modify soil layers window

7.5  Create and assign material data sets
Three data sets need to be created. The materials have the following properties as shown in
Table 7–1 (p. 123):

Table 7–1: Soil and interface properties

Parameter Name Silt Sand Loam Unit

General

Soil model Model Hardening
soil

Hardening
soil

Hardening
soil -

Drainage type Type Drained Drained Drained -

Unsaturated unit weight γunsat 16 17 17 kN/m3

Saturated unit weight γsat 20 20 19 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 20 · 103 30 · 103 12 · 103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 20 · 103 30 · 103 8 · 103 kN/m2
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Mechanical

Unloading / reloading stiffness Eur 
ref 60 · 103 90 · 103 36 · 103 kN/m2

Poisson's ratio νur 0.2 0.2 0.2 -

Power for stress-level dependency
of stiffness m 0.5 0.5 0.8 -

Cohesion (constant) c'ref 1 0 5 kN/m2

Friction angle φ' 30 34 29 °

Dilatancy angle ψ 0 4 0 °

K0-value for normal consolidation K0 nc 0.5 0.4408 0.5152 -

Groundwater
Classification type - USDA USDA USDA -

SWCC fitting method - Van
Genuchten

Van
Genuchten

Van
Genuchten -

Soil class - Silt Sand Loam -

< 2μm - 6.0 4.0 20.0 %

2μm - 50μm - 87.0 4.0 40.0 %

50μm - 2mm - 7.0 92.0 40.0 %

Flow parameters - Use defaults - From
data set

From
data set

From
data set -

Permeability in horizontal direction kx 0.5996 7.128 0.2497 m/day

Permeability in vertical direction ky 0.5996 7.128 0.2497 m/day

Interfaces
Strength determination - Manual Manual Rigid -

Interface reduction factor Rinter 0.65 0.70 1.0 -

Consider gap closure - Yes yes yes

Initial
K0 determination - Automatic Automatic Automatic -

Pre-overburden pressure POP 0 0 25 kN/m2

Over-consolidation ratio OCR 1.0 1.0 1.0 -

1 Define three data sets for soil and interfaces with the parameters given in Table 7–1 (p.
123).

2 Assign the material data sets to the corresponding soil layers (Figure 7–2 (p. 123)).
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7.6  Define the structural elements
The creation of diaphragm walls, excavation levels, ground anchor and surface load is described
below.

Click the Structures tab to proceed with the input of structural elements in the Structures mode
.

7.6.1  To define the diaphragm wall and interfaces:
A diaphragm wall with the following material properties as shown in Table 7–2 (p. 125) has to
be defined:

Table 7–2: Material properties of the diaphragm wall (plate)

Parameter Name Value Unit

General
Material type - Elastic -

Weight w 8.3 kN/m/m

Prevent punching - True -

Mechanical
Isotropic - True -

Axial stiffness EA1 12 · 10 6 kN/m

Bending stiffness EI 120 · 10 3 kNm2/m

Poisson's ratio ν (nu) 0.15 -

1 In the Structures mode, model the diaphragm walls as plates passing through (40 30) - (40
14) and (60 30) - (60 14).

2 Multi-select the plates in the model.

3 In the Selection explorer click on Material.

The view will change displaying a drop-down menu and a plus button next to it as shown in
Figure 7–3 (p. 125):

Figure 7–3: Material assignment in the Selection explorer
4 Click the Add button .
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A new empty material set is created for plates.

5 Define the material data set for the diaphragm walls according to the properties are listed in
Table 7–2 (p. 125). The concrete has a Young's modulus of 35 GN/m2 and the wall is 0.35
m thick.

6 Assign positive and negative interfaces to the geometry lines created to represent the
diaphragm walls.

7.6.2  Definition of excavation levels
The soil is excavated in three stages. The first excavation layer corresponds to the bottom of the
silt layer and it is automatically created. To define the remaining excavation stages:

1 Define the second excavation phase by drawing a line  through (40 23) and (60 23).

2 Define the third excavation phase by drawing a line  through (40 20) and (60 20).

7.6.3  Defining the ground anchor
A ground anchor can be modelled by a combination of a node-to-node anchor and an
embedded beam. The embedded beam simulates the grouted part of the anchor whereas the
node-to-node anchor simulates the free length. In reality there is a complex three-dimensional
state of stress around the grout body which cannot be simulated in a 2D model.

The coordinates of the anchor and grout body are listed in Table 7–3 (p. 126) , Table 7–4 (p.
126) and Table 7–5 (p. 126) and material properties of grout body are shown in Table 7–6 (p.
127).

Table 7–3: Node to node anchor coordinates

Anchor location Name First point Second point
Left (40 27) (31 21)

Top
Right (60 27) (69 21)

Left (40 23) (31 17)
Bottom

Right (60 23) (69 17)

Table 7–4: Properties of the anchor rod (node-to-node anchor)

Parameter Name Value Unit
Material type - Elastic -

Axial stiffness EA 500 · 10 3 kN

Out-of-plane spacing Lspacing 2.5 m

Table 7–5: Grout coordinates

Anchor location Name First point Second point
Left (31 21) (28 19)

Top
Right (69 21) (72 19)
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Anchor location Name First point Second point
Left (31 17) (28 15)

Bottom
Right (69 17) (72 15)

Table 7–6: Properties of the grout body (embedded beam )

Parameter Name Value Unit

General
Material type - Elastic -

Unit weight γ 0 kN/m3

Mechanical

Pile spacing Lspacing 2.5 m

Beam type - Predefined -

Predefined beam type - Solid circular beam -

Diameter D 0.3 m

Stiffness E 7.07 · 106 kN/m2

Distribution Linear -

Tskin, start, max 400 kN/mAxial Skin resistance

Tskin, end, max 400 kN/m

Lateral resistance Lateral resistance Unlimited -

Base resistance Fmax 0 kN

Interface stiffness
factor Default values Yes -

1 Define the node-to-node anchors  according to Table 7–3 (p. 126).

2 Create an Anchor material data set according to the parameters specified in Table 7–4 (p.
126).

3 Multi-select the anchors in the drawing area. Assign the material data set by selecting the
corresponding option in the Material drop-down menu in the Selection explorer.

4 Define the grout body using the Embedded beam  button  according to Table 7–5 (p.
126).

5 Create the Grout material data set according to the parameters specified in Table 7–6 (p.
127) and assign it to the grout body.

6 Set the Behaviour of the embedded beam to Grout body as shown in Figure 7–4 (p.
128).
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Figure 7–4: Embedded beam in the Selection explorer

The connection with the anchor will be automatically established.

7 Multi-select (keep Ctrl  pressed while selecting) the top node-to-node anchors and
embedded beams. Right-click on the selected region and select the Group option in the
context menu.

8 In the Model explorer expand the Groups subtree.

Note that a group is created composed of the elements of the top ground anchors.

9 Click on Group_1 in the Model explorer and type a new name (e.g GroundAnchor_Top).

10 Follow the same steps to create a group and to rename the bottom ground anchors.

Although the precise stress state and interaction with the soil cannot be modelled with this 2D
model, it is possible in this way to estimate the stress distribution, the deformations and the
stability of the structure on a global level, assuming that the grout body does not slip relative to
the soil. With this model it is certainly not possible to evaluate the pullout force of the ground
anchor.

7.6.4  Defintition of distributed load
Create a line load  between (28 30) and (38 30).

7.7  Generate the mesh
In order to generate the mesh, follow these steps:

1 Proceed to the Mesh mode.

2 Click the Generate mesh button  in the side toolbar. Use the default option for the
Element distribution parameter (Medium).

3 Click the View mesh button  to view the mesh as shown in Figure 7–5 (p. 129).
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Figure 7–5: The generated mesh

7.8  Define and perform the calculation
The calculation of this project consists of six phases. In the initial phase (Phase 0), the initial
stresses are generated. In Phase 1, the walls are constructed and the surface loads are
activated. In Phase 2, the first 3 m of the pit is excavated without connection of anchors to the
wall. At this depth the excavation remains dry. In Phase 3, the first anchor is installed and pre-
stressed. Phase 4 involves further excavation to a depth of 7 m. At this depth the excavation still
remains dry. In Phase 5, the second anchor is installed and pre-stressed. Phase 6 is a further
excavation to the final depth of 10 m including the dewatering of the excavation.

Before defining the calculation phases, the water levels to be considered in the calculation
can be defined in the Flow conditions mode. The water level is lowered in the final excavation
phase. At the side boundaries, the groundwater head remains at a level of 23.0 m. The bottom
boundary of the problem should be closed. The flow of groundwater is triggered by the fact that
the pit is pumped dry. At the bottom of the excavation the water pressure is zero, which means
that the groundwater head is equal to the vertical level (head = 20.0 m). This condition can be
met by drawing a new general phreatic level and performing a groundwater flow calculation.
Activating the interfaces during the groundwater flow calculation prevents flow through the wall.

7.8.1  Initial phase
The initial stress field is generated in all the clusters by means of the K0 procedure using the
default K0-values which is defined automatically by the program.

1 Proceed to the Staged construction mode .

2 Initially, all structural components and loads are inactive. Hence, make sure that the
plates, the node-to-node anchors, the embedded beam rows and the surface loads are
deactivated.

3 In the Phases explorer double-click the initial phase. The default parameters for the initial
phase will be used. The Phreatic option is selected as Pore pressure calculation type.
Note that when the pore pressures are generated by phreatic level, the full geometry of the
defined phreatic level is used to generate the pore pressures.

4 Click OK to close the Phases window.

5 In the Model explorer expand the Model conditions subtree.

6 Expand the Water subtree.
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The water level created according to the head value specified in the borehole,
(BoreholeWaterLevel_1), is automatically assigned to GlobalWaterLevel .

7 The model for initial phase is shown in Figure 7–6 (p. 130).

Figure 7–6: Configuration of the initial phase

7.8.2  Phase 1: Activation of wall and load
1 Click the Add phase button  to create a new phase.

2 In the Staged constructions mode activate all walls and interfaces by clicking on the
checkbox in front of them in the Model explorer.

The active elements in the project are indicated by a green check mark.

3 Activate the distributed load.

4 After selecting the line load assign a value of -10 to qy,start,ref in the Selection explorer
shown in Figure 7–7 (p. 130):

Figure 7–7: Line load in the Selection explorer
The model for the phase 1 in the Staged construction mode is displayed in Figure 7–8 (p.
130):

Figure 7–8: Configuration of Phase 1 in the Staged construction mode
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7.8.3  Phase 2: First excavation
1 Click the Add phase button  in the Phases explorer to add a new phase.

2 In the Staged construction mode deactivate the upper cluster of the excavation

The model for the first excavation phase is shown in Figure 7–9 (p. 131):

Figure 7–9: Configuration of Phase 2 in the Staged construction mode

7.8.4  Phase 3: First anchor row
1 Click the Add phase button  in the Phases explorer.
2 Activate the upper ground anchors by clicking on the checkbox in front of

GroundAnchors_Top under the Groups subtree in the Model explorer.
3 Multi-select the top node-to-node anchors.

4 In the Selection explorer set the Adjust prestress parameter to True and assign a pre-
stress force of 500 kN.

Note: A pre-stress force is exactly matched at the end of a finished staged
construction calculation and turned into an anchor force. In successive calculation
phases the force is considered to be just an anchor force and can therefore further
increase or decrease, depending on the development of the surrounding stresses
and forces.

The model for the phase 3 in the Staged construction mode is shown in Figure 7–10 (p. 132):
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Figure 7–10: Configuration of Phase 3 in the Staged construction mode

7.8.5  Phase 4: Second excavation
1 Click the Add phase button  to add a new phase.

2 Deactivate the second cluster of the excavation.

The model for the phase 4 in the Staged construction mode is displayed in Figure 7–11 (p.
132):

Figure 7–11: Configuration of Phase 4 in the Staged construction mode

Note that the anchors are not pre-stressed anymore.

7.8.6  Phase 5: Second anchor row
1 Click the Add phase button  to add a new phase.

2 Activate the lower ground anchors.

3 Select the bottom node-to-node anchors.

4 In the Selection explorer set the Adjust prestress parameter to True and assign a pre-
stress force of 1000 kN.

The model for the phase 5 in the Staged construction mode is displayed in Figure 7–12 (p.
133):
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Figure 7–12: Configuration of Phase 5 in the Staged construction mode

7.8.7  Phase 6: Final excavation
1 Click the Add phase button  to add a new phase.

2 In the Phases window, within General > Pore pressure calculation type select the Steady
state groundwater flow option . The default values of the remaining parameters are
valid.

3 Deactivate the third cluster of the excavation.

4 Click the Flow conditions tab to display the corresponding mode.

5 In the Model explorer expand the Attributes library.

6 Expand the Water levels subtree.

7 Click the Create water level button  in the side toolbar and draw a new phreatic level.
Start at (0 23) and draw the phreatic level through (40 20), (60 20) and end in (100 23).

8 In the Model explorer expand the User water levels subtree. Click on UserWaterLevel_1
and type LoweredWaterLevel to rename the water level created in the Flow conditions
mode as shown in Figure 7–13 (p. 133).

Figure 7–13: Water levels in the Model explorer
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9 In the Model explorer expand Model conditions > GroundwaterFlow. The default
boundary conditions are valid which is shown in Figure 7–14 (p. 134).

Figure 7–14: The GroundwaterFlow subtree
under the Model conditions in the Model explorer

10 In the Water subtree assign the LoweredWaterLevel to GlobalWaterLevel.

The model and the defined water levels are displayed in Figure 7–15 (p. 134):

Figure 7–15: Configuration of Phase 6 in the Flow conditions mode

Note: Note that for Groundwater flow (steady or transient) the intersection points of the
water level with the active model boundaries are important. The program calculates flow
boundary conditions in terms of a groundwater head corresponding to the water level.
The 'internal' part of the water level is not used and will be replaced by the phreatic
level resulting from the groundwater flow calculation. Hence, the water level tool is just a
convenient tool to create boundary conditions for a flow calculation.
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7.8.8  Execute the calculation
1 Click the Select points for curves button in the side toolbar.

2 Select some characteristic points for curves (for example the connection points of the
ground anchors on the diaphragm wall, such as (40 27) and (40 23).

3 Click the Calculate button  to calculate the project.

4 After the calculation has finished, save the project by clicking the Save button .

7.9  Results
The deformed meshes at the end of calculation phase 2 to phase 6 are shown in Figure 7–16 (p.
135), Figure 7–17 (p. 135), Figure 7–18 (p. 136), Figure 7–19 (p. 136) and Figure 7–20 (p.
136):

Figure 7–16: Deformed mesh (scaled up 50.0 times) - Phase 2

Figure 7–17: Deformed mesh (scaled up 50.0 times) - Phase 3
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Figure 7–18: Deformed mesh (scaled up 50.0 times) - Phase 4

Figure 7–19: Deformed mesh (scaled up 50.0 times) - Phase 5

Figure 7–20: Deformed mesh (scaled up 50.0 times) - Final phase

Figure 7–21 (p. 136) shows the effective principal stresses in the final situation. The passive
stress state beneath the bottom of the excavation is clearly visible. It can also be seen that there
are stress concentrations around the grout anchors.

Figure 7–21: Principal effective stresses (final stage)
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Figure 7–22 (p. 137) shows the bending moments in the diaphragm walls in the final state. The
two dips in the line of moments are caused by the anchor forces.

Figure 7–22: Bending moments in the diaphragm walls in the final stage

The anchor force can be viewed by double-clicking the anchor. When doing this for the results
of the third and the fifth calculation phase, it can be checked that the anchor force is indeed
equal to the specified pre-stress force in the calculation phase they are activated. In the
following phases this value might change due to the changes in the model.
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8
Dry excavation using a tie back wall -

ULS [ADV]

8.1  Introduction
In this tutorial an Ultimate Limit State (ULS) calculation will be defined and performed for the dry
excavation using a tie back wall (7 Dry excavation using a tie back wall [ADV] (p. 121)). The same
geometry model will be used. The Design approaches feature is introduced in this example. This
feature allows for the use of partial factors for loads and model parameters after a serviceability
calculation has already been performed.

Objective
● Using Design approaches
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8.2  Define the geometry
In order to define a design approach:

1 Open the project created in 7 Dry excavation using a tie back wall [ADV] (p. 121) and save it
under a different name.

2 Select the menu Soil > Design approaches or Structures > Design approaches.

The corresponding window is displayed .

3 Click the Add button.

A new design approach is added in the list .

4 In this example the design approach 3 of the Eurocode 7 will be used. This design
approach involves partial factors for loads and partial factors for materials (strength). Click
the design approach in the list and specify a representative name (ex: 'Eurocode 7 - DA 3').

Figure 8–1: Partial factors for loads
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Figure 8–2: Partial factors for materials
5 In the lower part of the window the partial factors can be defined for loads and materials as

shown in Figure 8–1 (p. 139). Set the partial factor for Variable unfavourable to 1.3.

6 Click the Materials tab.

7 Assign a value of 1.25 to Effective strength (c' and phi') as shown in Figure 8–2 (p. 140).

8 Click the Materials... button. The Material sets window pops up.

9 Open the Loam material data set. Note that the view has changed. In the current view it is
possible to assign factors to different soil parameters, as well as to see the effect of these
factors on the soil parameters.

10 Click the Mechanical tab. In the Mechanical tabsheet select the Label > Effective
strength (c' and phi') [MaterialFactorLabel_2] from the drop down list for c'ref and φ'
respectively. The new values will be updated for the strength parameters as shown in
Figure 8–3 (p. 141).

11 Repeat the step for the remaining soil data sets.

12 Close the Design approaches window.
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Figure 8–3: Mechanical tabsheet for Loam showing effective
strength parameter after assigning partial factors for material

Note:

Note that a partial factor for φ' and ψ applies to the tangent of φ' and ψ respectively.

8.3  Define and perform the calculation
There are two main schemes to perform design calculations in relation to serviceability
calculations (see Design approaches in the Reference Manual). The first approach is used in this
tutorial.

8.3.1  Changes to all phases
1 Proceed to the Staged construction mode.

2 In the Phases explorer click the phase Phase_1.

3 Add a new phase.

4 Double-click the newly added phase to open the Phases window.

5 In the General subtree of the Phases window select the defined design approach in the
corresponding drop-down menu.
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6 In the Model explorer expand the Line loads and all the subtrees under it.

7 Select the Variable unfavourable option in the LoadFactorLabel drop-down menu of the
static component of the load.

Figure 8–4: Assignment of factor label to loads in the Selection explorer
8 Follow the same steps to define ULS phases for all the remaining SLS phases. Make sure

that the Phase 7 starts from Phase 1, Phase 8 from Phase 2, Phase 9 from Phase 3 and so
on.

8.3.2  Execute the calculation
1 Click the Select points for curves button in the side toolbar.

2 Select some characteristic points for curves (for example the connection points of the
ground anchors on the diaphragm wall, such as (40 27) and (40 23)).

3 Click the Calculate button  to calculate the project.

4 After the calculation has finished, save the project by clicking the Save button .
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8.4  Results
The results obtained for the design approach phases can be evaluated in Output. Figure 8–5 (p.
143) displays the ΣMstage - |u| plot for the node located at (40.0 27.0).

Figure 8–5: ΣMstage - |u| plot for the ULS phases

If the ULS calculations have successfully finished, the model complies with the corresponding
design approach. If there are doubts about this due to excessive deformations, an additional
Safety calculation may be considered using the same design approach, which should then
result in a stable ΣMsf value larger than 1.0. Note that if partial factors have been used it is not
necessary that ΣMsf also includes a safety margin. Hence, in this case ΣMsf just larger that 1.0 is
enough.

Figure 8–6 (p. 144) displays the ΣMsf - |u| plot for the Safety calculations of the Phase 6 and
the corresponding ULS phase (Phase 12). It can be concluded that the situation complies with
the design requirements.
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Figure 8–6: ΣMsf - |u| plot for the last calculation phase and the corresponding ULS phase

8 Dry excavation using a tie back wall - ULS [ADV]   |  144



9
Construction of a road embankment

[ADV]

9.1  Introduction
The construction of an embankment on soft soil with a high groundwater level leads to an
increase in pore pressure. As a result of this undrained behaviour, the effective stress remains
low and intermediate consolidation periods have to be adopted in order to construct the
embankment safely. During consolidation the excess pore pressures dissipate so that the soil
can obtain the necessary shear strength to continue the construction process.

This tutorial concerns the construction of a road embankment in which the mechanism
described above is analysed in detail. In the analysis three new calculation options are
introduced, namely a consolidation analysis, an updated mesh analysis and the calculation of a
safety factor by means of a safety analysis (strength reduction).

Objectives
● Consolidation analysis
● Modelling drains
● Change of permeability during consolidation
● Safety analysis (strength reduction)
● Updated mesh analysis (large deformations)
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9.2  Geometry
The embankment is 16 m wide and 4 m high. The slopes have an inclination of 1:3. The
problem is symmetric, so only one half is modelled (in this case the right half is chosen). The
embankment itself is composed of loose sandy soil. The subsoil consists of 6 m of soft soil.
The upper 3 m is peat and the lower 3 m is clay. The phreatic level is located 1 m below the
original ground surface. Under the soft soil layers there is a dense sand layer of which 4 m are
considered in the model which is shown in Figure 9–1 (p. 146).

Dense sand

Clay

Peat

Road embankment

12 m 16 m 12 m

4 m

3 m

3 m

Figure 9–1: Situation of a road embankment on soft soil

9.3  Create new project
1

Start PLAXIS 2D by double-clicking the icon of the Input program .

2 Click Start a new project.

3 In the Project tabsheet of the Project properties window, enter an appropriate title.

4 In the Model tabsheet make sure that Model is set to Plane strain and that Elements is set
to 15-Noded.

5 Set the model Contour to xmin = 0 m, xmax = 60 m, ymin = -10 m and ymax = 4 m.

9.4  Define the soil stratigraphy
The sub-soil layers are defined using a borehole. The embankment layers are defined in the
Structures mode .

To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up as shown in Figure 9–2 (p. 147).
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Figure 9–2: Soil layer distribution
2 Define three soil layers as shown in figure .

3 The water level is located at y = -1 m. In the borehole column specify a value of -1 to Head.

9.5  Create and assign material data sets
A number of material set are needed for this tutorial. The properties of the materials are as
follows:

Table 9–1: Material properties of the sand and clay layer and the interfaces

Parameter Name Embank-
ment Sand Peat Clay Unit

General

Soil model - Hardening
soil

Hardening
soil Soft soil Soft soil -

Drainage type - Drained Drained Undrained
(A)

Undrained
(A) -

Unsaturated unit
weight γunsat 16 17 8 15 kN/m3

Saturated unit weight γsat 19 20 12 18 kN/m3

Initial void ratio einit 0.5 0.5 2.0 1.0 -

Mechanical

Modified compression index λ* - - 0.15 0.05 -
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Mechanical

Modified swelling index κ* - - 0.03 0.01 -

Secant stiffness in standard
drained triaxial test E50 ref 25 · 103 35 · 103 - - kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 25· 103 35 · 103 - - kN/m2

Unloading / reloading stiffness Eur 
ref 75· 103 105 · 103 - - kN/m2

Power for stress-level
dependency of stiffness m 0.5 0.5 - - -

Cohesion (constant) c'ref 1 0 2 1 kN/m2

Friction angle φ' 30 33 23 25 °

Dilatancy angle ψ 0 3 0 0 °

Miscellaneous: Set to default Yes Yes Yes Yes -

Groundwater
Classification type - USDA USDA USDA USDA -

SWCC fitting method - Van
Genuchten

Van
Genuchten

Van
Genuchten

Van
Genuchten -

Soil class - Loamy
sand Sand Clay Clay -

< 2μm - 6.0 4.0 70.0 70.0 %

2μm - 50μm - 11.0 4.0 13.0 13.0 %

50μm - 2mm - 83.0 92.0 17.0 17.0 %

Use defaults - From
data set

From
data set None From

data set -

Horizontal permeability kx 3.499 7.128 0.1 0.04752 m/day

Vertical permeability ky 3.499 7.128 0.05 0.04752 m/day

Change in permeability ck 1 · 1015 1 · 1015 1.0 0.2 -

Interfaces
Strength determination - Rigid Rigid Rigid Rigid -

Interface reduction factor Rinter 1 1 1 1 -

Initial
K0 determination - Automatic Automatic Automatic Automatic -

Pre-overburden pressure POP 0 0 5 0 kN/m2

Overconsolidation ratio OCR 1.0 1.0 1.0 1.0 -

To create the material sets, follow these steps:
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1 Click the Materials button  to open the Material sets window.

2 Create soil material data sets according to Table 9–1 (p. 147) and assign them to the
corresponding layers in the borehole (see Figure 9–2 (p. 147)).

3 Close the Modify soil layers window and proceed to the Structures mode to define the
embankment and drains.

Note: The initial void ratio (einit) and the change in permeability (ck) should be defined to
enable the modelling of a change in the permeability in a consolidation analysis due to
compression of the soil. This option is recommended when using advanced models.

9.6  Define the construction
The embankment and the drains are defined in the Structures mode .

Click the Structures tab to proceed with the input of structural elements in the Structures mode
.

9.6.1  Definiton of the embankment
1 Click the Create soil polygon button  in the side toolbar and select the Create soil

polygon option.

2 Define the embankment in the drawing area by clicking on (0 0), (0 4), (8 4) and (20 0).

3 Select and right click the created polygon and assign the Embankment data set to the soil
polygon as shown in Figure 9–3 (p. 149).

Figure 9–3: Assignment of a material dataset to a soil cluster in the drawing area
4 To define the embankment construction level click the Cut polygon button  in the side

toolbar and define a cutting line by clicking on (0 2) and (14 2).

The embankment cluster is split into two sub-clusters.

9.6.2  To define the drains
In this project the effect of the drains on the consolidation time will be investigated by comparing
the results with a case without drains. Drains will only be active for the calculation phases in the
case with drains.
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1 Click the Create hydraulic conditions button in the side toolbar and select the Create drain
option in the appearing menu which is shown in Figure 9–4 (p. 150).

Figure 9–4: Create Drain option
2 Drains are defined in the soft layers (clay and peat; y = 0 m to y = -6 m). The distance

between two consecutive drains is 2 m. Considering the symmetry, the first drain is located
at 1 m distance from the model boundary. 10 drains will be created in total. The head is
defined at 0.0 m. The geometry is shown in Figure 9–5 (p. 150).

Figure 9–5: Final geometry of the model

Note:

The modelling of drains in a plane strain model actually involves the use of an equivalent
(lateral) permeability in the surrounding soil based on the drain pattern. The latter has
been omitted in this simplified example. More information can be in found in literature1.

9.7  Generate the mesh
In order to generate the mesh, follow these steps:

1 Proceed to Mesh mode .

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh as shown in Figure 9–6 (p. 151).

1 Achtergronden bij numerieke modellering van geotechnische constructies, deel 2. CUR
191. Stichting CUR, Gouda Indraratna, B.N., Redana, I.W., Salim, W. (2000), Predicted and
observed behaviour of soft clay foundations stabilised with vertical drains. Proc. GeoEng.
2000, Melbourne.
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Figure 9–6: The generated mesh
4 Click the Close tab to close the Output program.

9.8  Define and perform the calculation
The embankment construction is divided into two phases. After the first construction phase a
consolidation period of 30 days is introduced to allow the excess pore pressures to dissipate.
After the second construction phase another consolidation period is introduced from which
the final settlements may be determined. Hence, a total of four calculation phases have to be
defined besides the initial phase.

9.8.1  Initial phase: Initial conditions
In the initial situation the embankment is not present.

The remaining active geometry is horizontal with horizontal layers, so the K0 procedure can
be used to calculate the initial stresses. The geometry of the model for initial phase is shown in
Figure 9–7 (p. 151).

Figure 9–7: Configuration of the initial phase

The initial water pressures are fully hydrostatic and based on a general phreatic level located at
y = -1 m. Note that a phreatic level is automatically created at y = -1 m, according to the value
specified for Head in the borehole. In addition to the phreatic level, attention must be paid to the
boundary conditions for the consolidation analysis that will be performed during the calculation
process. Without giving any additional input, all boundaries except for the bottom boundary are
draining so that water can freely flow out of these boundaries and excess pore pressures can
dissipate. In the current situation, however, the left vertical boundary must be closed because
this is a line of symmetry, so horizontal flow should not occur. The remaining boundaries are
open because the excess pore pressures can be dissipated through these boundaries. In order
to define the appropriate consolidation boundary conditions, follow these steps:

1 Go to the Staged construction mode and in the Model explorer expand the Model
conditions subtree shown in Figure 9–8 (p. 152).

2 Expand the GroundwaterFlow subtree and set BoundaryXMin to Closed and
BoundaryYMin to Open.
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Figure 9–8: The boundary conditions of the problem

9.8.2  Consolidation analysis
A consolidation analysis introduces the dimension of time in the calculations. In order to
correctly perform a consolidation analysis a proper time step must be selected. The use of time
steps that are smaller than a critical minimum value can result in stress oscillations.

The consolidation option in PLAXIS 2D allows for a fully automatic time stepping procedure that
takes this critical time step into account. Within this procedure there are three main possibilities:

Consolidate for a predefined period, including the effects of changes to the active
geometry (Staged construction).

Consolidate until all excess pore pressures in the geometry have reduced to a
predefined minimum value (Minimum excess pore pressure).

Consolidate until a specified degree of saturation is reached (Degree of
consolidation).

The first two possibilities will be used in this exercise. To define the calculation phases, follow
these steps:

9.8.2.1  Phase 1: First embankment construction
The first calculation stage is a Consolidation analysis, Staged construction.

1 Click the Add phase button  to create a new phase and double-click.

2 In the Phases window go to the General subtree and from the Calculation type drop-down

menu select the Consolidation option .

3
Make sure that for the Loading type the Staged construction option  is selected .
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4 Enter a Time interval of 2 days. The default values of the remaining parameters will be used.

5 In the Staged construction mode activate the first part of the embankment. The model for
phase 1 is shown in Figure 9–9 (p. 153).

Figure 9–9: Configuration of the phase 1

9.8.2.2  Phase 2: First consolidation period
The second phase is also a Consolidation analysis, Staged construction. In this phase no
changes to the geometry are made as only a consolidation analysis to ultimate time is required.

1 Click the Add phase button  to create a new phase.

2 In the Phases window go to the General subtree and from the Calculation type drop-down

menu select the Consolidation option .

3
For the Loading type make sure that the Staged construction option  is selected.

4 Enter a Time interval of 30 days. The default values of the remaining parameters will be
used.

9.8.2.3  Phase 3: Second embankment construction

1 Click the Add phase button  to create a new phase.

2 In the Phases window go to the General subtree and from the Calculation type drop-down

menu select the Consolidation option .

3
For the Loading type make sure that the Staged construction option  is selected.

4 Enter a Time interval of 1 day. The default values of the remaining parameters will be used.

5 In the Staged construction mode activate the second part of the embankment. The model
for phase 3 is shown in Figure 9–10 (p. 153).

Figure 9–10: Configuration of the phase 3
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9.8.2.4  Phase 4: End of consolidation
The fourth phase is a Consolidation analysis to a minimum excess pore pressure.

1 Click the Add phase button  to create a new phase.

2 In the Phases window go to the General subtree and from the Calculation type drop-down

menu select the Consolidation option .

3
In the Loading type drop-down menu select the Minimum excess pore pressure option 
and accept the default value of 1 kN/m2 for the minimum pressure. The default values of the
remaining parameters will be used.

9.8.3  Safety analysis
In the design of an embankment it is important to consider not only the final stability, but also the
stability during the construction. It is clear from the output results that a failure mechanism starts
to develop after the second construction phase.

It is interesting to evaluate a global safety factor at this stage of the problem, and also for other
stages of construction.

To calculate the global safety factor for the road embankment at different stages of
construction, follow these steps:

1 Select Phase 1 in the Phases explorer.

2 Add a new calculation phase. 

3 Double-click on the new phase to open the Phases window.

4 In the Phases window the selected phase is automatically selected in the Start from phase
drop-down menu.

5
In the General subtree, select Safety  as calculation type.

6
The Incremental multipliers option  is already selected in the Loading input box. The first
increment of the multiplier that controls the strength reduction process, Msf, is set to 0.1.

7 In order to exclude existing deformations from the resulting failure mechanism, select the
Reset displacements to zero option in the Deformation control parameters subtree.

The first safety calculation has now been defined.

8 Follow the same steps to create new calculation phases that analyse the stability at the end
of each consolidation phase. The various phases after defining safety calculation is shown
in Figure 9–11 (p. 155).
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Figure 9–11: Safety calculation phases

9.8.4  Calculate
Before starting the calculation it is suggested that you select nodes or stress points for a later
generation of load-displacement curves or stress and strain diagrams. To do this, follow the
steps given below.

1 Click the Select points for curves button in the side toolbar.

2 As the first point, select the toe of the embankment at (20 0).

3 The second point will be used to plot the development (and decay) of excess pore
pressures. To this end, a point somewhere in the middle of the soft soil layers at the left
side of the model is needed, hence underneath the middle of the embankment. Select for
instance a precalculation point at (0 -3).

4 Click the update option.

5 Click the Calculate button  to calculate the project.

During a consolidation analysis the development of time can be viewed in the upper part of the
calculation info window as shown in Figure 9–12 (p. 156).
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Figure 9–12: Calculation progress displayed in the Active tasks window

In addition to the multipliers, a parameter Pexcess,max occurs, which indicates the current
maximum excess pore pressure. This parameter is of interest in the case of a Minimum excess
pore pressure consolidation analysis, where all pore pressures are specified to reduce below a
predefined value.
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9.9  Results

9.9.1  Deformed mesh
After the calculation has finished, select the third phase and click the View calculation results

button .

The Output window now shows the deformed mesh after the undrained construction of the
final part of the embankment. Considering the results of the third phase, the deformed mesh as
displayed in Figure 9–13 (p. 157) shows the uplift of the embankment toe and hinterland due to
the undrained behaviour.

Figure 9–13: Deformed mesh after undrained construction of embankment (Phase 3)

9.9.2  Incremental displacements
1 Select the menu Deformations >  Incremental displacements > |Δ u|.

2 Select the menu View > Arrows option in the menu or click the corresponding button  in
the toolbar to display the results arrows.

On evaluating the total displacement increments, it can be seen that a failure mechanism is
developing shown in Figure 9–14 (p. 157):

Figure 9–14: Displacement increments after undrained construction of embankment

9.9.3  Excess pore pressures
1 Press Ctrl + 7 to display the developed excess pore pressures (see Appendix C of the

for more shortcuts). They can also be displayed by selecting the menu StressesPore
pressuresPexcess.
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2 Click the Center principal directions button . The principal directions of excess pressures
are displayed at the center of each soil element. The results are displayed in Figure 9–15 (p.
158).

Figure 9–15: Excess pore pressures after undrained construction of embankment

It is clear that the highest excess pore pressure occurs under the embankment centre.

3 Select Phase 4 in the drop down menu.

4 Click the Contour lines button  in the toolbar to display the results as contours.

5 To show the labels of the contour lines on the soil profile click on the Draw scanline button
 (or the corresponding option in the View menu). Then on the geometry make a line by

clicking on an initial point and drag the line on the contours to be identified (Figure 9–15 (p.
158)).

By exploring the different phases, it can be seen that the settlement of the original soil
surface and the embankment increases considerably during the Phase 4. This is due to the
dissipation of the excess pore pressures (= consolidation), which causes further settlement
of the soil. Figure 9–15 (p. 158) shows the remaining excess pore pressure distribution
after consolidation. Check that the maximum value is below 1.0 kN/m2.

Figure 9–16: Excess pore pressure contours after consolidation to Pexcess < 1.0 kN/m2

9.9.4  Development of excess pore pressure
The Curves manager can be used to view the development, with time, of the excess pore
pressure under the embankment. In order to create such a curve, follow these steps:

1 In the Curves manager create a new curve by clicking the button  .

2 For the x-axis, select the Project option from the drop-down menu and select Time in the
tree.

3 For the y-axis select the point in the middle of the soft soil layers (defined as second pre-
calculation point) from the drop-down menu. In the tree select Stresses > Pore pressure >
Pexcess.

4 Select the Invert sign option for the y-axis.
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5 Click OK.

6 Open the Curve settings (F3) and go to the second tabsheet.

7 In the Show box click the Phases button. By default all phases are selected to show in the
curve. For the clarity of the curve, hide the Safety phases (phases 5 - 8).

8 Click OK to close the Curve settings window.

A curve similar to the following one should appear as shown in Figure 9–17 (p. 159):

Figure 9–17: Development of excess pore pressure under the embankment

The figure clearly shows the four calculation phases. During the construction phases the
excess pore pressure increases with a small increase in time while during the consolidation
periods the excess pore pressure decreases with time. In fact, consolidation already occurs
during construction of the embankment, as this involves a small time interval. From the
curve it can be seen that more than 50 days are needed to reach full consolidation.

Save the chart before closing the Output program.

9.9.5  Safety analysis results

9.9.5.1  Failure mechanism
Additional displacements are generated during a Safety calculation. The total displacements do
not have a physical meaning, but the incremental displacements in the final step (at failure) give
an indication of the likely failure mechanism.

In order to view the mechanisms in the three different stages of the embankment construction:

1
Select one of these phases and click the View calculation results button .

2 Select the menu Deformations > Incremental displacements > |Δu|.
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3 Change the presentation from Arrows to Shadings . The resulting plots shown in Figure
9–18 (p. 160) gives a good impression of the failure mechanisms. The magnitude of the
displacement increments is not relevant.

Figure 9–18: Shadings of the total displacement increments indicating the
most applicable failure mechanism of the embankment in the final stage

9.9.5.2  Safety Factor
The safety factor can be obtained from the Calculation info option of the Project menu. The
Multipliers tabsheet of the Calculation information window represents the actual values of
the load multipliers. The value of ΣMsf represents the safety factor, provided that this value is
indeed more or less constant during the previous few steps.

The best way to evaluate the safety factor, however, is to plot a curve in which the parameter
ΣMsf is plotted against the displacements of a certain node. Although the displacements are not
relevant, they indicate whether or not a failure mechanism has developed.

In order to evaluate the safety factors for the three situations in this way, follow these steps:

1 Click the Curves manager button in the toolbar.

2 Click New in the Charts tabsheet.

3 In the Curve generation window, select the embankment toe (Point A) for the x-axis. Select
Deformations > Total displacements > |u|.

4 For the y-axis, select Project > Multipliers > ΣMsf. The Safety phases are considered in
the chart.

5 Right-click on the chart and select the Settings option in the appearing menu. The Settings
window pops up.

6 In the tabsheet corresponding to the curve click the Phases button.

7 In the Select phases window select Phase 5 shown in Figure 9–19 (p. 161):
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Figure 9–19: The Select phases window
8 Click OK to close the Select phases window.

9 In the Settings window change the titles of the curve in the corresponding tabsheet.

10 Click the Add curve button and select the From current project... option in the appearing
menu. Define curves for phases 6, 7 and 8 by following the described steps.

11 In the Settings window click the Chart tab to open the corresponding tabsheet.

12 In the Chart tabsheet specify the chart name.

13 Set the scaling of the x-axis to Manual and set the value of Maximum to 1 as shown in
Figure 9–20 (p. 162):
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Figure 9–20: The Chart tabsheet in the Settings window
14 Click Apply to update the chart according to the changes made and click OK to close the

Settings window.

15 To modify the location of the legend right-click on the legend.

16 In the context menu select View > Legend in chart.

17 The legend can be relocated in the chart by dragging it. The plot is shown in Figure 9–21
(p. 163):
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Figure 9–21: Evaluation of safety factor
The maximum displacements plotted are not relevant. It can be seen that for all curves a more or
less constant value of ΣMsf is obtained. Hovering the mouse cursor over a point on the curves,
a box showing the exact value of ΣMsf can be obtained.

9.10  Using drains
In this section the effect of the drains in the project will be investigated. Four new phases will be
introduced having the same properties as the first four consolidation phases. The first of these
new phases should start from the initial phase. The differences in the new phases are:
● The drains should be active in all the new phases. Activate them in the Staged construction

mode .
● The Time interval in the first three of the consolidation phases (9 to 11) is 1 day. The last

phase is set to Minimum excess pore pressure and a value of 1.0 kN/m2 is assigned to the
minimum pressure (|P-stop|).

Follow these steps:

1 After the calculation is finished, save the project, then select the last phase and click the

View calculation results button . The Output window now shows the deformed mesh
after the drained construction of the final part of the embankment. In order to compare the
effect of the drains, the excess pore pressure dissipation in the second point can be used.

2 Click the Curves manager button  to open the Curves manager.
3 In the Chart tabsheet double-click Chart 1 (pexcess of the second point at (0 -3) versus

time). The chart is displayed. Close the Curves manager.
4 Double-click the curve in the legend at the right of the chart. The Settings window pops

up.
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5 Click the Add curve button and select the From current project ... option in the appearing
menu. The Curve generation window pops up.

6 Select the Invert sign option for y-axis and click OK to accept the selected options.

7 In the chart a new curve is added and a new tabsheet corresponding to it is opened in the
Settings window. Click the Phases button. From the displayed window select the Initial
phase and the last four phases (drains) and click OK.

8 In the Settings window change the titles of the curves in the corresponding tabsheets.

9 In the Chart tabsheet specify the chart name.

10 Click Apply to preview the generated curve and click OK to close the Settings window.
The chart gives a clear view of the effect of drains in the time required for the excess pore
pressures to dissipate as shown in Figure 9–22 (p. 164):

Figure 9–22: Effect of drains

Tip:

Instead of adding a new curve, the existing curve can be regenerated using the
corresponding button in the Curves settings window.

9.11  Updated mesh and updated water
pressures analysis

As can be seen from the output of the Deformed mesh at the end of consolidation (stage 4),
the embankment settles about one meter since the start of construction. Part of the sand fill that
was originally above the phreatic level will settle below the phreatic level.
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As a result of buoyancy forces the effective weight of the soil that settles below the water level
will change, which leads to a reduction of the effective overburden in time. This effect can be
simulated in PLAXIS 2D using the Updated mesh and Updated water pressures options. For the
road embankment the effect of using these options will be investigated.

1 Select the initial phase in the Phases explorer.

2 Add a new calculation phase.

3 Define the new phase in the same way as Phase 1. In the Deformation control parameters
subtree check the Updated mesh and Updated water pressures options.

4 Define the other 3 phases in the same way.

5 Run the calculation and when the calculation is finished, compare the settlements for the
two different calculation methods.

6 In the Curve generation window select time for the x-axis and select the vertical
displacement (uy) of the point in the middle of the soft soil layers at (0 -3) for the y-axis.

7 In this curve the results for Initial phase and phases from 1 to 4 will be considered.

8 Add a new curve to the chart.

9 In this curve the results for Initial phase and phases from 13 to 16 will be considered. The
resulting chart is shown in Figure 9–23 (p. 165).

Figure 9–23: Effect of updated mesh and water
pressures analysis on resulting settlements

It can be seen that the settlements are less when the Updated mesh and Updated water
pressures options are used (red curve). This is partly because the Updated mesh procedure
includes second order deformation effects by which changes of the geometry are taken into
account, and partly because the Updated water pressures procedure results in smaller effective
weights of the embankment. This last effect is caused by the buoyancy of the soil settling below
the (constant) phreatic level. The use of these procedures allows for a realistic analysis of
settlements, taking into account the positive effects of large deformations.
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10
Excavation and dewatering [ADV]

10.1  Introduction
In this tutorial lowering the groundwater level and the flow around a sheetpile wall will be
analysed. The Well feature is introduced in this example. The geometry model of the tutorial 7
Dry excavation using a tie back wall [ADV] (p. 121) will be used.

10.2  Create and assign material data set
The material parameters remain unchanged from the original project as shown in Table 7–1 (p.
123).

To create the project:

1 Open the project defined in the tutorial 7 Dry excavation using a tie back wall [ADV] (p. 121).

2 Save the project under a different name (e.g. 'Flow around a sheet pile wall').
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10.3  Define the structural elements
1 In the Structures mode click the Create hydraulic conditions button  in the side toolbar.

2 Select the Create well option  in the appearing menu.

3 Draw the first well by clicking on (42 20) and (42 17).

4 Draw the second well by clicking on (58 20) and (58 17).

10.4  Generate the mesh
1 Proceed to the Mesh mode.

2 Select the cluster and two wells as shown in the Figure 10–1 (p. 167) . In Selection
Explorer specify a Coarseness factor of 0.25.

Figure 10–1: Indication of the local refinement of the mesh in the model
3 Click the Generate mesh button  to generate the mesh. Use the default option for the

Element distribution parameter (Medium).

4 Click the View mesh button  to view the mesh as shown in Figure 10–2 (p. 167).

Figure 10–2: The generated mesh
5 Click the Close tab to close the Output program.
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10.5  Define and perform the calculation
Proceed to the Staged construction mode . The groundwater flow analysis performed in phase
6 has to be modified.

10.5.1  Phase 6: Dewatering
In this phase the wells will be used to lower the phreatic level in the excavation down to y = 17m.
This corresponds to 3m below the final excavation level.

1 Multi-select the wells in the model and activate them.

2 In the Selection explorer the behaviour of the wells is by default set to Extraction.

3 Set the discharge value to 1.5m3/day/m.

4 Set the hmin value to 17m. This means that water will be extracted as long as the
groundwater head at the wall location is at least 17m.

Figure 10–3 (p. 168) shows the parameters assigned to the wells in the Selection explorer.

Figure 10–3: Well properties

10.5.2  Execute the calculation
The definition of the calculation process is complete.

1 Click the Calculate button  to calculate the project.

2  Save the project after the calculation has finished.

10.6  Results
To display the flow field:

1. Select the Phase 6 in the drop down menu.
2. Click the menu Stresses > Groundwater flow > |q|.

A scaled representation of the results (scale factor = 5.0 ) is shown in Figure 10–4 (p. 169):
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Figure 10–4: The resulting flow field at the end of Phase 6
Click the menu Stresses > Pore pressures > Groundwater head. Compare the results with the
ones of the Phase 6 of the project defined in the tutorial 7 Dry excavation using a tie back wall
[ADV] (p. 121).

In Figure 10–5 (p. 169), the resulting groundwater head with and without the wells are
displayed .

A

B

Figure 10–5: Comparison of the resulting groundwater head

A: Groundwater head (Phase 6 in the tutorial 7 Dry
excavation using a tie back wall [ADV] (p. 121))

B: Groundwater head (Phase 6 in the current project)

10 Excavation and dewatering [ADV]   |  169



11
Cyclic vertical capacity and stiffness
of circular underwater footing [ADV]

11.1  Introduction
This tutorial illustrates how to calculate the vertical bearing capacity and vertical stiffness of a
circular stiff underwater footing (e.g. one of the footings of a jacket structure) exposed to cyclic
loading during a storm. The storm is idealised by a distribution of load parcels with different
magnitude. The cyclic accumulation tool is used to obtain soil parameters for the UDCAM-S
model. The example considers a circular concrete footing with a radius of 11 m, placed on an
over-consolidated clay layer.

The procedure for establishing non-linear stress-strain relationships and calculating load-
displacement curves of a foundation under a cyclic vertical load component is presented. The
analysis of the circular footing is performed with a 2D axisymmetric model. The soil profile
consists of clay with an overconsolidation ratio, OCR, of 4, submerged unit weight of 10 kN/
m3 and an earth pressure coefficient, K0 of 1. The (static) undrained shear strength from
anisotropically consolidated triaxial compression tests has a constant value with a depth of su C

= 130 kPa. The maximum shear modulus, Gmax, of the clay is 67275 kPa. The cyclic behaviour
of the soil is based on contour diagrams for Drammen clay (Andersen, Kleven & Heien, 1988 2)
assuming that the behaviour is representative of the actual clay.

2 Andersen, K.H., Kleven, A., Heien, .D. (1988). Cyclic soil data for design of gravity structures.
Journal of Geotechnical Engineering, 517–539.
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Objectives:
● Obtain the UDCAM-S model input parameters by running the cyclic accumulation procedure,

determining the stress-strain curves and optimising the material model parameters.
● Calculate the total cyclic vertical bearing capacity.
● Calculate the vertical stiffness accounting for cyclic loading for both the total and the cyclic

component.

11.2  Geometry
The soil properties and footing geometry are shown in Figure 11–1 (p. 171).

D = 22 m

w 
γ' 

Ip 

1 m

OCR = 4
suc = 130 kPa
Gmax = 67275 kPa

= 10 kPa
= 52 %
= 27 %

Figure 11–1: Geometry of the project

11.3  Create new project
To create a new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick select dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet make sure that

a. Model is set to Axisymmetry and
b. Elements is set to 15-Noded.

4 Define the limits for the model contour as

a. xmin = 0.0 m, xmax = 40.0 m
b. ymin = -30.0 m and ymax = 0.0 m

11.4  Define the soil stratigraphy
The sub-soil layers are defined using a borehole.

To define the soil stratigraphy:
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1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

2 Create a single soil layer with top level at 0.0 m and bottom level at -30.0m.

3 For simplicity, water is not taken into account in this example. The groundwater table is
therefore set below the bottom of the model, and the soil weight is based on the effective
(underwater) weight.

4 In the borehole column specify a value of -50.00 for Head.

Figure 11–2: Soil layer

11.5  Create and assign material data sets
Three material data sets need to be created; two for the clay layer (Clay - total load and Clay -
cyclic load) and one for the concrete foundation.

 Open the Material sets window.

11.5.1  Material: Clay - total load
The model parameters for this material will be determined by the cyclic accumulation and
optimisation tool.

The other properties are as shown in Table 11–1 (p. 173) :
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Table 11–1: Material properties

Parameter Name Clay - total load Unit

General
Identification - Clay - total load -

Soil model - UDCAM-S model -

Drainage type - Undrained (C) -

Unsaturated unit weight γunsat 10 kN/m3

To create the material set, follow these steps:

1 Choose Soil and interfaces as the Set type and click the New button.

2 On the General tab enter the values according to Table 11–1 (p. 173).

3 Proceed to the Mechanical tab.

Instead of entering the model parameters in this tab sheet, we will run the cyclic accumulation
and optimisation tool. This procedure consists of three steps.

Click the Mechanical tab and click the Cyclic accumulation and optimisation tool option in the
side window as shown in Figure 11–3 (p. 173).

Figure 11–3: Cyclic accumulation and optimisation tool

A new window opens shown in Figure 11–4 (p. 174):
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Figure 11–4: Cyclic accumulation tool window

The three steps of the cyclic accumulation and optimisation procedure are represented by the
three modes (Cyclic accumulation, Stress-strain curves and Parameter optimisation) in the
window.

11.5.1.1  Cyclic accumulation
The purpose of this step is to determine the equivalent number of undrained cycles of the peak
load, Neq, for a given soil contour diagram and load distribution.

The following storm composition data will be used as shown in Table 11–2 (p. 174):

Table 11–2: Composition of cyclic vertical load for a 6-hour design storm

# Load ratio N cycles
1 0.02 2371

2 0.11 2877

3 0.26 1079

4 0.40 163

5 0.51 64

6 0.62 25

7 0.75 10
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# Load ratio N cycles
8 0.89 3

9 1.0 1

1 Select an appropriate contour diagram from Select contour diagram data in the Cyclic
accumulation tab. In this case, select Drammen clay, OCR = 4.

Note: For more information about contour diagrams, see Andersen (2015) 3 and
Reference Manual, Cyclic accumulation and optimisation tool.

2 The load ratios and number of cycles from the storm composition can be entered in the
empty table. The storm composition is given in Table 11–2 (p. 174) (Jostad, Torgersrud,
Engin & Hofstede, 2015) 4 as the cyclic vertical load normalized with respect to the maximum
cyclic vertical load (Load ratio) and the number of cycles (N cycles). It is here assumed that
the cyclic shear stress history in the soil is proportional to the maximum cyclic vertical load
of the footing. The table should be entered such that the smallest load ratio is at the top and
the highest load ratio is at the bottom.

Note: The design storm is a load history that is transformed into parcels of constant
cyclic load. Each parcel corresponds to a number of cycles at a constant amplitude
determined from the time record of the load component. See Reference Manual,
Cyclic accumulation and optimisation tool, for more information.

When you've entered the load parcels in the table, the Load ratio vs N cycles graph will
show a graphic representation of the data. For the data given here and the logarithmic scale
turned on, the resulting graph is shown in Figure 11–5 (p. 175).

Figure 11–5: Load ratio vs N cycles graph (logarithmic scale)

3 Andersen, K.H. (2015). Cyclic soil parameters for offshore foundation design, volume The
3rd ISSMGE McClelland Lecture of Frontiers in Offshore Geotechnics III. Meyer (Ed). Taylor &
Francis Group, London, ISFOG 2015. ISBN 978-1-138-02848-7.

4 Jostad, H.P., Torgersrud, Ø., Engin, H.K., Hofstede, H. (2015). A fe procedure for calculation
of fixity of jack-up foundations with skirts using cyclic strain contour diagrams. City University
London, UK.
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3 Click Calculate to calculate the equivalent number of cycles Neq.

The selected contour diagram is plotted together with the shear stress history for a scaling
factor where the soil fails (here defined at 15% shear strain) at the last cycle (Figure 11–6
(p. 176)) and the loci of end-points of the stress history for different scaling factors. The
calculated equivalent number of cycles corresponds to the value on the x-axis at the last
point of the locus of end-points and is equal to 6.001.

Figure 11–6: Cyclic accumulation in PLAXIS 2D

11.5.1.2  Stress-strain curves
The purpose of this tab is to obtain non-linear stress-strain curves for a given (calculated) Neq
and given cyclic over average shear stress ratio (here taken equal to the ratio between cyclic
and average vertical load during the storm).

1 Go to the Stress-strain curves tab.

2 For the Neq determination, keep the default option From cyclic accumulation. The calculated
equivalent number of cycles is adopted from the previous tab.

3 Keep the Soil behaviour as Anisotropic, and the Scaling factor, DSS and Scaling factor, TX
as 1.

Note:
● Cyclic strength can be scaled based on available soil specific cyclic strength.
● If the plasticity index and/or water content of the soil is different from Drammen

clay, the cyclic strength can be scaled by applying a scaling factor different from
1 (see Andersen, 2015 5 for details).

4 Set the cyclic to average shear stress ratio for DSS, triaxial compression and triaxial
extension, describing the inclination of the stress path, to appropriate values. In this

5 Andersen, K.H. (2015). Cyclic soil parameters for offshore foundation design, volume The
3rd ISSMGE McClelland Lecture of Frontiers in Offshore GeotechnicsIII. Meyer (Ed). Taylor &
Francis Group, London, ISFOG 2015. ISBN978-1-138-02848-7.
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example, the following input values are selected to obtain strain compatibility at failure, i.e.
the same cyclic and average shear strain for the different stress paths at failure.

a. cyclic to average ratio for DSS (Δτcyc/Δτa)DSS = 1.1,
b. triaxial compression (Δτcyc/Δτa)TXC = 1.3 and
c. extension (Δτcyc/Δτa)TXE = -6.3

5 Select the load type as, Total load  for this first material.

DSS and triaxial contour diagrams are plotted together with stress paths described by
the cyclic to average ratios (Figure 11–7 (p. 177)). Notice that the shear stresses are
normalised with respect to the static undrained shear strength in compression. The
extracted stress-strain curves are plotted below the contour diagrams.

6 Click Calculate to produce the corresponding normalised stress-strain curves below the
contour diagrams. See Figure 11–7 (p. 177) for the outcome.

Figure 11–7: Stress-strain curves for total load

11.5.1.3  Parameter optimisation
The purpose of the optimisation is to obtain a set of parameters for the UDCAM-S model.

The parameter ranges and the results you will see after the optimisation are shown in Table 11–3
(p. 178):
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Table 11–3: Parameter ranges and results after optimization

Parameter Name Min
value

Max
value

Optimised
value Unit

Ratio of the initial shear modulus
to the degraded shear strength at
failure in triaxial compression

Gur / τ
C 400.0 480.0 420.4 -

Shear strain at failure in triaxial
compression γf 

C 6.0 8.0 6.431 %

Shear strain at failure in triaxial
extension γf 

E 5.0 8.0 7.873 %

Shear strain at failure in direct simple
shear γf 

DSS 8.0 12.0 11.97 %

Ratio of the cyclic compression
shear strength over the undrained
static compression shear strength

τC / Su C 1.14 1.16 1.152 -

Ratio of the cyclic DSS shear
strength over the undrained static
compression shear strength

τDSS / Su C 0.89 0.91 0.9051 -

Ratio of the cyclic extension shear
strength over the undrained static
compression shear strength

τE / Su C 0.62 0.64 0.6208 -

Reference degraded shear strength
at failure in the triaxial compression
test

τC ref - - 149.7 -

Reference depth yref - - 0.000 m

Increase of degraded shear strength
at failure in the triaxial compression
test with depth

τC inc - - 0.000
kN/
m2/m

Ratio of the degraded shear strength
at failure in the triaxial extension test
to the degraded shear strength in the
triaxial compression test

τE / τC - - 0.5389 -

Initial mobilisation of the shear
strength with respect to the
degraded TXC shear strength

τ0 / τC - - 2.332E-3 -

Ratio of the degraded shear strength
at failure in the direct simple shear
test to the degraded shear strength
in the triaxial compression test

τDSS / τC - - 0.7858 -

Use the following steps to calculate the optimised values.

1 Click the Parameter optimisation tab.

2 Enter the parameters of the clay in the Static properties. Set su C ref to 130.0 and K0
determination to Manual and set K0 to 1.0.
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3 Propose minimum and maximum values for the parameters listed in Table 11–3 (p. 178).

Note:

In the optimisation, set minimum and maximum values of τC / Su C, τDSS / Su C, and

τE / Su C close to the results from the strain interpolation if one wants to keep these
values.

Calculate Gmax / τC by dividing Gmax from soil properties with results for (τC / Su C) ·

Su C.

Set the minimum and maximum values close to this value.

4 Click Calculate to obtain optimised parameters (Figure 11–8 (p. 179) and column
Optimised value of Table 11–3 (p. 178)).

After a few seconds, the optimal values are shown in the corresponding column in the
Parameter ranges table. Based on these values, the optimised parameters are calculated
and listed in the right-hand side of the table as shown in Figure 11–8 (p. 179)

Figure 11–8: Optimised parameters for total load
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The resulting stress-strain curves from test simulations with the UDCAM-S model using
the optimised parameters are shown together with the target points from the contour
diagrams.

5 When the calculation has finished, save the application state of the Cyclic accumulation
and optimisation tool. The saved data will be used when creating another material. To save
the application state, press the Save button  at the top of the window. Save the state
under the file name optimised_total.json.

6 Copy the optimised material parameters: Press the Copy parameters button and go back
to the Soil-UDCAM-S window describing the material.

7
Click the Paste material button .

The values in the Mechanical tab are replaced with the new values as shown in Figure 11–9
(p. 180) .

Figure 11–9: Copy parameters into Clay total material
8 Go to the Initial tab and set K0 to 1 by setting K0 determination to Manual, check K0,x = K0,z

(default) and set K0,x to 1.

9 Click OK to close the created material.

10 Assign the Clay - total load material set to the soil layer in the borehole.
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11.5.2  Material: Clay - cyclic load
Create a material for the second clay. Some information from the Clay - total load material will
be reused. The optimisation of the parameters has to be recalculated though, based on other
conditions.

The parameter ranges and the results you will see after the optimisation are shown in Table 11–4
(p. 181):

Table 11–4: Parameter ranges and results after optimisation

Parameter Name Min
value

Max
value

Optimised
value Unit

Ratio of the initial shear modulus
to the degraded shear strength at
failure in triaxial compression

Gmax / τC 700.0 800.0 703.2 -

Shear strain at failure in triaxial
compression γf 

C 1.0 3.0 2.966 %

Shear strain at failure in triaxial
extension γf 

E 1.0 3.0 2.699 %

Shear strain at failure in direct simple
shear γf 

DSS 1.0 3.0 2.946 %

Ratio of the cyclic compression
shear strength over the undrained
static compression shear strength

τC / Su C 0.66 0.67 0.6667 -

Ratio of the cyclic DSS shear
strength over the undrained static
compression shear strength

τDSS / Su C 0.47 0.49 0.4787 -

Ratio of the cyclic extension shear
strength over the undrained static
compression shear strength

τE / Su C 0.57 0.59 0.5790 -

Reference degraded shear strength
at failure in the triaxial compression
test

τC ref - - 86.67 -

Reference depth yref - - 0.000 m

Increase of degraded shear strength
at failure in the triaxial compression
test with depth

τC inc - - 0.000
kN/
m2/m

Ratio of the degraded shear strength
at failure in the triaxial extension test
to the degraded shear strength in the
triaxial compression test

τE / τC - - 0.8684 -

Initial mobilisation of the shear
strength with respect to the
degraded TXC shear strength

τ0 / τC - - 0.000 -
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Parameter Name Min
value

Max
value

Optimised
value Unit

Ratio of the degraded shear strength
at failure in the direct simple shear
test to the degraded shear strength
in the triaxial compression test

τDSS / τC - - 0.7181 -

Use the following steps to calculate the optimised values.

1 Copy the Clay - total load material.

2 Enter Clay - cyclic load for the identification.

3 Go to the Mechanical tab.

Like for the first material, also here the parameters will be determined using the Cyclic
accumulation and optimisation tool.

4 Click the Cyclic accumulation and optimisation tool button on the Mechanical tab to open
the tool.

5
Click the Open file button  and choose the application state optimised_total.json
that was saved after optimisation of the first material.

All tabs will be filled with data.

6 Leave the Cyclic accumulation tab as it is.

7 Go to the Stress-strain curves tab, set load type to Cyclic load.

8 Press Calculate and let the calculation finish.

The stress-strain curves are shown in Figure 11–10 (p. 183):
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Figure 11–10: Stress-strain curves for cyclic load
9 Go to the Parameter optimisation tab. Accept the notification about resetting the

optimisation tab to get updated values.

10 Make sure that su C ref is set to 130.0 and set K0 determination to Automatic.

11 Modify the minimum and maximum values for the Parameter ranges, see Table 11–4 (p.
181) for values.

12 Click Calculate to get the optimised parameters.

The optimised parameters are shown in the Figure 11–11 (p. 184) and are also listed in the
column 'Optimised value' in Table 11–4 (p. 181).
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Figure 11–11: Optimised parameters for cyclic load
13 Save the application state under the file name optimised_cyclic.json.

14 Copy the optimised material parameters: Click the Copy parameters button and go back to
the Soil-UDCAM-S window.

15
Click the Paste material button .

The values in the Mechanical tab are replaced with the new values.

16 Click OK to close the created material.

11.5.3  Material: Concrete
Create a new material for the concrete foundation.

1 Choose Soil and interfaces as the Set type and click the New button.

2 Enter Concrete footing for the Identification and select Linear elastic as the Soil model.

3 Set the Drainage type to Non-porous.

4 Enter the properties of the material:
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a. a unit weight of 24 kN/m3,
b. Young's modulus of 30x106 kN/m2 and
c. a Poisson's ratio of 0.1.

5 Click OK to close the created material.

6 Click OK to close the Material sets window.

11.6  Define the structural elements
The concrete foundation and interfaces have to be defined.

11.6.1  Define the concrete foundation
1 Click the Structures tab to proceed with the input of structural elements in the Structures

model.

2 Select the Create soil polygon feature in the side toolbar and click on (0.0, 0.0), (11.0, 0.0),
(11.0, -1.0) and (0.0, -1.0).

Note: Do not yet assign the Concrete footing material to the polygon.

11.6.2  Define the interfaces
Create an interface to model the interaction of the foundation and the surrounding soil. Extend
the interface half a meter into the soil. Make sure the interface is at the outer side of the footing
(inside the soil). The interface is created in two parts.

1 Click Create interface to create the upper part from (11.0, -1.0) to (11.0, 0.0), Figure 11–13 (p.
186).

2 Click Create interface to create the lower part (between foundation and soil) from (11.0, -1.5)
to (11.0, -1.0), Figure 11–13 (p. 186).

3 The upper part interface (between the foundation and the soil) is modeled with a reduced
strength of 30%.

a. Make a copy of the Clay - total load material and name it Clay - total load -
interface .

b. Reduce the interface strength by setting Rinter to 0.3 as shown in Figure 11–12 (p. 186)
and
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Figure 11–12: Clay-Total load interface
c. Assign this to the upper part of the interface.

4 For Phase 3 (Calculate vertical cyclic stiffness), another material with reduced strength is
needed.

a. Make a copy of the Clay - cyclic load material and name it Clay - cyclic load -
interface.

b. Reduce the interface strength by setting Rinter to 0.3.
c. Do not assign this yet. It will be assigned when defining Phase 3.

5 For the interface material extended into the soil, full soil strength is applied (Rinter = 1.0),
as implicitly defined in the original clay material Clay - total load. Keep the default setting
Material mode: From adjacent soil. The geometry of the model is shown in Figure 11–13 (p.
186):

Figure 11–13: Geometry of the model
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11.6.3  Define a vertical load
In order to calculate the cyclic vertical capacity and stiffness, a vertical load is applied at the top
of the foundation.

1 Define a distributed load by selecting Create line load and click (0.0, 0.0) and (11.0, 0.0).

2 In the Selection explorer set the value of qy,start,ref to -1000 kN/m/m.

11.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Medium (default).

3 Click the View mesh button  to view the mesh as shown in Figure 11–14 (p. 187).

Figure 11–14: The generated mesh
4 Click the Close tab to close the Output program.

11.8  Define and perform the calculation
The calculation consists of the following phases:
● In the Initial phase, the initial stress conditions are generated by the K0 procedure, using the

default values.
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● In Phase 1 the footing is activated by assigning the Concrete material to the corresponding
polygon. The interfaces are also activated.

● In Phase 2 the total cyclic vertical bearing capacity and stiffness are calculated.
● In Phase 3 the cyclic vertical bearing capacity and stiffness are computed.

11.8.1  Initial phase
1 Proceed to Staged construction mode .

2 In the Phases explorer double-click the initial phase.

3 Make sure that Calculation type is set to K0 procedure.

4 Click OK to close the Phases window.

11.8.2  Phase 1: Footing and interface activation
1 Click the Add phase button  to create a new phase.

2 Phase 1 starts from the Initial phase.

3 Activate the footing by assigning the Concrete footing material to the corresponding
polygon.

4 Activate the interfaces as well.

11.8.3  Phase 2: Cyclic Vertical Bearing capacity and
stiffness

In Phase 2 the total cyclic vertical bearing capacity and stiffness are calculated. The vertical
bearing capacity is obtained by increasing the vertical load (stress) until failure. The stiffness is
calculated as the force divided by the displacement.

1 Click the Add phase button  to create a new phase.

2 Phase 2 starts from Phase 1.

3 In the Phases window go to the Deformation control parameters subtree and select the
Reset displacements to zero option and Reset small strain.

4 In the Phases window go to the Numerical control parameters and in Max number of steps
stored set 500 steps.

5 Activate the line load.

11.8.4  Phase 3: Calculate vertical cyclic stiffness
In Phase 3, which also starts from Phase 1, the vertical cyclic stiffness is calculated by activating
the Clay - cyclic load material. The vertical bearing capacity is obtained by increasing the
vertical load (stress) until failure.

1 Click the Add phase button  to create a new phase.
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2 In the Phases window set the Start from phase to Phase 1.

3 Go to the Deformation control parameters subtree and select the Reset displacements to
zero option and Reset small strain.

4 In the Phases window goto the Numerical control parameters and in Max number of steps
stored set 500 steps and close the Phases window.

5 Replace the soil material with the Clay - cyclic load.

6 Assign the material Clay - cyclic load - interface material to the upper part of the interface.
The material mode of the lower part of the interface remains From adjacent soil.

7 Make sure the line is activated.

The calculation definition is now complete.

11.8.5  Execute the calculation
Before starting the calculation it is recommended to select nodes or stress points for a later
generation of load-displacement curves or stress and strain diagrams.

To do this, follow these steps:

1 Click the Select points for curves button in the side toolbar.

The connectivity plot is displayed in the Output program and the Select points window is
activated.

2 Select a pre-calc node on the footing (0.0, 0.0). Close the Select points window.

3 Click on the Update tab to close the Output program and go back to the Input program.

4 Click the Calculate button  to calculate the project.

5 Once the calculation is finished, go to the Output program and click on the Select points for
curves button  and chose a post-calc node on the footing (0.0, 0.0).
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11.9  Results
11.9.1  Total load cyclic vertical bearing capacity

Applied vertical stress (load): qy = -1000kN/m2

Failure at: qy = 720kN/m2(Figure 11–15 (p. 190))

Total vertical bearing capacity: Vcap = qy · Area = 720 kN/m2 · π · (11m)2 = 273.7MN

Figure 11–15: Total displacement vs ΣMstage
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Tip:  Generating a load displacement curve using pre-calc points

The load-displacement curve as function of qy  can be generated on a spreadsheet
using the calculation results on selected precalculation nodes of ΣMstage versus their
corresponding displacement (also called load-displacement curve).

Take into account that for PLAXIS a distributed load qy in any calculation step can be
defined as:

qactive=qphase.start+ΣMstage(qphase.end-qphase.start)

where:
● qphase.start is the load value at the start of the phase (or actually the load value at the

end of the previous phase).
● qphase.end is the desired load value at the end of the current phase, i.e. the defined

value in the Staged Construction settings.

Since for this tutorial qphase.start =0 then qactive=ΣMstage x qphase.end

Procedure:

1. From the Output program go to Curves manager and obtain the ΣMstage-
displacement curve.

2. Click on the  icon. Copy the |u| vs ΣMstage values for all steps and paste them
on the spreadsheet. Ensure that the values and their units pasted are consistent with
PLAXIS output.

3. Multiply each value of the ΣMstage column with the value of qphase.end. For this
example, qphase.end is equal to the defined vertical load of 1000KN.

4. Graph |u| vs qy.

For comparison, the static vertical bearing capacity (using the static undrained shear strength)
is found to be 228.1MN. The reason for the larger vertical bearing capacity is that the shear
strengths increase due to the higher strain rate during wave loading, compared to the value
obtained from standard monotonic laboratory tests, and this effect is larger than the cyclic
degradation during the storm.

11.9.2  Cyclic load cyclic vertical bearing capacity

Applied vertical stress (load): qy = -1000kN/m2

Failure at: qy = 458.1kN/m2(Figure 11–16 (p. 192))

Total vertical bearing capacity:

Vcap = qy · Area = 458.1kN/m2 · π · (11 m)2 = 174.14MN
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Figure 11–16: Total displacement vs vertical bearing capacity curve for cyclic load

Tip:  Generating a load displacement curve using post-calc points

Load displacement curves as a function of qy  vs |u| (see Figure 171) can be generated
directly in the Curves manager using the data on post-cal points. For this it is necessary
to ensure that before running the calculation a Max number of steps stored (inside the
Numerical control parameters) is defined for each specific phase (for this example 500
steps were utilized). Be aware that storing several calculation steps to obtain results
on post-cal nodes might produce heavier files with can be unsuitable depending on
the project. If this is case it is advised to obtain load displacement curves with pre-calc
nodes as indicated in previous sections.

In the Curves manager window, select the Invert sign option to obtain the positive
values of qy before generating the chart.

11.9.3  Vertical stiffness
The vertical stiffness (accounting for cyclic loading) is calculated as ky = Fy / uy for both the
total and the cyclic component. The total vertical displacement includes accumulated vertical
displacements during the storm. Load versus stiffness is shown in the following Figure 11–17 (p.
193):

Tip: To construct the vertical load vs vertical stiffness graph, use the values of the load
displacement curve (|u| vs qy) and operate Fy for each step, take into account:

● Fy = qy x Areafooting.
● For this example, uy is equal to |u|.

11 Cyclic vertical capacity and stiffness of circular underwater footing [ADV]   |  192



Figure 11–17: Vertical load versus stiffness for total and cyclic load components
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12
Flow through an embankment [ULT]

12.1  Introduction
In this chapter the flow through an embankment will be considered. Flow takes place from the
left side (river) to the right side (polder). As a result seepage will take place at the right side
of the embankment. The position of the phreatic level depends on the river water level, which
varies in time.

Objectives
● Performing Flow only analysis
● Using cross section curves
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12.2  Geometry
Figure 12–1 (p. 195) shows the layout of the embankment problem where free surface
groundwater flow occurs. The crest of the embankment has a width of 2.0 m. Initially the water
in the river is 1.5 m deep. The difference in water level between the river and the polder is 3.5 m.

2 m 6 m 2 m

3 m

3 m

10 m 3 m

5 m

1 m

y

x

Figure 12–1: Geometry of the project

12.3  Create new project
To create a new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick select dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-
Node).

4 Set the model dimensions to: xmin = 0 m, xmax = 23 m, ymin = 0 m and ymax = 6 m

5 Keep the default values for units, constants and the general parameters and click OK.

The Project properties window closes.

12.4  Define the soil stratigraphy
A number of boreholes has to be defined according to the information in Table 12–1 (p. 195).

Table 12–1: Information on the boreholes in the model

Borehole
number

Location (x) Head Top Bottom

1 2 4.5 3 0

2 8 4.5 6 0

3 10 4.0 6 0

4 20 1.0 1 0
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To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 2.

The Modify soil layers window pops up.

2 Specify the head value as 4.5.

3 Add a soil layer in the borehole. Set the top level to 3. No change is required for the bottom
boundary of the layer.

4 Create the rest of the required boreholes according to the information given in Table 12–1 (p.
195).

12.5  Create and assign material data set
A material data set needs to be created for the soil layer.

The sand layer has the following properties as shown in Table 12–2 (p. 196) .

Table 12–2: Material properties of the embankment material (sand)

Parameter Name Sand Unit

General
Material model - Linear elastic -

Drainage type - Drained -

Unsaturated unit weight γunsat 20 kN/m3

Saturated unit weight γsat 20 kN/m3

Mechanical

Young's modulus E'ref 10·103 kN/m2

Poisson's ratio ν 0.3 -

Groundwater
Classification type - Standard -

Soil class - Medium fine -

Flow parameters - Use defaults - From data set -

Horizontal permeability kx 0.02272 m/day

Vertical permeability ky 0.02272 m/day

To create the material set, follow these steps:

1  Define the soil material according to the table above and assign the material dataset to
the cluster. Skip the Interfaces and Initial tabsheets as these parameters are not relevant.

2 After assigning the material to the soil cluster close the Modify soil layers window.
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12.6  Generate the mesh
1 Proceed to the Mesh mode.

2 Select the two lines that form the left hand side slope and river bed as shown in Figure 12–2
(p. 197) . In the Selection Explorer specify a Coarseness factor of 0.5.

Figure 12–2: Selection of left hand side of slope
3 Click the Generate mesh button  to generate the mesh.

The Mesh options window appears.

4 Select the Fine option in the Element distribution drop-down menu and generate the mesh.

5 Click the View mesh button  to view the mesh as shown in Figure 12–3 (p. 197).

Figure 12–3: The generated mesh
6 Click the Close tab to close the Output program.

12.7  Define and perform the calculation
In this project only the flow related behaviour will be analysed. The calculation process consists
of three phases that will be defined in the Staged construction mode. In the initial phase, the
groundwater flow in steady state is calculated for an average river level. In Phase 1, the transient
groundwater flow is calculated for a harmonic variation of the water level. In Phase 2, the
calculation is similar as in Phase 1, but the period is longer.

Click the Staged construction tab to proceed to the corresponding mode. A global level is
automatically created according to the head values specified for each borehole (Table 12–1 (p.
195)). The model in the Staged construction mode is shown in Figure 12–4 (p. 198) .
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Figure 12–4: The model in the Staged construction mode

Note:  Note that the 'internal' part of the global water level will be replaced by the result
of the groundwater flow calculation.

12.7.1  Initial phase
1 Double-click the initial phase in the Phases explorer.

2 In the General subtree select the Flow only option as the Calculation type.

3 The default values of the remaining parameters are valid for this phase. Click OK to close
the Phases window.

4 In the Model explorer expand the Model conditions subtree.

5 In the Model conditions expand the GroundwaterFlow subtree. The default boundary
conditions are relevant for the initial phase. Confirm that only the bottom boundary is closed.
The expanded groundwater flow boundary conditions is shown in Figure 12–5 (p. 198).

Figure 12–5: The groundwater flow boundary conditions for the initial phase
6 In the Model explorer expand the Groundwater flow BCs subtree. The boundary conditions

at the extremities of the model are automatically created by the program and listed under the
GWFlowBaseBC.
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Note: Note that when the boundary conditions under the Groundwater flow BCs
subtree are active, the model conditions specified in the GroundwaterFlow are
ignored.

12.7.2  Phase 1-Transient ground water flow analysis
1 Click the Add phase button  to create a new phase.

2 In the Phases explorer double-click the current phase.

3 In the General subtree select the Transient groundwater flow option as pore pressure
calculation type.

4 Set the Time interval to 1 day.

5 In the Numerical control parameters subtree set the Max number of steps stored
parameter to 50. The default values of the remaining parameters will be used.

6 Click OK to close the Phases window.

7 Click the Select multiple objects button  in the side toolbar.

8  Click Select lines > Select water boundaries.

9 Select the hydraulic boundaries as shown in Figure 12–6 (p. 199).

Figure 12–6: Selected hydraulic boundaries
10 Right-click and click Activate.

11 In the Selection explorer set the Behaviour parameter to Head.

12 Set href to 4.5 m.

13 Select the Time dependent option in the Time dependency drop-down menu.

14 Click on the Head function parameter.

15 Click the Add button  to add a new head function.

16 In the Flow functions window select the Harmonic option in the Signal drop-down menu.
Set the amplitude to 1 m, the phase angle to 0° and the period to 1 day.

The flow function for the rapid phase is shown in Figure 12–7 (p. 200).
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Figure 12–7: The flow function for the rapid case
17 Click OK to close the Flow functions window.

12.7.3  Phase 2-Long term groundwater flow analysis
1 Click the Add phase button  to create a new phase.

2 In the Phases explorer double-click the current phase.

3 In the General subtree select the Initial phase in the Start from phase drop-down menu.

4 Select the Transient groundwater flow option as Pore pressure calculation type.

5 Set the Time interval to 10.0 day.

6 In the Numerical control parameters subtree set the Max number of steps stored
parameter to 50. The default values of the remaining parameters will be used.

7 Click OK to close the Phases window.

8 Make sure that the same boundaries are selected as in Phase 1.

9 In the Selection explorer click on the Head function parameter.

10 Click the Add button  to add a new head function.

11 In the Flow functions window select the Harmonic option in the Signal drop-down menu.
Set the amplitude to 1 m, the phase angle to 0° and the period to 10 day as shown in Figure
12–8 (p. 201).
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Figure 12–8: The flow function for the slow case
12 Click OK to close the Flow functions window.

12.7.4  Execute the calculation
To select points to be considered in curves:

1 In the Staged construction mode click the Select point for curves button  in the side
toolbar.

The Connectivity plot is displayed in the Output program.

2 In the Select points window select nodes located nearest to (0 3) and (8 2.5) to be
considered in curves.

3 Click Update to close the output program.

4 Click the Calculate button  to calculate the project.

5  Save the project after the calculation has finished.
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12.8  Results
In the Output program the Create animation tool can be used to animate the results displayed in
the Output program. To create the animation follow these steps:

1. Click the menu Stresses > Pore pressures > Groundwater head.
2. Select the menu File > Create animation. The corresponding window pops up.
3. Define the name of the animation file and the location where it will be stored. By default the

program names it according to the project and stores it in the project folder. In the same way
animations can be created to compare the development of pore pressures or flow field.

4. Deselect the Initial phase and Phase 2, such that only Phase 1 is included in the animations
and rename the animation accordingly. The Create animation window is shown in  Create
animation window:

Figure 12–9: Create animation window
To view the results in a cross section:

1. Click the Cross section button  in the side toolbar. The Cross section points window pops
up and the start and the end points of the cross section can be defined. Draw a cross section
through the points (2.0 3.0) and (20.0 1.0). The results in the cross section are displayed in a
new window.

2. In the Cross section view select the menu Stresses > Pore pressures > p active.
3. Click the Tools menu and select the Cross section curves option  . After the curves

window pops up, select the menu Selection style > Individual steps.
4. Select Phase 1. The variation of the results in the cross section is displayed in a new window

as shown in Figure 12–10 (p. 203).
5. Do the same for Phase 2. This may take about 30 seconds which is shown in Figure 12–11 (p.

203).
6. The variation of the results due to different time intervals in harmonic variation at a specific

cross section can be compared, see the figures below.

It can be seen that the slower variation of the external water level has a more significant
influence on the pore pressures in the embankment and over a larger distance.
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Figure 12–10: Active pore pressure variation in the cross section in Phase 1

Figure 12–11: Active pore pressure variation in the cross section in Phase 2
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13
Potato field moisture content [ULT]

13.1  Introduction
This tutorial demonstrates the applicability of PLAXIS 2D to agricultural problems. The potato
field tutorial involves a loam layer on top of a sandy base. The water level in the ditches remains
unchanged. The precipitation and evaporation may vary on a daily basis due to weather
conditions. The calculation aims to predict the variation of the water content in the loam layer in
time as a result of time-dependent boundary conditions.

Objectives
● Defining precipitation
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13.2  Geometry
Due to the symmetry of the problem, it is sufficient to simulate a strip with a width of 15.0 m, as
indicated in Figure 13–1 (p. 205). The thickness of the loam layer is 2.0 m and the sand layer is
3.0 m deep.

Loam

Sand

Precipitation

15m 15m

0.75m
0.50m
0.75m

1.25m0.75m

Precipitation

Figure 13–1: Potato field geometry

13.3  Create new project
To create a new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick select dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-
Node).

4 Set the model dimensions to: xmin = 0 m, xmax = 15 m, ymin = 0 m and ymax = 5 m.

5 Keep the default values for units, constants and the general parameters and press OK.

The Project properties window closes.

13.4  Define the soil stratigraphy
Due to the geometry of the model, the options for snapping should be changed.

1 Click the Snapping options button  in the bottom toolbar and snapping window appears
as shown in Figure 13–2 (p. 206).
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Figure 13–2: Modification of the Number of snap intervals
2 In the appearing window set the Number of snap intervals to 100.

3 Click OK to close the Snapping window.

To define the soil stratigraphy:

4 Click the Create borehole button  and create two boreholes located at x = 0.75 and x = 2
respectively.

5 In the Modify soil layers window add two soil layers.

6 In the first borehole set Top = 3.75 and Bottom = 3 for the uppermost soil layer. Set Bottom
= 0 for the lowest soil layer.

7 In the second borehole set Top = 5 and Bottom = 3 for the uppermost soil layer. Set Bottom
= 0 for the lowest soil layer.

8 For both boreholes the Head is located at y = 4.25.

Figure 13–3 (p. 206) shows the soil stratigraphy defined in the Modify soil layers window.

Figure 13–3: Soil stratigraphy in the Modify soil layers window
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13.5  Create and assign material data sets
Two material data sets need to be created for the soil layers.

The layers have the following properties:

Table 13–1: Material properties of the material

Parameter Name Loam Sand Unit

General
Soil model Model Linear elastic Linear elastic -

Drainage type Type Drained Drained -

Unsaturated unit weight γunsat 19 20 kN/m3

Saturated unit weight γsat 19 20 kN/m3

Mechanical

Stiffness E' ref 1·103 10·103 kN/m2

Poisson's ratio ν 0.3 0.3 -

Groundwater
Classification type Type Staring Staring -

SWCC fitting method - Van
Genuchten

Van
Genuchten -

Subsoil/Topsoil - Topsoil Subsoil -

Soil class - Clayey
loam (B9)

Loamy
sand (O2) -

Flow parameters - Use defaults - From data set From data set -

Permeability in horizontal direction kx 0.01538 0.1270 m/day

Permeability in vertical direction ky 0.01538 0.1270 m/day

To create the material sets, follow these steps:

1  Create the material data sets according to Table 13–1 (p. 207).

2 Assign the material data set to the corresponding clusters in the model.

13.6  Generate the mesh
1 Proceed to the Mesh mode.

2 Multi-select the line segments composing the upper boundary of the model as shown in
Figure 13–4 (p. 208).
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Figure 13–4: The upper boundary of the model
3 In the Selection explorer set the Coarseness factor parameter to 0.5.

4 Click the Generate mesh button  to generate the mesh. Use the default option for the
Element distribution parameter (Medium).

5 Click the View mesh button  to view the mesh which is shown in Figure 13–5 (p. 208).

Figure 13–5: The generated mesh
6 Click the Close tab to close the Output program.

13.7  Define and perform the calculation
The calculation process consists of two phases. In the initial phase, the groundwater flow in
steady state is calculated. In Phase 1, the transient groundwater flow is calculated.

13.7.1  Initial phase
1 Proceed to the Staged construction mode . In this project only groundwater flow analysis

will be performed.

2 In the Phases window, select the General subtree, set the Calculation type as Flow only
option.

3 The default values of the remaining parameters are valid for this phase. Click OK to close
the Phases window.
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4  Right-click the bottom boundary of the model and select the Activate option in the
appearing menu.

5 In the Selection explorer in the Behaviour drop-down menu select the Head option and set
href to 3.0 as shown in Figure 13–6 (p. 209).

Figure 13–6: Initial phase with ground water flow base
6 In the Model explorer expand the Model conditions subtree.

7 Expand the GroundwaterFlow subtree. Set BoundaryXMin and BoundaryXMax to Closed.

8 Expand the Water subtree. The borehole water level is assigned to GlobalWaterLevel.

Tip:  Note that the conditions explicitly assigned to groundwater flow boundaries
are taken into account. In this tutorial the specified Head will be considered for
the bottom boundary of the model, NOT the Closed condition specified in the
GroundwaterFlow subtree under the Model conditions.

13.7.2  Transient phase
In the transient phase the time-dependent variation of precipitation is defined.

A discharge function with the following precipitation data will be defined as shown in Table 13–2
(p. 209).

Table 13–2: Precipitation data

ID Time [days] Δ Discharge [m3/day/m]
1 0 0

2 1 0.01

3 2 0.03

4 3 0

5 4 -0.02

6 5 0

7 6 0.01

8 7 0.01

9 8 0
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ID Time [days] Δ Discharge [m3/day/m]
10 9 -0.02

11 10 -0.02

12 11 -0.02

13 12 -0.01

14 13 -0.01

15 14 0

16 15 0

1 Click the Add phase button  to create a new phase.

2 In General subtree of the Phases window select the Transient groundwater flow as Pore
pressure calculation type.

3 Set the Time interval to 15 days.

4 In the Numerical control parameters subtree set the Max number of steps stored to 250.
The default values of the remaining parameters will be used.

5 Click OK to close the Phases window.

6 To define the precipitation data a discharge function should be defined. In the Model
explorer expand the Attributes library subtree.

7 Right-click on Flow functions and select the Edit option in the appearing menu. The Flow
functions window pops up.

8 In the Discharge functions tabsheet add a new function.

9 Specify a name for the function and select the Table option in the Signal drop-down menu.

10 Click the Add row button to introduce a new row in the table. Complete the data using the
values given in Table 13–2 (p. 209).

Figure 13–7 (p. 211) shows the defined function for precipitation.
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Figure 13–7: The Flow function window displaying the precipitation data and plot
11 Close the windows by clicking OK.

12 In the Model explorer under Model conditions expand the Precipitation subtree and
activate it. The default values for discharge (q) and condition parameters (ψmin = -1.0 m
and ψmax = 0.1m) are valid.

13 For the precipitation select the Time dependent option in the corresponding drop-down
menu and assign the defined function.

14 In the Model explorer set DischargeFunction_1 under Discharge function as shown in
Figure 13–8 (p. 212).
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Figure 13–8: Precipitation in the Model explorer

Note: Negative values of precipitation indicate evaporation.

13.7.3  Execute the calculation
1 Click the Calculate button  , ignore the feedback and continue to calculate the project. .

2  Save the project after the calculation has finished.
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13.8  Results
The calculation was focused on the time-dependent saturation of the potato field.

To view the results:

1 Click the menu Stresses > Groundwater flow > Saturation.

2 Double-click the legend.

The Legend settings window pops up. Define the settings as shown in Figure 13–9 (p.
213).

Figure 13–9: Value for settings

3
Figure 13–10 (p. 213) shows the spatial distribution of the saturation for the last time step.

Figure 13–10: Saturation field at day 15

4 Create an animation of the transient phase for a better visualisation of the results.

5 It is also interesting to create a vertical cross section at x = 4 m and draw cross section
curves for pore pressure and saturation.
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14
Stability of dam under rapid

drawdown [ULT]

14.1  Introduction
This example concerns the stability of a reservoir dam under conditions of drawdown. Fast
reduction of the reservoir level may lead to instability of the dam due to high pore water
pressures that remain inside the dam. To analyse such a situation using the finite element
method, a fully coupled flow-deformation analysis is required. Time-dependent pore pressure
is coupled with deformations development and used in a stability analysis. This example
demonstrates how coupled analysis and stability analysis can interactively be performed in
PLAXIS 2D.

Objectives
● Defining time-dependent hydraulic conditions (Flow functions).
● Defining transient flow conditions using water levels.
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14.2  Geometry
The dam to be considered is 30m high and the width is 172.5m at the base and 5m at the top.
The dam consists of a clay core with a well graded fill at both sides. The normal water level
behind the dam is 25m high. A situation is considered where the water level drops 20m. The
normal phreatic level at the right hand side of the dam is 10m below ground surface. The
geometry of the dam is shown in Figure 14–1 (p. 215).

77.5 m 37.5 m

30 m

30 m

25 m

Fill Fill

Core

20 m

50 m 90 m

120 m 120 m

5 m

y

x

5 m

Subsoil

Figure 14–1: Geometry of the project

14.3  Create new project
To create the new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 Keep the default units and constants and set the model Contour to xmin = -130 m, xmax = 130
m, ymin = -30 m and ymax = 30 m.

14.4  Define the soil stratigraphy
In order to define the underlying foundation soil, a borehole needs to be added and material
properties must be assigned. A layer of 30 m overconsolidated silty sand is considered as sub-
soil in the model.

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

2 Add a soil layer extending from ground surface (y = 0) to a depth of 30 m (y = -30).

14.5  Create and assign material data sets
Three material data sets need to be created for the soil layers.
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The layers have the following properties as shown in Table 14–1 (p. 216):

Table 14–1: Material properties of the dam and subsoil

Parameter Name Core Fill Subsoil Unit

General

Soil model Model Mohr-
Coulomb

Mohr-
Coulomb

Mohr-
Coulomb -

Drainage type Type Undrained
(B) Drained Drained -

Unsaturated unit weight γunsat 16 16 17 kN/m3

Saturated unit weight γsat 18 20 21 kN/m3

Mechanical

Young's modulus E' ref 1.5·103 20·103 50·103 kN/m2

Poisson's ratio ν 0.35 0.33 0.3 -

Cohesion c'ref - 5 1 kN/m2

Young's modulus increment E'inc 300 - -
kN/
m2/m

Undrained shear strength su,ref 5 - - kN/m2

Friction angle φ' - 31 35 °

Dilatancy angle ψ - 1 5 °

Undrained shear strength increment su,inc 3.0 - - kN/m3

Reference level yref 30 - - m

Groundwater
Classification type - Hypres Hypres Hypres -

SWCC fitting method - Van
Genuchten

Van
Genuchten

Van
Genuchten -

Subsoil /Topsoil - Subsoil Subsoil Subsoil -

Soil class(standard) - Very fine Coarse Coarse -

Flow parameters - Use defaults None None None -

Horizontal permeability kx 0.1·10-3 1.00 0.01 m/day

Vertical permeability ky 0.1·10-3 1.00 0.01 m/day

To create the material sets, follow these steps:

1  Open the Material sets window.
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2 Create data sets under the Soil and interfaces set type according to the information given
in Table 14–1 (p. 216). Note that the Thermal, Interfaces and Initial tabsheets are not
relevant (no thermal properties, no interfaces or K0 procedure are used).

3 Assign the Subsoil material dataset to the soil layer in the borehole.

14.6  Define the dam
The dam will be defined in the Structures mode.

In order to draw the dam with the mouse it is necessary to decrease the snap-to-grid distance.
By default this distance is 1 m, but in this tutorial it should be 0.5m. In order to change the snap-

to-grid distance, select the Snapping options button  below the drawing area. The Spacing
defines the distance between 2 grid points and the Intervals defines the amount of snap-to-
grid intervals between 2 grid points. In order to have a snap-to-grid distance of 0.5m we can set
either the Spacing to 0.5m and leave the Intervals to 1, or we can leave the Spacing at 1 m and
set the amount of Intervals to 2.

1
Click on the Polygon button  to define a polygon through the points located at (-80 0),
(92.5 0), (2.5 30) and (-2.5 30).

2
Click again on the Polygon button  , and this time select the Cut polygon button  to
create the sub-clusters in the dam. Define two cutting lines from (-10 0) to (-2.5 30) and
from (10 0) to (2.5 30).

3 Assign the corresponding material datasets to the soil clusters.

14.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Click the Generate mesh button  in the side toolbar. For the Element distribution
parameter, use the option Fine.

3 Click the View mesh button  to view the mesh which is shown in Figure 14–2 (p. 217).

Figure 14–2: The generated mesh
4 Click the Close tab to close the Output program.
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14.8  Define and perform the calculation
The following cases will be considered:
● A long term situation with water level at 25m.
● A quick drop of the water level from 25 to 5m.
● A slow drop of the water from 25 to 5m.
● A long term situation with water level at 5m.

In addition to Initial phase, the calculation consists of eight phases. In the initial phase, initial
stresses and initial pore water pressures of the dam under normal working conditions are
calculated using Gravity loading. For this situation the water pressure distribution is calculated
using a steady-state groundwater flow calculation. The first and second phases both start
from the initial phase (i.e. a dam with a reservoir level at 25m) and the water level is lowered
to 5 m. A distinction is made in the time interval at which this is done (i.e. different speeds of
water level reduction; rapid drawdown and slow drawdown). In both cases the water pressure
distribution is calculated using a fully coupled flow-deformation analysis. The third calculation
phase also starts from the initial phase and considers the long-term behaviour of the dam at
the low reservoir level of 5 m, which involves a steady-state groundwater flow calculation to
calculate the water pressure distribution. Finally, for all the water pressure situations the safety
factor of the dam is calculated by means of phi-c reduction.

Note that only the water conditions will be defined for different calculation phases. The model
requires no changes in the geometry. Water levels can be defined in the Flow conditions mode.

14.8.1  Initial phase: Dam construction & high reservoir
By default the initial phase is added in the Phases explorer.

1 Proceed to the Flow conditions mode by clicking the corresponding tab.

2 Activate Fill and Core.

3 In the Phases explorer double-click Initial phase.

The Phases window is displayed.

4 In the General subtree specify the name of the phase (e.g. High reservoir).

5
Select the Calculation type > Gravity loading option  .

6
Select the Pore pressure calculation type > Steady state groundwater flow option 

7 In the Deformation control parameters subtree, uncheck the Ignore suction option.

Note: Note that in this exercise we will do a fully coupled flow-deformation
analysis and this type of analysis always takes into account suction in the
unsaturated zone. Therefore, it is advised to also take into account suction in
calculation phases prior to the fully coupled flow deformation analysis (like the
initial phase in this tutorial) to avoid the unbalance in soil stresses that would occur
when changing between phases with and without suctions.
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The phases window after putting all the parameters is shown in Figure 14–3 (p. 219):

Figure 14–3: The Phases window

8 Click OK to close the Phases window.

Note: Note that by default Undrained behaviour (A) and (B) are ignored for a
Gravity loading calculation type. The corresponding option is available in the
Deformation control parameters subtree in the Phases window

9  Define the water level corresponding to the level of water in the reservoir prior to the
drawdown. The water level consists of four points:
● Starting at the very left side at a level of 25 m above the ground surface (-132 25);
● Second point just inside the dam at a level of 25 m (-10 25);
● Third point near the dam toe (93 -10);
● Forth point just outside the right boundary at a level of 10 m below the ground surface

(132 -10).

Note: Straight lines can be defined by keeping the Shift key pressed while defining
the geometry.

The defined water level is shown in Figure 14–4 (p. 220)
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Figure 14–4: High water level in the reservoir
10 Right-click the created water level and select the Make global option in the appearing

menu.

Note that the global water level can also be specified in the Model Explorer by selecting
the corresponding option in the menu Model conditions > Water > GlobalWaterLevel >
UserWaterLevel_1.

11 In the Model explorer expand the Attributes library.

12 Expand the Water levels subtree. The levels created in the Flow conditions mode are
grouped under User water levels.

13 Expand the User water levels subtree.

The created water level can be seen named as UserWaterLevel_1. The location of the water
levels in Model explorer is shown in Figure 14–5 (p. 220)

Figure 14–5: Water levels in Model explorer
14 Double-click on the created water level and rename it as FullReservoir_steady. This is a

distinctive name that satisfies the naming requirements (no invalid characters).

15 Expand the Model conditions subtree.

16 Expand the GroundWaterFlow subtree.

Note that by default the boundary at the bottom of the model is set to Closed shown in
Figure 14–6 (p. 221). This is relevant for this example.
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Figure 14–6: GroundwaterFlow boundary conditions in Model explorer

14.8.2  Phase 1: Rapid drawdown
In this phase rapid drawdown of the reservoir level is considered.

1 Click the Add phase button  to create a new phase.

2 In the Phases explorer double-click the newly added phase.

The Phases window is displayed.

3 In the General subtree specify the name of the phase (e.g. Rapid drawdown). Note that the
High reservoir phase is automatically selected in the Start from phase drop-down menu.

4
As Calculation type, select the Fully coupled flow-deformation option  .

5 In the Include reference flow analysis option keep the checkbox unselected. This sets
non-steady state boundary conditions.

6 To the Time interval parameter assign a value of 5 days .

7 In the Deformation control parameters subtree, make sure that the Reset displacements
to zero and Reset small strain options are selected.

8 Click OK to close the Phases window (see Figure 14–7 (p. 222)).
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Figure 14–7: Phases window for the Rapid drawdown phase
with - fully coupled flow-deformation calculation type

9 Due to the global nature of the water levels, if an attribute is assigned to a water level in
the model it will affect it in all phases. The water level in this phase has the same geometry
with the one previously defined, however it is time dependent and a function needs to be
assigned to it. As a result, it is required to create a new water level with the same geometry
and different attributes. In the Model explorer go to the Attributes library > Water levels
> User water levels and right-click on FullReservoir_Steady as shown in Figure 14–8 (p.
223). Then select the Duplicate option in the appearing menu.

A copy of the water level is created.
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Figure 14–8: Duplication of water level
10 Rename the newly created water level as FullReservoir_Rapid. The behaviour of the water

levels can be described by specifying Flow functions. Note that Flow functions are global
entities and are available in the Model explorer under the Attributes library. To define the
flow functions:

a. In the Model explorer go to the Attributes library and right-click the Flow functions
option. Select the Edit option in the appearing menu. The Flow functions window is
displayed.

b. In the Head functions tabsheet add a new function by clicking the corresponding button
. The new function is highlighted in the list and options to define the function are

displayed.
c. Specify a proper Name to the function for the rapid drawdown (e.g. Rapid).
d. From the Signal drop-down menu, select the Linear option .
e. Specify a time interval of 5 days.
f. As ΔHead assign a value of -20 m representing the amount of the head decrease.

A graph is displayed showing the defined function in Figure 14–9 (p. 224).
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Figure 14–9: The flow function for the rapid drawdown case
g. Click OK to close the Flow functions window.

11 In the Model explorer right-click on FullReservoir_Rapid and select the Use as global
water level option in the appearing menu.

12 Expand the FullReservoir_Rapid subtree. Note that the water level is composed of 3 water
segments. Select the water segment in the upstream shoulder (left from the dam, at the
reservoir side).

13 Expand the subtree of the selected segment and from the TimeDependency parameter
select the Time dependent option.

14 For the HeadFunction parameter select the Rapid option.

Figure 14–10 (p. 225) shows the selected water segment in Model explorer.
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Figure 14–10: Properties of the lowering water segment
15 Note that in the Model explorer under the Model conditions in the Water subtree the

GlobalWaterLevel gets assigned the new water level (FullReservoir_Rapid).

The configuration of the phase is shown in Figure 14–11 (p. 225).

Figure 14–11: Configuration of the rapid drawdown phase

Note that the shadow under the water level segment in the upstream shoulder indicates the
variation of the water level during the phase.

14.8.3  Phase 2: Slow drawdown
In this phase the drawdown of the reservoir level is performed at a lower rate.

1 Select the High reservoir phase in the Phases explorer.

2 Click the Add phase button  to create a new phase.

3 In Phases explorer double-click the newly added phase. The Phases window is displayed.

4 In the General subtree specify the name of the phase (e.g. Slow drawdown). The High
reservoir phase is automatically selected for the Start from phase parameter.
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5
Select the Fully coupled flow deformation option  as calculation type.

6 Assign a value of 50 days to the Time interval parameter.

7 Make sure that the Reset displacements to zero and Reset small strain options are
selected in the Deformation control parameters subtree. The Ignore suction option is
unchecked by default.

8 Click OK to close the Phases window.

9 Create a new duplicate of the high water level. The newly created water level will be used
as Global water level in the slow drawdown phase. Even though the water level in this
phase has the same geometry as the previously defined ones, the flow function for the
time dependency is different.

10 Rename the newly created water level as 'FullReservoir_Slow'.

11  Add a new flow function following the steps described for the previous phase.

a. Specify a proper name to the function for the slow drawdown (e.g. Slow).
b. From the Signal drop-down menu select the Linear option.
c. Specify a time interval of 50 days.
d. Assign a value of -20 m to ΔHead, representing the amount of the head decrease. A

graph is displayed showing the defined function.
e. Click OK to close the Flow functions window as shown in Figure 14–12 (p. 226).

Figure 14–12: The flow function for the slow drawdown case
12 In the Model Explorer > Attributes library > Water levels > User water levels right-click

on FullReservoir_Slow and select the Use as global water level option in the appearing
menu.

13 Expand the FullReservoir_Slow subtree. Select the water segment in the upstream
shoulder (left from the dam, at the reservoir side).

The segment selected in Model explorer is indicated by a red colour in the model.

14 Expand the subtree of the selected segment and for the TimeDependency parameter
select the Time dependent option.
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15 Select the Slow option for the HeadFunction parameter.

Note that in the Model explorer under the Model conditions in the Water subtree the
GlobalWaterLevel gets assigned the new water level (FullReservoir_Slow).

14.8.4  Phase 3: Low level
This phase considers the steady-state situation of a low reservoir level.

1 Go to the Phases explorer and select the High reservoir phase.

2 Click the Add phase button  to create a new phase.

3 In Phases explorer double-click the newly added phase.

The Phases window is displayed.

4 In the General subtree specify the name of the phase (e.g. Low level). The High reservoir
phase is automatically selected for the Start from phase parameter.

5
In the Calculation type make sure that the Plastic option  is selected.

6
As Pore pressure calculation typeselect the Steady state groundwater flow option .

7 In the Deformation control parameters subtree select Ignore und. behaviour (A,B).
Then make sure that the Reset displacements to zero and Reset small strain options are
selected. Finally, uncheck the Ignore suction option.

8 Click OK to close the Phases window.

9  Define the water level corresponding to the level of water in the reservoir after the
drawdown. The water level consists of four points:
● Starting at the very left side at a level of 5 m above the ground the surface (-132 5);
● Second point inside the dam at a level of 5 m (-60 5);
● Third point at (93 -10);
● Fourth point just outside the right boundary at a level of 10 m below the ground surface

(132 -10).

10 Rename the newly created water level as 'LowLevel_Steady'.

11 In the Model explorer > Model conditions > Water assign to the GlobalWaterLevel the
newly created water level (LowLevel_Steady).

Figure 14–13: Model for the low level case in the Flow conditions mode

All the defined water levels are shown in Figure 14–13 (p. 227).
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14.8.5  Phase 4 to 7: Safety analysis
In Phases 4 to 7 stability calculations are defined for the previous phases.

1 Select the parent phase in the Phases explorer.

2 Click the Add phase button  to create a new phase. Proceed to the Phases window.

3 Set Calculation type to Safety .

4 In the Deformation control subtree, select Reset displacements to zero.

5 In the Deformation control parameters subtree, check the Ignore suction option for all the
safety analyses.

Note: Taking suction into account in a Safety phase gives a higher factor of safety,
hence ignoring suction in a Safety phase is more conservative. In the Safety
analysis of PLAXIS 2D, any unbalance due to changing from suction to no suction is
first solved before the factor of safety is determined. As a result, ΣMsf can decrease
in the first part of the calculation.

6 The final view of the phases explorer window is shown in Figure 14–14 (p. 228).

Figure 14–14: The final view of Phases explorer

14.8.6  Execute the calculation
1 Proceed to the Staged construction mode.

2  Select nodes located at the crest (-2.5 30) and at the toe of the dam (-80 0).

3 Click the Calculate button  to calculate the project and ignore the warnings regarding the
influence of suction in the Safety analysis..

4  Save the project after the calculation has finished.
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14.9  Results
The results of the four groundwater flow calculations in terms of pore pressure distribution are
shown in the figures below. Four different situations were considered:
● The steady-state situation with a high (standard) reservoir level is shown in Figure 14–15 (p.

229).

Figure 14–15: Pore pressure distribution, (pactive), for high reservoir level

● The pore pressure distribution after rapid drawdown of the reservoir level is shown in Figure
14–16 (p. 229).

Figure 14–16: Pore pressure distribution, (pactive), after rapid drawdown

● The pore pressure distribution after slow drawdown of the reservoir level is shown in Figure
14–17 (p. 229).

Figure 14–17: Pore pressure distribution, (pactive), after slow drawdown

● The steady-state situation with a low reservoir level is shown in Figure 14–18 (p. 230).
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Figure 14–18: Pore pressure distribution, (pactive), for low reservoir level

Note:

The phreatic level can be smoother with a high refinement of the mesh in the core.

When the change of pore pressure is taken into account in a deformation analysis, some
additional deformation of the dam will occur. These deformations and the effective stress
distribution can be viewed on the basis of the results of the first four calculation phases.
Here, attention is focused on the variation of the safety factor of the dam for the different
situations. Therefore, the development of ΣMsf is plotted for the phases 4 to 7 as a function of
the displacement of the dam crest point (-2.5 30.0), see Figure 14–19 (p. 230).

Figure 14–19: Safety factors for different situations

Rapid drawdown of a reservoir level can reduce the stability of a dam significantly. Fully coupled
flow-deformation and stability analysis can be performed with PLAXIS 2D to effectively analyse
such situations.

14 Stability of dam under rapid drawdown [ULT]   |  230



Note:
● In the strength reduction method the factor of safety is considered the value of the

strength reduction factor ΣMsf for which progressive failure occurs. Hence, a Safety
analysis should be performed with sufficient steps to make sure that failure really
occurs. This can be checked from the graph of displacement vs ΣMsf where the
curve flattens: the strength can no longer be reduced while the displacement rapidly
increase.

● By removing the suction in the safety analysis, an out-of-balance force is introduced
at the beginning of the calculation. Without the contribution of the suction, the ΣMsf
can decrease in the first part of the calculation.
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15
Dynamics analysis of a generator on

an elastic foundation [ULT]

15.1  Introduction
Using PLAXIS 2D, it is possible to simulate dynamic soil-structure interaction. Here the influence
of a vibrating source on its surrounding soil is studied. Oscillations caused by the generator are
transmitted through the footing into the subsoil.

The physical damping due to the viscous effects is taken into consideration via the Rayleigh
damping. Also, due to axisymmetry 'geometric damping' can be significant in attenuating the
vibration.

The modelling of the boundaries is one of the key points. In order to avoid spurious wave
reflections at the model boundaries (which do not exist in reality), special conditions have to be
applied in order to absorb waves reaching the boundaries.

Objectives
● Defining a Dynamic calculation
● Defining dynamic loads
● Defining dynamic boundary conditions (viscous)
● Defining material damping by means of Rayleigh damping
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15.2  Geometry
The vibrating source is a generator founded on a 0.2 m thick concrete footing of 1 m in diameter
as shown in Figure 15–1 (p. 233).

Generator

Sandy clay

1 m

Figure 15–1: Generator founded on elastic subsoil

15.3  Create new project
To create the new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick select dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 Due to the three dimensional nature of the problem, an axisymmetric model is used. In the
Model tabsheet select the Axisymmetric option for Model and keep the default option for
Elements (15-Noded).

4 Keep the default values for units and constants and set the model contour to xmin = 0 m, xmax
= 20 m, ymin = -10 m and ymax = 0 m.

Note: The model boundaries should be sufficiently far from the region of interest,
to avoid disturbances due to possible reflections. Although special measures
are adopted in order to avoid spurious reflections (viscous boundaries), there is
always a small influence and it is still a good habit to put boundaries far away. In
a dynamics analysis, model boundaries are generally taken further away than in a
static analysis.

15.4  Define the soil stratigraphy
The subsoil consists of one layer with a depth of 10 m. The ground level is defined at y = 0. Note
that water conditions are not considered in this example. To define the soil stratigraphy:
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1 Click the Create borehole button  and create a borehole at x = 0.

2 Create a soil layer extending from ground surface (y = 0) to a depth of 10 m (y = -10).

3 Keep the Head in the borehole at 0 m. This means that the sub-soil is fully saturated.

15.5  Create and assign material data sets
 The soil layer consists of sandy clay, which is assumed to be elastic. Create a data set under

the Soil and interfaces set type according to the information given in Table 15–1 (p. 234). The
specified Young's modulus seems relatively high. This is because the dynamic stiffness of the
ground is generally considerably larger than the static stiffness, since dynamic loadings are
usually fast and cause very small strains.

Table 15–1: Material properties of the material

Parameter Name Value Unit

General
Soil model Model Linear elastic -

Drainage type Type Drained -

Unsaturated unit weight γunsat 20 kN/m3

Saturated unit weight γsat 20 kN/m3

Mechanical

Stiffness E' ref 50·103 kN/m2

Poisson's ratio ν' 0.3 -

Initial
K0 determination - Automatic -

Lateral earth pressure coefficient K0,x 0.50 -

Note: When using Mohr-Coulomb or linear elastic models the wave velocities Vp and
Vs are calculated from the elastic parameters and the soil weight. Vp and Vscan also
be entered as input; the elastic parameters are then calculated automatically. See also
Elastic parameters and the Wave Velocity relationships in the Mechanical Tabsheet of
the Reference Manual.

15.6  Define the structural elements
The generator is defined in the Structures mode.
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Table 15–2: Material properties of the footing

Parameter Name Value Unit
Material type - Elastic -

Weight w 5 kN/m/m

Isotropic - Yes -

Axial stiffness EA1 7.6·106 kN/m

Flexural rigidity EI 24·103 kNm2/m

Poisson's ration ν 0 -

1  Create a plate extending from (0 0) to (0.5 0) to represent the footing.

2  Define a material data set for the footing according to the information given in Table 15–2
(p. 235). The footing is assumed to be elastic and has a weight of 5 kN/m2.

3 Apply a distributed load on the footing to model the weight of the generator as well as the
vibrations that it produces. The actual value of the load will be defined later.

The model is shown in Figure 15–2 (p. 235):

Figure 15–2: Model layout

15.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Click the Generate mesh button  to generate the mesh. Use the default option for the
Element distribution parameter (Medium).

3 Click the View mesh button  to view the mesh.

The resulting mesh is shown in Figure 15–3 (p. 236) . Note that the mesh is automatically
refined under the footing.
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Figure 15–3: The generated mesh
4 Click the Close tab to close the Output program.

15.8  Define and perform the calculation
The calculation consists of 4 phases and it will be defined in the Staged construction mode .

15.8.1  Initial phase
1 Click the Staged construction tab to proceed with the definition of the calculation phases.

2 The initial phase has already been introduced. The default settings of the initial phase will be
used in this tutorial.

15.8.2  Phase 1: Footing
1 Click the Add phase button  to create a new phase. The default settings of the added

phase will be used for this calculation phase.

2 Activate the footing.

3 Activate the static component of the distributed load. In the Selection explorer set qy,start,ref
value to -8 kN/m/m. Do not activate the dynamic component of the load as shown in Figure
15–4 (p. 236).

Figure 15–4: Specification of the static load component in the Selection explorer

15.8 Define and perform the calculation  |  236



15.8.3  Phase 2: Start generator
In this phase, a vertical harmonic load, with a frequency of 10 Hz and amplitude of 10 kN/m2,
is applied to simulate the vibrations transmitted by the generator. Five cycles with a total time
interval of 0.5 sec are considered.

1 Click the Add phase button  to create a new phase.

2 In the General subtree in the Phases window, select the Dynamic option  as calculation
type.

3 Set the Dynamic time interval parameter to 0.5 s.

4 In the Deformation control parameters subtree in the Phases window select the Reset
displacements to zero parameter. The default values of the remaining parameters will be
used for this calculation phase.

5 In the Model explorer expand the Attributes library subtree.

6 Right-click the Dynamic multipliers subtree and select the Edit option from the appearing
menu.

The Multipliers window pops up.

7 Click the Load multipliers tab.

8 Click the Add button  to introduce a multiplier for the loads.

9 Define a Harmonic signal with an Amplitude of 10, a Phase of 0° and a Frequency of 10
Hz and as shown in Figure 15–5 (p. 237):

Figure 15–5: Definition of a Harmonic multiplier
10

 In the Selection explorer, activate the dynamic component of the load
(DynLineLoad_1).
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11 Specify the components of the load as (qx, start, ref, qy, start, ref) = (0.0, -1.0). Click Multiplier_y
in the dynamic load subtree and select the LoadMultiplier_1 option from the drop-down
menu as shown in Figure 15–6 (p. 238).

Figure 15–6: Specification of the dynamic load component in the Selection explorer

Tip: The dynamic multipliers can be defined in the Geometry modes as well as in
the Calculation modes.

12 Special boundary conditions have to be defined to account for the fact that in reality the
soil is a semi-infinite medium. Without these special boundary conditions the waves would
be reflected on the model boundaries, causing perturbations. To avoid these spurious
reflections, viscous boundaries are specified at Xmax and Ymin. The dynamic boundaries
can be specified in the Model explorer > Model conditions > Dynamics subtree as shown
in Figure 15–7 (p. 239).
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Figure 15–7: Boundary conditions for dynamics calculations

15.8.4  Phase 3: Stop generator
1 Click the Add phase button  to create a new phase.

2 In the General subtree in the Phases window, select the Dynamic option  as calculation
type.

3 Set the Dynamic time interval parameter to 0.5 s.

4 In the Staged construction mode deactivate the dynamic component of the surface load.
Note that the static load is still active. The dynamic boundary conditions of this phase should
be the same as in the previous phase.

15.8.5  Execute the calculation
1 Click the Select points for curves button in the side toolbar and select nodes located at

the ground surface, for instance at (1.4 0), (1.9 0) and (3.6 0), to consider in curves.

2 Click the Calculate button  to calculate the project.

3 After the calculation has finished, save the project by clicking the Save button .
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15.8.6  Additional calculation with damping
In a second calculation, material damping is introduced by means of Rayleigh damping. Rayleigh
damping can be entered in the material data set. The following steps are necessary:

1 Save the project under another name.

2 Open the material data set of the soil.

3 In the General tabsheet Rayleigh damping parameter is displayed .Set the Input method to
SDOF Equivalent.

4 In order to introduce 5% of material damping, set the value of the ξ parameter to 5%
for both targets as ξ  1  and ξ 2  and set the frequency values to 1 and 10 for f 1  and f 2 
respectively.

5 The values of α and β are automatically calculated by the program as shown in Figure 15–8
(p. 240).

Figure 15–8: Input of Rayleigh damping
6 Click OK to close the data base.

7 Check whether the phases are properly defined (according to the information given before)
and start the calculation.
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15.9  Results
The Curve generator feature is particularly useful for dynamics analysis. You can easily display
the actual loading versus time (input) and also displacements, velocities and accelerations of the
pre-selected points versus time. The evolution of the defined multipliers with time can be plotted
by assigning Dynamic time to the x-axis and uy to the y-axis.

Figure 15–9 (p. 241) shows the response of the pre-selected points at the surface of the
structure. It can be seen that even with no damping, the waves are dissipated which can be
attributed to the geometric damping.

Figure 15–9: Vertical displacement vs time on the surface at
different distances to the vibrating source (without damping)

The presence of damping is clear in Figure 15–10 (p. 242).
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Figure 15–10: Vertical displacement vs time on the surface
at different distances to the vibrating source (with damping)

It can be seen that the vibration is totally seized when some time is elapsed after the removal of
the force (at t = 0.5 s). Also, the displacement amplitudes are lower. Compare the curves without
and with damping.

It is possible in the Output program to display displacements, velocities and accelerations at a
particular time, by choosing the appropriate option in the Deformations menu. Figure 15–11 (p.
242) shows the total accelerations in the soil at the end of phase 2 (t = 0.5 s).

Figure 15–11: Acceleration (|a|) in the soil at the end of phase 2 (with damping)
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16
Pile driving [ULT]

16.1  Introduction
Pile driving is a dynamic process that causes vibrations in the surrounding soil. Moreover,
excess pore pressures are generated due to the quick stress increase around the pile.

In this example focus is put on the irreversible deformations below the pile. In order to simulate
this process most realistically, the behaviour of the sand layer is modelled by means of the
Hardening Soil model with small-strain stiffness.

16.2  Geometry
This example involves driving a concrete pile through an 11 m thick clay layer into a sand layer.
The pile has a diameter of 0.4 m which is displayed in Figure 16–1 (p. 244).
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11 m

7 m

Clay

Sand

Pile Ø 0.4 m

Figure 16–1: Pile driving situation

16.3  Create new project
To create the new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet select the Axisymmetry option for Model and keep the default option
for Elements (15-Noded).

4 Keep the default values for units and constants and set the model Contour to xmin = 0 m,
xmax = 30 m, ymin = 0 m and ymax = 18 m.
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16.4  Define the soil stratigraphy
The subsoil is divided into an 11 m thick clay layer and a 7 m thick sand layer. The phreatic level
is assumed to be at the ground surface. Hydrostatic pore pressures are generated in the whole
geometry according to this phreatic line. To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

2 Create two soil layers extending from y = 18 to y = 7 and from y = 7 to y = 0.

3 Set the Head in the borehole at 18 m.

16.5  Create and assign material data sets
The clay layer is modelled with the Mohr-Coulomb model. The behaviour is considered to be
Undrained (B). An interface strength reduction factor is used to simulate the reduced friction
along the pile shaft.

In order to model the non-linear deformations below the tip of the pile in a right way, the sand
layer is modelled by means of the Hardening Soil model with small-strain stiffness. Because
of the fast loading process, the sand layer is also considered to behave undrained. The short
interface in the sand layer does not represent soil-structure interaction. As a result, the interface
strength reduction factor should be taken equal to unity (rigid).

The layers have the following properties:

Table 16–1: Material properties of the clay layer and the pile

Parameter Name Clay Pile Unit

General

Soil model Model Mohr-
Coulomb Linear elastic -

Drainage type Type Undrained (B) Non-porous -

Unsaturated unit weight γunsat 16 24 kN/m3

Saturated unit weight γsat 18 - kN/m3

Mechanical

Young's modulus (constant) E'ref 5.0·103 30·106 kN/m2

Poisson's ratio ν 0.3 0.1 -

Young's modulus increment E'inc 1.0·103 - kN/m2

Reference level yref 18 - m

Undrained shear strength su,ref 5.0 - kN/m2

Undrained shear strength increment su,inc 3 - kN/m3

Reference level yref 18 - m

16.4 Define the soil stratigraphy   |  245



Mechanical

Cohesion c'ref- - - kN/m2

Interface
Strength determination Type Manual Rigid -

Interface reduction factor Rinter 0.5 1.0 -

Initial
K0 determination - Automatic Automatic -

Lateral earth pressure coefficient K0,x 0.5000 0.5000 -

Table 16–2: Material properties of the sand layer

Parameter Name Sand Unit

General
Soil model Model HS small -

Drainage type Type Undrained (A) -

Unsaturated unit weight γunsat 17 kN/m3

Saturated unit weight γsat 20 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 50·103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 50·103 kN/m2

Unloading / reloading stiffness Eur 
ref 150·103 kN/m2

Poisson's ratio νur 0.2 -

Power for stress-level dependency
of stiffness m 0.5 -

Shear modulus at very small strains G0 ref 120·103 kN/m2

Shear strain at which Gs = 0.722 G0 γ0.7 0.1·10-3 -

Cohesion c'ref 0 kN/m2

Friction angle φ' 31 °

Dilatancy angle ψ 0 °

Interface
Strength determination - Rigid -
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Initial
K0 determination - Automatic -

 Create the material data sets according to Table 16–1 (p. 245) and Table 16–2 (p. 246)

16.6  Define the structural elements
The pile is defined as a column of 0.2 m width. The Interface elements are placed along the pile
to model the interaction between the pile and the soil. The interface should be extended to about
half a meter into the sand layer. Note that the interface should be defined only at the side of the
soil. A proper modelling of the pile-soil interaction is important to include the material damping
caused by the sliding of the soil along the pile during penetration and to allow for sufficient
flexibility around the pile tip.

Tip:  Use the Zoom in feature to create the pile and the interface.

Clay

Sand

Interface

Extended interface

(0.2, 6.6)

(0.2, 7.0)
(0.0, 7.0)

Pile

Figure 16–2: Extended interface

16.6.1  Define the pile
To define the concrete pile:

1 Click the Structures tab to proceed with the input of structural elements in the Structures
mode .

2 Select the Create line feature  in the side toolbar and draw a line from (0.2 6.6) to (0.2 18).

3  Assign a negative interface to the line to model the interaction of the pile with the
surrounding soil.

The pile is made of concrete, which is modelled by means of the linear elastic model
considering non-porous behaviour. In the beginning, the pile is not present, so initially the
clay properties are present in the area the represents the pile.
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16.6.2  Define a load
In order to model the driving force, a distributed unit load is created on top of the pile. To create
a dynamic load:

1  Define a distributed load by clicking on Create load > Create line load from the tool bar
and then on (0 18.0) and (0.2 18.0).

2 The load components will be defined in the Selection explorer. Note that the static
component of the load will not be used in this project. The program will neglect the static
components of the load if it (static load) is not activated.

3 Expand the Dynamic load subtree and specify a unit load in the gravity direction.

4 Click the Multiplier_y drop down menu and click on the appearing plus button .

The Multipliers window pops up and a new load multiplier is automatically added.

5 Define a Harmonic signal with an Amplitude of 5000, a Phase of 0° and a Frequency of
50 Hz and as shown in Figure 16–3 (p. 248) . During the pile driving phase, we will only
consider half a cycle (0.01 s) of this signal.

Figure 16–3: Definition of an Harmonic multiplier

Tip:

Note that dynamic multipliers can be defined by right-clicking the Dynamic
multipliers subtree under Attributes library in the Model explorer.

Note that dynamic multipliers are attributes and as such it is possible to define them
in all the program's modes.

The final geometry model is shown in Figure 16–4 (p. 249):
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Figure 16–4: The geometry model

16.7  Generate the mesh
1 Proceed to the Mesh- mode .

2 Click the Generate mesh button  to generate the mesh. Use the default option for the
Element distribution parameter (Medium).

3 Click the View mesh button  to view the mesh shown in Figure 16–5 (p. 249).

The resulting mesh is shown. Note that the mesh is automatically refined under the footing.

Figure 16–5: The generated mesh
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4 Click the Close tab to close the Output program.

16.8  Define and perform the calculation
The calculation consists of 3 phases. In the Initial phase, the initial stress conditions are
generated. In the Phase 1 the pile is created. In the Phase 2 the pile is subjected to a single
stroke, which is simulated by activating half a harmonic cycle of load. In the Phase 3 the load is
kept zero and the dynamic response of the pile and soil is analysed in time. The last two phases
involve dynamics calculations.

16.8.1  Initial phase
Initial effective stresses are generated by the K0 procedure, using the default values. Note that
in the initial situation the pile does not exist and that the clay properties should be assigned
to the corresponding cluster. The phreatic level is assumed to be at the ground surface.
Hydrostatic pore pressures are generated in the whole geometry according to this phreatic line.

16.8.2  Phase 1: Pile activation
1 Click the Add phase button  to create a new phase.

2 In the General subtree in the Phases window, the Plastic option is selected as Calculation
type.

3 The Staged construction option is by default selected as Loading type.

4 In the Staged construction mode assign the pile properties to the pile cluster.

5 Activate the interface in the Clay layer only. The model for the Phase 1 in the Staged
construction mode is displayed in Figure 16–6 (p. 250).

Figure 16–6: Configuration of Phase 1 in the Staged construction mode
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16.8.3  Phase 2: Pile driving
1 Click the Add phase button  to create a new phase.

2 In the General subtree in the Phases window, select the Dynamic option as Calculation
type.

3 Set the Dynamic time interval to 0.01 s.

4 In the Deformation control parameters subtree select Reset displacements to zero.

5 In the Staged construction mode activate the dynamic component of the distributed load.

The activated dynamic component of the load in Selection explorer is shown in Figure 16–7
(p. 251) .

Figure 16–7: The dynamic load component in the Selection explorer
6 Expand the subtree Model explorer > Model conditions > Dynamics is shown in Figure 16–8

(p. 252) .
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Figure 16–8: Boundary conditions for dynamics calculations
7 Specify viscous boundaries at xmax and ymin.

The result of this phase is half a harmonic cycle of the external load. At the end of this phase,
the load is back to zero.

16.8.4  Phase 3: Fading
1 Click the Add phase button  to create a new phase.

2 In the General subtree in the Phases window, select the Dynamic option as Calculation
type.

3 Set the Dynamic time interval to 0.19 s.

4 In the Staged construction mode deactivate the dynamic load.

16.8.5  Execute the calculation
1 Click the Select points for curves button in the side toolbar and select a node at the top

of the pile for load displacement curves.

2 Click the Calculate button  to calculate the project.

3 After the calculation has finished, save the project by clicking the Save button .
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16.9  Results
Figure 16–9 (p. 253) shows the settlement of the pile (top point) versus time. From this figure
the following observations can be made:
● The maximum vertical settlement of the pile top due to this single stroke is almost 14 mm.

However, the final settlement is about 9.5 mm.
● Most of the settlement occurs in phase 3 after the stroke has ended. This is due to the fact

that the compression wave is still propagating downwards in the pile, causing additional
settlements.

● Despite the absence of Rayleigh damping, the vibration of the pile is damped due to soil
plasticity and the fact that wave energy is absorbed at the model boundaries.

Figure 16–9: Pile settlement vs. time

When looking at the output of the second calculation phase (t = 0.01 s, i.e. just after the stroke),
it can be seen that large excess pore pressures occur very locally around the pile tip. This
reduces the shear strength of the soil and contributes to the penetration of the pile into the
sand layer. The excess pore pressures remain also in the third phase since consolidation is not
considered.

Figure 16–10 (p. 254) shows the shear stresses in the interface elements at t = 0.01 s. The plot
shows that the maximum shear stress is reached all along the pile, which indicates that the soil
is sliding along the pile.
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Figure 16–10: Maximum shear stresses in the interface at t = 0.01 s

When looking at the deformed mesh of the last calculation phase (t = 0.2 s), it can also be seen
that the final settlement of the pile is about 9.5 mm. In order to see the whole dynamic process
it is suggested to use the option Create Animation to view a 'movie' of the deformed mesh in
time. You may notice that the first part of the animation is slower than the second part.
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17
Free vibration and earthquake

analysis of a building [ULT]

17.1  Introduction
This example demonstrates the natural frequency of a five-storey building when subjected to
free vibration and earthquake loading. The two calculations employ different dynamic boundary
conditions:
● In the free vibration, the Viscous boundary conditions are considered. This option is suitable

for problems where the dynamic source is inside the mesh.
● For the earthquake loading, the Free-field and Compliant base boundary conditions are

considered. This option is preferred for earthquake analysis, where the dynamic input is
applied at the bottom of the model.

Objectives
● Performing a Dynamic calculation
● Defining dynamic boundary conditions (free-field, compliant base and viscous)
● Defining earthquakes by means of dynamic multipliers
● Modelling free vibration of structures
● Modelling hysteretic behaviour by means of Hardening Soil model with small-strain stiffness
● Evaluating the natural frequency from Fourier spectrum
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17.2  Geometry
The building consists of 5 floors and a basement. It is 10 m wide and 17 m high including
basement. The total height from the ground level is 5 x 3 m = 15 m and the basement is 2 m
deep. A value of 5 kN/m2 is taken as the weight of the floors and the walls. The building is
constructed on a rather loose sand of 15 m depth underlain by a deep denser sand layer. In the
model, 25 m of the deep sand layer will be considered as shown in Figure 17–1 (p. 256).

15 m

2 m

y

x

25 m

15 m

75 7510

Figure 17–1: Geometry of the project

17.3  Create new project
To create the new project, follow these steps:

1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet keep the default options for Model (Plane strain) and Elements (15-
Noded).

4 Keep the default units and constants and set the model Contour to xmin = -80 m, xmax = 80
m, ymin = -40 m and ymax = 15 m.

17.2 Geometry  |  256



17.4  Define the soil stratigraphy
The subsoil is divided into a 15 m thick rather loose sand layer and a 25 m thick medium dense
sand layer. The phreatic level is assumed to be at y = -15 m. Hydrostatic pore pressures are
generated in the whole geometry according to this phreatic line.

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

2 Add two soil layers extending from y = 0 to y = -15 and from y = -15 to y = -40.

3 Set the Head in the borehole at -15 m.

17.5  Create and assign material data sets
The upper layer consists of rather loose sand and the lower one is a medium dense sand.
Both have Hardening Soil model with small-strain stiffness properties. The presence of the
groundwater is neglected. The soil layers with Hardening Soil model with small-strain stiffness
properties have inherent hysteretic damping.
●

 Open the Material sets window.
● Create data sets under Soil and interfaces set type according to the information given in

Table 17–1 (p. 257).
● Assign the material datasets to the corresponding soil layers in the borehole.

Table 17–1: Material properties

Parameter Name Upper
sand layer

Lower
sand layer Unit

General
Soil model - HS small HS small -

Drainage type - Drained Drained -

Unsaturated unit weight γunsat 16 20 kN/m3

Saturated unit weight γsat 20 20 kN/m3

Mechanical
Secant stiffness in standard drained
triaxial test E50 ref 20·103 30·103 kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 26·103 36·103 kN/m2

Unloading / reloading stiffness Eur 
ref 95·103 110·103 kN/m2

Poisson's ratio ν'ur 0.2 0.2 -
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Mechanical
Power for stress-level dependency
of stiffness m 0.5 0.5 -

Shear modulus at very small strains G0 ref 270·103 100·103 kN/m2

Shear strain at which Gs = 0.722 G0 γ0.7 0.15·10-3 0.1·10-3 -

Cohesion c'ref 10 5 kN/m2

Friction angle φ' 31 28 °

Dilatancy angle ψ 0 0 °

When subjected to cyclic shear loading, the Hardening Soil model with small-strain stiffness will
show typical hysteretic behaviour. Starting from the small-strain shear stiffness, G0 ref, the actual
stiffness will decrease with increasing shear. The figures below display the Modulus reduction
curves, i.e. the decay of the shear modulus with strain. Figure 17–2 (p. 258) shows the secant
shear modulus and Figure 17–3 (p. 259) shows the tangent shear modulus.

Figure 17–2: Modulus reduction curves for the upper sand layer
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Figure 17–3: Modulus reduction curve for the lower sand layer

In the Hardening Soil model with small-strain stiffness, the tangent shear modulus is bound by a
lower limit, Gur.

The values of Gur 
ref for the Upper sand layer and Lower sand layer and the ratio to G0 ref are

shown in Table 17–2 (p. 259) . This ratio determines the maximum damping ratio that can be
obtained.

Table 17–2: Gur values and ratio to G0 ref

Parameter Upper sand layer Lower sand layer Unit

Gur 39.103 45.103 kN/m2

G0 ref/Gur 6.82 2.18 -

Figure 17–4 (p. 260) and Figure 17–5 (p. 260) show the damping ratio as a function of the
shear strain for the material used in the model. A more detailed description about the modulus
reduction curve to the damping curve can be found in the literature.6

6 Brinkgreve, R.B.J., Kappert, M.H., Bonnier, P.G. (2007). Hysteretic damping in small-strain
stiffness model. In Proc. 10th Int. Conf. on Comp. Methods and Advances in Geomechanics.
Rhodes, Greece, 737-742.
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Figure 17–4: Damping curve for the upper sand layer

Figure 17–5: Damping curve for the lower sand layer

17.6  Define the structural elements
The structural elements of the model are defined in the Structures mode.
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17.6.1  Define the building
The building consists of 5 floors and a basement. It is 10 m wide and 17 m high including the
basement. A value of 5 kN/m2 is taken as the weight of the floors and the walls. The total height
from the ground level is 5 x 3 m = 15 m and the basement is 2 m deep.

The plates, representing the walls and the floors in the building, are considered to be linear
elastic. Note that two different material datasets are used, one for the basement and the other
for the rest of the building. The physical damping in the building is simulated by means of
Rayleigh damping. A description of Rayleigh damping parameters is given in the Reference
Manual.

Table 17–3: Material properties of the building (plate properties)

Parameter Name Building Basement Unit

General
Material type - Elastic Elastic -

Weight w 10 20 kN/m/m

Input method - Direct Direct -

Rayleigh α - 0.2320 0.2320 -

Rayleigh β - 8.0·10-3 8.0·10-3 -

Prevent punching - No No -

Mechanical
Isotropic - Yes Yes -

Axial stiffness EA1 9·106 12·106 kN/m

Bending stiffness EI 67.5·103 160·103 kNm2/m

Poisson's ratio ν 0 0 -

Table 17–4: Material properties of the node-to-node anchor

Parameter Name Column Unit
Material type Type Elastic -

Out-of-plane spacing Lspacing 3 m

Axial stiffness EA 2.5· 106 kN

1  Use plates to create the vertical walls of the building from (-5 0) to (-5 15) and from (5
0) to (5 15).

2 Again with plates, now define the vertical walls of the basement from (-5 -2) to (-5 0) and
from (5 -2) to (5 0).

3 Define the basement and ground level of the building as plates from (-5 -2) to (5 -2) and
from (-5 0) to (5 0).
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4 Define the floors by copying the basement floor 5 times. To do so, select the basement
floor and choose the Array button . Now specify that we want to copy it in y-direction, 6
copies (be aware: number of copies includes the original) and an intermediate distance of
3 m.

5  Define the material datasets for the structural elements in the building according to
Table 17–3 (p. 261).

6 Assign the Basement material dataset to the vertical plates (2) and the lowest horizontal
plate (all below ground level) in the model.

7 Assign the Building material dataset to the remaining plates in the model.

8  Use the Node-to-node anchor feature to define the column at the centre of the building
connecting consecutive floors, hence (0 -2) to (0 0), (0 0) to (0 3), (0 3) to (0 6), (0 6) to
(0 9), (0 9) to (0 12) and (0 12) to (0 15). Of course this can also be done by drawing one
column and use the Array function to copy the others.

9 Define the properties of the anchor according to Table 17–4 (p. 261) and assign the
material dataset to the anchors in the model.

10  Define an interface to model the interaction between soil and the building.

17.6.2  Define the loads
1 In order to model the driving force, a point load is created on top of the pile. To create a

dynamic load:

a.  Create a point load at the top left corner of the building.
b. Set Fx,ref = 10 kN/m and Fy,ref = 0 kN/m.

2 The earthquake is modelled by imposing a prescribed displacement at the bottom boundary.
To define the prescribed displacement:

a.  Define a line displacement at the bottom of the model, from (-80 -40) to (80 -40).
b. Set the x-component of the line displacement to Prescribed and assign a value of 1.0.

The y-component of the line displacement is Fixed. The default distribution (Uniform)
should be kept.

3 To define the dynamic multipliers for the line displacement:

a. Expand the Dynamic line displacement.
b. Click the Multiplier_x drop down menu and click on the appearing plus button . The

Multipliers window pops up and a new displacement multiplier is automatically added.
c. From the Signal drop-down menu select the Table option.
d. The file containing the earthquake data is available in Bentley Communities: search for

the tutorial Free vibration and earthquake analysis of a building. Download the earthquake
signal file 225a.smc.

e. In the Multipliers window click the Open button. In the appearing window change in the
drop-down menu Plain text files *.txt to Strong motion CD-ROM files option and select
the appearing downloaded .smc file.

f. Select the Acceleration option in the Data type drop-down menu.
g. Select the Drift correction options and click OK to finalize the definition of the multiplier.

The defined multiplier is displayed in Figure 17–6 (p. 263) :
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Figure 17–6: Dynamic multipliers window

17.6.3  Create interfaces on the boundary
Free-field and Compliant base boundaries require the creation of interface elements along the
vertical and bottom boundaries of the model in the Structures mode. The interface elements
must be added inside the model, else the Free-field and Compliant base boundary conditions
are ignored. To define the interfaces:

 Click the Create interfaces on the boundary button to automatically generate the interfaces
at the boundary of the model.

The geometry of the model is shown in Figure 17–7 (p. 263) :

Figure 17–7: Geometry of the model
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17.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Reset the mesh refinement on the boundaries by changing the Coarseness factor on the
boundaries to 1.

3 Select both soil layers and set their Coarseness factor to 0.3.

4 Click the Generate mesh button  to generate the mesh. Set the Element distribution to
Medium.

5 Click the View mesh button  to view the mesh.

The resulting mesh is shown in Figure 17–8 (p. 264).:

Figure 17–8: The generated mesh
6 Click the Close tab to close the Output program.

17.8  Define and perform the calculation
The calculation process consists of the initial conditions phase, simulation of the construction of
the building, loading, free vibration analysis and earthquake analysis.

17.8.1  Initial phase
1 Click on the Staged construction tab to proceed with definition of the calculation phases.

2 The initial phase has already been introduced. The default settings of the initial phase will be
used in this tutorial.

3 In the Staged construction mode check that the building and load are inactive.

4 The model for the initial phase is shown in Figure 17–9 (p. 265).
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Figure 17–9: Initial phase

17.8.2  Phase 1: Building
1 Click the Add phase button  to create a new phase. The default settings of the added

phase will be used for this calculation phase.

2 In the Staged construction mode construct the building (activate all the plates, the anchors
and only the interfaces of the basement) and deactivate the basement volume.

3 The model for phase 1 is shown in Figure 17–10 (p. 265).

Figure 17–10: Construction of the building

17.8.3  Phase 2: Excitation
1 Click the Add phase button  to create a new phase (Phase_2).

2 In the Phases window select the Reset displacement to zero in the Deformation control
parameters subtree. The default values of the remaining parameters will be used in this
calculation phase.

3 In the Staged construction mode activate the load. The value of the load is already defined
in the Structures mode .

17.8.4  Phase 3: Free vibration
1 Click the Add phase button  to create a new phase (Phase_3).
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2 In the Phases window select the Dynamic option  as Calculation type.

3 Set the Dynamic time interval parameter to 5 sec.

4 In the Staged construction mode release (deactivate) the point load.

5 In the Model explorer expand the Model conditions subtree.

6 Expand the Dynamics subtree. Check the boundary conditions BoundaryXMin,
BoundaryXMax and BoundaryYMin are viscous which is shown in Figure 17–11 (p. 266).

Figure 17–11: Boundary conditions for dynamics calculations

Note:

For a better visualisation of the results, animations of the free vibration and earthquake
can be created. If animations are to be created, it is advised to increase the number of
the saved steps by assigning a proper value to the Max steps saved parameter in the
Parameters tabsheet of the Phases window.

17.8.5  Phase 4: Earthquake
1 Click the Add phase button  to create a new phase (Phase_4).

2 In the Phases window set the Start from phase option to Phase 1 (construction of
building).

3  As Calculation type, select the Dynamic option.
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4 Set the Dynamic time interval parameter to 20 sec.

5 In the Deformation control parameters subtree, select the Reset displacement to zero.

6 In the Numerical control parameters subtree uncheck the Use default iter parameters
checkbox.

7 Set the Max steps to 1000.

8 Set the Time step determination to Manual and the  Number of sub steps to 4 in order to
get a more detailed time-acceleration curve.

Note:
● The dynamic time interval is set to 20 seconds with a time interval of 0.005

seconds which gives 20/0.005=4000. So 4000 steps are required for the
calculation. Therefore, the Max steps is set to 1000 and the Number of sub
steps is set to 4. However, the automatic time stepping suggests smaller time
steps due to one or two relatively small elements, which requires a sensitivity
analysis for the time step size. For more information on time step for dynamic
calculations please visit Bentley communities.

● For more information on drift correction and input signal please visit Bentley
communities.

9 In the Model explorer expand the Model conditions subtree.

10 Expand the Dynamics subtree. Set the BoundaryXMin and BoundaryXMax to Free-field.
Set the BoundaryYMin to Compliant base as shown in Figure 17–12 (p. 267).

Figure 17–12: Boundary conditions for dynamics calculations (Phase_4)
11 Interface elements do not need to be active to enable the use of Free-field or Compliant

base boundaries.
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12 In the Model explorer activate the Line displacements and its dynamic component. Make
sure that the value of ux,start,ref is set to 0.5 m. Considering that the boundary condition at
the base of the model will be defined using a Compliant base, the input signal has to be
taken as half of the bedrock (within) motion.

17.8.6  Execute the calculation
1 Click the Select points for curves button in the side toolbar and select a point at the top

of the building, close to or at (0 15).

2 Click the Calculate button  to calculate the project.

3 After the calculation has finished, save the project by clicking the Save button .

17.9  Results
Figure 17–13 (p. 268) shows the deformed structure at the end of the Phase 2 (application of
horizontal load).

Figure 17–13: Deformed structure in phase 2

Figure 17–14 (p. 269) shows the time history of displacements of the selected points A (0 15)
for the free vibration phase. It may be seen from the figure that the vibration slowly decays with
time due to damping in the soil and in the building.
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Figure 17–14: Time history of displacements at selected points

In the Fourier tabsheet of the Curve generation window select the Power (spectrum) > Total
displacements > Ux and click OK to create the plot. The plot is shown in Figure 17–15 (p. 269).
From this figure it can be evaluated that the dominant building frequency is around 1 Hz.

Figure 17–15: Frequency representation (spectrum)
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Figure 17–16 (p. 270) shows the time history of the lateral acceleration of the selected point
at (0 15) for the earthquake phase (dynamic analysis). For a better visualisation of the results
animations of the free vibration and earthquake can be created.

Figure 17–16: Variation of acceleration in dynamic time
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18
Thermal expansion of a navigable lock

[ULT]

18.1  Introduction
A navigable lock is temporarily 'empty' due to maintenance. After some time there is significant
increase of the air temperature, which causes thermal expansion of the inner side of the
lock, while the soil-side of the concrete block remains relatively cold. This leads to backward
bending of the wall and, consequently, to increased lateral stress in the soil behind the wall and
increased bending moments in the wall itself.

Objectives
This example demonstrates the use of the Thermal module to analyse this kind of situations.
● Defining a thermal temperature function
● Use of thermal expansion
● Performing a fully coupled analysis for THM calculation
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18.2  Geometry
The geometry of the project is shown in Figure 18–1 (p. 272).

Excavation

Sand

Concrete lock
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Figure 18–1: Geometry of the project

18.3  Create new project
1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet, the default options for Model and Elements are used for this project.
Also the default options for the units are used in this tutorial.

4 Set the model Contour to xmin = 0 m, xmax = 25 m, ymin = -16 m and ymax = 0 m.

5 Click OK to close the Project properties window.

18.4  Define the soil stratigraphy
To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up.

2 Create a single soil layer with top level at 0.0 m and bottom level at -16 m. Set the head at -4
m.

18.5  Create and assign material data sets
Two data sets need to be created; one for the sand layer and one for the concrete block.
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1.  Open the Material sets window.
2. Define a data set for the Sand layer with the parameters given in Table 18–1 (p. 273), for the

General, Mechanical, Groundwater, Thermal, Interfaces and Initial tabsheets.
3. Create another dataset for Concrete according to Table 18–1 (p. 273).
4. Assign the material dataset Sand to the borehole soil layer.

Table 18–1: Material properties

Parameter Name Sand Concrete Unit

General
Soil model - HS small Linear elastic -

Drainage type - Drained Non-porous -

Unsaturated unit weight γunsat 20 24 kN/m3

Saturated unit weight γsat 20 - kN/m3

Mechanical

Young's modulus Eref - 25· 106 kN/m2

Poisson's ratio ν - 0.15 -

Secant stiffness in standard drained
triaxial test E50 ref 40· 103 - kN/m2

Tangent stiffness for primary
oedometer loading Eoed ref 40· 103 - kN/m2

Unloading / reloading stiffness Eur 
ref 1.2· 105 - kN/m2

Power for stress-level dependency
of stiffness m 0.5 - -

Shear modulus at very small strains G0 ref 80· 103 - kN/m2

Shear strain at which Gs = 0.722 G0 γ0.7 0.1· 10-3 - -

Cohesion c'ref 2 - kN/m2

Friction angle φ' 32 - °

Dilatancy angle ψ 2 - °

Groundwater
Data set - USDA - -

Model - Van
Genuchten - -

Soil - Type - Sand - -

Flow parameters - Use defaults - From data set - -

Thermal

Specific heat capacity cs 860 900 kJ/t/K
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Thermal

Thermal conductivity λs 4·10-3 1·10-3 kW/m/K

Soil density ρs 2.6 2.5 t/m3

Thermal expansion type - Isotropic Isotropic -

Volumetric Thermal expansion αsv 1.5.10-6 0.03.10-3 1/K

Interfaces
Strength determination - Rigid Manual -

Interface reduction factor Rinter 1.0 0.67 -

Initial
K0 determination - Automatic Automatic -

18.6  Define the structural elements
The lock will be modelled as a concrete block during the staged construction.

1 Proceed to Structures mode .

2
Click the Create soil polygon button in the side toolbar and select the Create soil
polygon option.

3 Define the lock in the drawing area by clicking on (0 -5), (5 -5), (5 0), (5.5 0), (6 -6), (0 -6)
and (0 -5).

Tip:

The Snapping options can be selected, and the Spacing can be set to 0.5 to easily
create the polygon.

The Concrete material will be assigned later in the Staged construction.

4 Click the Create line button  in the side toolbar.

5 Select the Create thermal flow bc option in the expanded menu.

6 Create thermal boundaries at vertical boundaries and the bottom boundary (Xmin, Xmax and
Ymin).

7 The vertical boundaries have the default option of Closed for the Behaviour.

8 Select the bottom boundary, in the Selection explorer set the Behaviour to Temperature.

9
Set the reference temperature, Tref to 283.4 K which is shown in Figure 18–2 (p. 275).
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Figure 18–2: Thermal boundary condition in the Selection explorer
The geometry of the model is now complete as shown in Figure 18–3 (p. 275) .

Figure 18–3: Geometry of the model

18.7  Generate the mesh
1 Proceed to the Mesh mode .

2 Select the polygon representing the concrete block, and in the Selection explorer set the
Coarseness factor to 0.25.

3 Click the Generate mesh button  to generate the mesh. The default element distribution of
Medium is used for this example.

4 Click the View mesh button  to view the mesh.

The resulting mesh is shown is shown in Figure 18–4 (p. 276):
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Figure 18–4: The generated mesh
5 Click the Close tab to close the Output program.

18.8  Define and perform the calculation
The calculations for this tutorial is carried out in three phases. The concrete lock is activated
in a plastic calculation, after which the temperature increase is defined as a fully coupled flow
deformation analysis.

18.8.1  Initial phase
1 Click on the Staged construction tab to proceed with the definition of the calculation

phases.

2 Double-click on Initial phase in the Phases explorer.

3 The default options for Calculation type and Pore pressure calculation type are used in this
example.

4 Select Earth gradient for the Thermal calculation type option and close the Phases
window.

5 In the Staged construction activate the ThermalFlow under the Model conditions subtree
and set the value for Tref to 283 K. The default values for href and Earth gradient are valid.
The Thermal flow parameters are shown in Figure 18–5 (p. 277) and the model for initial
phase is shown in Figure 18–6 (p. 277).
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Figure 18–5: Thermal flow in the Model explorer

Figure 18–6: Initial phase

18.8.2  Phase 1: Construction
1 Click the Add phase button  to create a new phase (Phase_1).

2 Double-click on Phase_1 in the Phases explorer.

3 In the Phases window, enter an appropriate name for the phase ID and select Steady state
groundwater flow  as Pore pressure calculation type.

4 Set the Steady state thermal flow  for the Thermal calculation type.

5 Make sure that the Reset displacements to zero and Ignore suction options are selected.
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6 In the Staged construction mode, assign the Concrete dataset to the created polygon
which represents the navigable lock as shown in Figure 18–7 (p. 278).

Figure 18–7: Concrete set as material for polygon
7 Right click the soil cluster which is cut-off by the polygon and select the option Deactivate

 from the appearing menu.

8 In the Selection explorer, set the WaterConditions of this cluster to Dry.

9 In the Model explorer, activate all the Thermal flow boundary conditions.

10 In the Model explorer, activate the Model conditions > Climate condition.

11 Set the Air temperature to 283 K and the Surface transfer to 1 kW/m2/K as shown in
Figure 18–8 (p. 279).

This will define the thermal conditions at the ground surface and the inside of the lock.
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Figure 18–8: Model conditions for Phase_1
12 Deactivate the ThermalFlow option. This is because the thermal flow boundary conditions,

including climate condition, are used in a steady state thermal flow calculation, instead of
the earth gradient option.

Figure 18–9 (p. 279) shows the model at the end of Phase_1.

Figure 18–9: The model at the end of Phase_1

18.8.3  Phase 2: Heating
1 Click the Add phase button  to create a new phase (Phase_2).

2 Double-click on Phase_2 in the Phases explorer.
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3 Set the Calculation type to Fully coupled flow deformation .

4 The Thermal calculation type is set to Use temperatures from previous phase . This is
to indicate that temperature needs to be considered and that the initial temperature is taken
from the previous phase.

5 The Time interval is set to 10 days.

6 Make sure that the Reset displacements to zero and Reset small strain options are selected
in the Deformation control parameters subtree. The Ignore suction option is unchecked by
default.

7 A temperature function is defined for the Time dependency in Climate which is used for this
phase. Follow these steps to create a temperature function.

a. Right-click the Thermal functions option in the Attributes library in the Model explorer
and select Edit option in the appearing menu.

The Thermal functions window is displayed.
b. In the Temperature functions tabsheet add a new function by clicking on the

corresponding button . The new function is highlighted in the list and options to define
the function are displayed.

c. The default option of Harmonic is used for this signal.
d. Assign a value of 15 for the Amplitude and 40 days for the Period.

A graph is displayed in Figure 18–10 (p. 280) showing the defined function. Since the
time interval of the phase is 10 days, only a quarter of a temperature cycle is considered
in this phase, which means that after 10 days the temperature has increased by 15 K.

Figure 18–10: The temperature function
e. Click OK to close the Thermal functions window.

8 Expand the subtree Model conditions in the Model explorer shown in Figure 18–11 (p.
281).
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9 In the Climate option, set the Time dependency to Time dependent and assign the
temperature function which was created.

Figure 18–11: Model conditions for Phase_2
The calculation definition is now complete.

18.8.4  Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later
generation of curves.

1 Click the Select points for curves button in the side toolbar and select some
characteristic points for curves (for example at the top of the excavation, (5.0, 0.0)).

2 Click the Calculate button  to calculate the project, a warning regarding different stress
type used in the Fully coupled flow deformation analysis will appear. This warning appears
because the Fully coupled flow deformation analysis always calculates with suction while
the other calculation types by default do not calculate suction, and mixing phases with
and without suction may lead to unexpected results. However, since in this tutorial we are
dealing with sand the influence of suction will be very small and thus the warning can be
ignored.

3 After the calculation has finished, save the project by clicking the Save button .

18.9  Results
In the Phases explorer, select the Initial phase and click the View calculation results button on
the toolbar. In the Output program, select the menu Stresses > Heat flow > Temperature.

Figure 18–12 (p. 282) shows the initial temperature distribution, which is obtained from the
reference temperature at the ground surface and the earth gradient. This gives a temperature of
283.0 K at the ground surface and 283.4 at the bottom of the model.
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Figure 18–12: Initial temperature distribution

Figure 18–13 (p. 282) shows the temperature distribution obtained from Phase_1 using a
steady-state thermal flow calculation. In fact, the temperatures at the top and bottom are equal
to the temperatures as defined in the Initial phase; however, since the temperature at the ground
surface is now defined in terms of Climate conditions (air temperature), this temperature is also
applied at the inner side of the lock and affects the temperature distribution in the ground.

Figure 18–13: Steady-state temperature distribution in Phase_1

The most interesting results are obtained in Phase_2 in which the air temperature in the Climate
condition increases gradually from 283 K to 298 K (defined by a quarter of a harmonic cycle
with an amplitude of 15K). Figure 18–14 (p. 283) shows the temperature at the ground surface
as a function of time.
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Figure 18–14: Temperature distribution in Point A as a function of time

As a result of the short increase in temperature at the inside of the concrete block, while the
outer side (soil side) remains 'cold', the wall will bend towards the soil. Figure 18–15 (p. 283)
shows the deformed mesh at the end of Phase_2.

Figure 18–15: Deformed mesh at the end of Phase_2

As a result of this backward bending, the lateral stresses in the soil right behind the concrete
block will increase, tending towards a passive stress state.
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Figure 18–16: Effective principal stresses at the end of Phase_2 in the Principal directions

Note:
● Note that the visualisation is different for Figure 18–16 (p. 284), because it displays

the stresses in the porous materials. This can be changed in View > Settings on the
tab Results (see the Reference Manual for more information).

● Note that Figure 18–16 (p. 284) shows the principal stresses for all stress points
whereas by default the principal stresses are only shown for the 3 center stress

points. This can be changed using the  and  buttons on the navigation bar.
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19
Freeze pipes in tunnel construction

[ULT]

19.1  Introduction
This tutorial illustrates change in coupling of groundwater flow and thermal flow as a result of
ground freezing. A tunnel is constructed with the use of freeze pipes. By first installing freeze
pipes in the soil, the soil freezes and becomes watertight so that tunnel construction can take
place. This method of construction requires a lot of energy for the cooling of the soil, so by
being able to model the cooling behaviour while groundwater flow is present an optimal freezing
system can be designed.

Objectives
● Modelling soil freezing, coupling between thermal flow and groundwater flow
● Modelling unfrozen water content.
● Using the command line for structure definition.
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19.2  Geometry
In this tutorial a tunnel with a radius of 3.0 m will be constructed in a 30 m deep soil layer. A
groundwater flow from left to right is present, influencing the thermal behaviour of the soil. First
the soil will be subjected to the low temperatures of the freeze pipes, and once the soil has
frozen sufficiently, tunnel construction can take place. The latter is not included in this tutorial.

Because groundwater flow causes an asymmetric temperature distribution, the whole geometry
needs to be modelled, where in previous examples only half of the geometry was sufficient. The
geometry of the project is shown in Figure 19–1 (p. 286).

Y

X

15 m

Radius = 3.0 m
45 m

90 m

30 m

Figure 19–1: Geometry of the project

19.3  Create new project
1 Start the Input program and select Start a new project from the Quick start dialog box.

2 In the Project tabsheet of the Project properties window, enter an appropriate title.

3 In the Model tabsheet, the default options for Model and Elements are used for this project.
Also the default options for the units are used in this tutorial. Note that the unit of Mass is set
automatically to tonnes.

4 Set the model Contour to xmin = -45 m, xmax = 45 m, ymin = -30 m and ymax = 0 m.

5 In the Constants tabsheet, set Twater and Tref to 283 K, other constants keep their default
values. A description of constants can be found in the Reference Manual.

6 Click OK to close the Project properties window.

19.4  Define the soil stratigraphy
To define the soil stratigraphy:

1 Click the Create borehole button  and create a borehole at x = 0.
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The Modify soil layers window pops up.

2 Create a single soil layer with top level at 0 m and bottom level at -30 m. Set the head at
ground level (0 m).

19.5  Create and assign material data sets
1. Click the Materials button  in the Modify soil layers window.
2. Define a data set for soil with the parameters given in Table 19–1 (p. 287), for the General

Parameters and Groundwater tabsheets.

Table 19–1: Material properties

Parameter Name Sand Unit

General
Soil model - Mohr-Coulomb -

Drainage type - Drained -

Unsaturated unit weight γunsat 18 kN/m3

Saturated unit weight γsat 18 kN/m3

Initial void ratio einit 0.5 -

Mechanical

Young's modulus E'  ref 100· 103 kN/m2

Poisson's ratio ν 0.3 -

Cohesion c'ref 0 kN/m2

Friction angle φ' 37 °

Dilatancy angle ψ 0 °

Groundwater
Classification type - Standard -

Soil - class - Medium -

Flow parameters - Use defaults - None -

Horizontal permeability kx 1 m/day

Vertical permeability ky 1 m/day

Thermal

Specific heat capacity cs 860 kJ/t/K

Thermal conductivity λs 4·10-3 kW/
m/K

Soil density ρs 2.6 t/m3
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Thermal
Thermal expansion type - Isotropic -

Thermal expansion αsv 0.015·10-3 1/K

Unfrozen water saturation method - User defined
(see table below) -

Interfaces
Strength determination - Rigid -

Thermal resistance factor Rthermal 0 m2K/
kW

Initial
K0 determination - Automatic -

To model the amount of (fluid) water available to flow through the soil at certain
temperatures, a curve for unfrozen water content needs to be determined by defining a
table with values for unfrozen water content at certain temperatures. The same curve can be
applied in other projects, hence the table can be saved and loaded into the soil properties of
other projects. For more information, refer to the Reference Manual.

3. Click the Thermal tab. Enter the values as given in Table 19–2 (p. 288) .

Table 19–2: Input for unfrozen water content curve for sand

# Temperature [K] Unfrozen water content [-]
1 273.0 1.00

2 272.0 0.99

3 271.6 0.96

4 271.4 0.90

5 271.3 0.81

6 271.0 0.38

7 270.8 0.15

8 270.6 0.06

9 270.2 0.02

10 269.5 0.00
4. Select the option User defined from the drop down menu for Unfrozen water content at the

bottom of the tabsheet.
5. Add rows to the table by clicking the Add row button . Complete the data using the values

given in Table 19–2 (p. 288).
6. Enter the values for Interfaces and Initial tabsheets as given in Table 19–1 (p. 287).
7. Click OK to close the dataset.
8. Assign the material dataset to the soil layer.
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Note:

The table can be saved by clicking the Save button in the table. The file must be given
an appropriate name. For convenience, save the file in the same folder as the project is
saved.

19.6  Define the structural elements
The freeze pipes are modelled by defining lines with a length similar to the freeze pipe diameter
(10 cm), containing a convective boundary condition. For simplicity, in this tutorial only 12
cooling elements are defined, while in reality more elements may be implemented in order to
achieve a sufficient share of frozen soil.

19.6.1  Define freeze pipes
1 Proceed to Structures mode .

2 Click the Create line button  in the side toolbar.

3 Click the command line and type line 0 -12.05 0 -11.95 Press Enter to create the first
freezing pipe. For more information regarding command line, see Reference Manual.

4 The remaining freeze pipes will be created by copying the first freeze pipe 12 times. To do
so select the line representing the freeze pipe that was just created.

5 From the side toolbar select the Create array option . Set the Array pattern to Polar as we
want to create a circle of freeze pipes, the Center point is (x y) = (0 -15), the Total number
of items is 12 (the original plus 11 copies) and finally the Angle to fill must be set to 360
degrees as we want to create a full circle. Press OK to create the 11 additional freeze pipes.

19.6.2  Define freeze pipes boundary conditions
PLAXIS 2D allows different types of Thermal boundary conditions to be applied. In this tutorial
the freeze pipes will be modelled as convective boundary conditions.

1 Multi select the 12 lines representing the freeze pipes using the Select lines option  from
the side toolbar.

2 Right click the selected lines and select Thermal flow BC to create the thermal flow
boundary conditions for the freeze pipes.

3 For the selected freeze pipes, in the Selection explorer expand the subtree for the
ThermalFlowBC.

4 The Behaviour is set to Convection, the Tfluid to 250 K and the Transfer coefficient to 1.0
kW/m2/K.
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19.6.3  Define model boundary conditions
1 Click the Create line button  in the side toolbar.

2 Select the Create thermal flow BC option  in the expanded menu. In the drawing area
create a thermal boundary condition along the perimeter of the model, hence from (x y) =
(-45 0) to (45 0), (45 -30), (-45 -30) and back to (-45 0).

3 Select the four boundaries just have been created and right-click on them. From the menu
that pops up select Create and Create groundwater flow BC to add groundwater flow
boundary conditions to the thermal flow boundary conditions.

19.6.4  Assign model boundary conditions
1 To assign the thermal boundary conditions, please take the following instructions:

a. Multi select the created boundaries.
b. For the ThermalFlowBC, set the Behaviour to Temperature and Tref to 283 K.

2 To assign the groundwater boundary conditions, please take the following instructions:

a. Multi select the top and bottom boundary.
b. For the GWFlowBC, set the Behaviour to Closed.
c. Select the left boundary, set the Behaviour to Inflow with a qref value of 0.1 m/day.
d. The right boundary has the default behaviour of Seepage.

19.6.5  Define the tunnel
The tunnel is created with the help of the Tunnel designer. Because deformations are not
considered in this calculation, there is no need to assign a plate material to the tunnel. The
generated tunnel will only be used for generating a more dense and homogeneous mesh around
the freezing pipes. The tunnel will not be activated during any calculation phase, but PLAXIS 2D
will detect the line elements and will generate the mesh according to these elements. Changing
the coarseness factor of the pipe elements will cause a denser, but not a more homogeneous
mesh.

1 Click the Create tunnel button in the side toolbar and click on (0 -18) in the drawing area.

2 The option Circular is selected for Shape type. Note that the default option is Free.

3 The default option of Define whole tunnel is used in this example.

4 Proceed to the Segments tab and set Radius to 3 m to the two multi selected segments.

5 Click on Generate to generate the defined tunnel in the model. Close the Tunnel designer
window.
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Figure 19–2: Geometry of the model

19.7  Generate the mesh
1 Proceed to the Mesh mode.

2 Click the Generate mesh button  to generate the mesh. The default element distribution of
Medium is used for this example.

3 Click the View mesh button  to view the mesh.

The resulting mesh is shown in Figure 19–3 (p. 291):

Figure 19–3: The generated mesh
4 Click the Close tab to close the Output program.

19.8  Define and perform the calculation
The calculations for this tutorial are carried out in the Flow only mode.

19.8.1  Initial phase
1 Click on the Staged construction tab to proceed with the definition of the calculation

phases.
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2 Double-click on Initial phase in the Phases explorer.

3 In the Phases window select the Flow only option from the Calculation type drop-down
menu.

4 Choose the Earth gradient option for the Thermal calculation type.

5 In the Staged construction activate the ThermalFlow under the Model conditions subtree
and set the value for Tref to 283 K, href to 0 m and 0 K/m for the Earth gradient.

6 The model for initial phase is shown in Figure 19–4 (p. 292).

Figure 19–4: Initial phase

19.8.2  Phase 1: Transient calculation
1 Click the Add phase button  to create a new phase.

2 Double-click the new phase in the Phases explorer.

3 In the Phases window, enter an appropriate name for the phase ID (e.g. Transient
calculation).

4 Set Transient groundwater flow  as the option for the Pore pressure calculation type.

5 Set Transient thermal flow  as the option for the Thermal calculation type.

6 Set Time interval to 180 days and the Max number of steps stored to 100. This is to be able
to view intermediate time steps after the calculation.

7 In Staged construction mode, activate all the thermal boundary conditions by clicking the
check box for the Thermal flow BCs in the Model explorer.

8 In the Model explorer, activate the four groundwater flow boundary conditions
corresponding to the left, top, right and bottom boundary conditions in the Groundwater
flow BCs subtree.

19.8.3  Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later
generation of curves.

1 Click the Select points for curves button in the side toolbar. Select at least the node in
the middle of the model and some characteristic points for curves (for example between two
freezing pipes).
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2 Click the Calculate button  to calculate the project.

3 After the calculation has finished, save the project by clicking the Save button .

19.9  Results
Interesting results from this calculation can be the point in time when there is no groundwater
flow in between two freezing pipes, groundwater flow over the whole model and temperature
distribution for both steady state and transient calculations.

To view the results in the Output program:

1 Click the View calculation results button  on the toolbar.

2 Select the menu Stresses > Heat flow > Temperature.

3 Figure 19–5 (p. 293) shows the spatial distribution of the temperature for transient
calculation in the final step. Note that the element contours have been switched off to better
show that the temperature of the soil inside the tunnel is below freezing.

Figure 19–5: Temperature distribution for transient phase
4 Select the menu Stresses > Groundwater flow > |q|.

5 Select the menu View > Arrows or click the corresponding button  in the toolbar to
display the results arrows.

In the Output program, it is possible to view the results for the intermediate saved steps. More
information is available in the Reference Manual. It is possible to view the progression of the
freezing of the tunnel.

Figure 19–6 (p. 294) shows the distribution of the of groundwater flow field for an intermediate
step for the transient calculation (around 38 days).
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Figure 19–6: Groundwater flow field for transient
phase for an intermediate step (tapprox 38 days)

Figure 19–7 (p. 294) shows the groundwater flow field for the last time step for the transient
flow calculation. Here it is clearly noticeable that the entire tunnel area is frozen and no flow
occurs.

Figure 19–7: Groundwater flow field after 180 days

Figure 19–8 (p. 295) shows the change of temperature in time for the point in the middle of
the tunnel. It can be seen that the temperature drops quite fast until about 273 K when the pore
water starts to change from water to ice. During this process the temperature remains almost
constant and only until after all pore water has turned to ice (at t = 122 s) the ice temperature
drops further.
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Figure 19–8: Temperature drop in time at the center of the tunnel
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